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Preface

1. General information

1.1. Purpose

This User Guide explains how to manage Talend Open Studio for Big Data functions in a normal
operational context.

Information presented in this document appliesto Talend Open Sudio for Big Data rel eases beginning
with 5.2.1.

1.2. Audience

This guide isfor users and administrators of Talend Open Sudio for Big Data.

Thelayout of GUI screens provided in this document may vary slightly from your actual GUI.

1.3. Typographical conventions

This guide uses the following typographical conventions:

* text in bold: window and dialog box buttons and fields, keyboard keys, menus, and menu and
options,

« textin[bold]: window, wizard, and dialog box titles,
 textincouri er: system parameters typed in by the user,

e textinitalics: file, schema, column, row, and variable names,

The 7 icon indicates an item that provides additional information about an important point. It is
also used to add comments related to atable or afigure,

The £A icon indicates a message that gives information about the execution requirements or
recommendation type. It is also used to refer to situations or information the end-user needs to be
aware of or pay specia attention to.

2. Feedback and Support

Y our feedback is valuable. Do not hesitate to give your input, make suggestions or requests regarding
this documentation or product and find support from the Talend team, on Talend’ s Forum website at:
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Feedback and Support

http://talendforge.org/forum
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Chapter 1. Data integration and Talend
Studio

There is nothing new about the fact that organizations' information systems tend to grow in complexity. The
reasons for this include the “layer stackup trend” (a new solution is deployed athough old systems are still
maintained) and the fact that i nformati on systems need to be more and more connected to those of vendors, partners
and customers.

A third reason is the multiplication of data storage formats (XML files, positiona flat files, delimited flat files,
multi-valued files and so on), protocols (FTP, HTTP, SOAP, SCP and so on) and database technologies.

A question arises from these statements: How to manage a proper integration of this data scattered throughout the
company’ sinformation systems? Various functionslay behind the dataintegration principle: businessintelligence
or analytics integration (data warehousing) and operational integration (data capture and migration, database
synchronization, inter-application data exchange and so on).

Both ETL for analytics and ETL for operational integration needs are addressed by Talend Open Sudio for Big
Data.
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Data analytics

1.1. Data analytics

While mostly invisible to users of the Bl platform, ETL processes retrieve the data from all operational systems
and pre-process it for the analysis and reporting tools.

Talend Open Sudio for Big Data offers nearly comprehensive connectivity to:

 Packaged applications (ERP, CRM, etc.), databases, mainframes, files, Web Services, and so on to address the
growing disparity of sources.

» Data warehouses, data marts, OLAP applications - for analysis, reporting, dashboarding, scorecarding, and so
on.

 Built-in advanced components for ETL, including string manipulations, Slowly Changing Dimensions,
automatic lookup handling, bulk loads support, and so on.

Most connectors addressing each of the above needs are detailed in Talend Open Studio for Big Data Components
Reference Guide. For information about their orchestration in Talend Open Sudio for Big Data, see chapter
Designing a data integration Job.

1.2. Operational integration

Operational data integration is often addressed by implementing custom programs or routines, completed on-
demand for a specific need.

Datamigration/loading and data synchronization/replication are the most common applications of operational data
integration, and often require:

» Complex mappings and transformations with aggregations, calculations, and so on due to variation in data
Structure,

» Conflicts of datato be managed and resolved taking into account record update precedence or “record owner”,
 Data synchronization in nearly real time as systemsinvolve low latency.

Most connectors addressing each of the above needs are detailed in Talend Open Studio for Big Data Components
Reference Guide. For information about their orchestration in Talend Open Sudio for Big Data, see chapter

2 Talend Open Studio for Big Data User Guide



Operationa integration

Designing a data integration Job. For information about designing a detailed dataintegration Job using the output
stream feature, see section Using the output stream feature.

Talend Open Studio for Big Data User Guide 3
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Chapter 2. Getting started with Talend Studio

This chapter introduces Talend Open Sudio for Big Data. It provides basic configuration information required to
get started with Talend Open Sudio for Big Data.

The chapter guides you through the basic stepsin creating local projects. It aso describes how to set preferences
and customize the workspace in Talend Open Sudio for Big Data.

Before starting any data integration processes, you need to be familiar with Talend Open Sudio for Big Data
Graphical User Interface (GUI). For more information, see appendix GUI.
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Important concepts in Talend Open Sudio for Big Data

2.1. Important concepts in Talend Open
Studio for Big Data

When working with Talend Open Sudio for Big Data, you will often come across words such as repository,
project, workspace, Job, component and item.

Understanding the concept behind each of these words is crucial to grasping the functionality of Talend Open
Sudio for Big Data.

What isa repository? A repository is the storage location Talend Open Studio for Big Data uses to gather data
related to al of thetechnical items that you use to design Jobs.

What is a project? Projects are structured collections of technical items and their associated metadata. All of the
Jobs you design are organized in Projects.

You can create as many projects as you need in a repository. For more information about projects, see section
Working with projects.

What is a workspace? A workspace is the directory where you store all your project folders. You need to have
one workspace directory per connection (repository connection). Talend Open Studio for Big Data enables you to
connect to different workspace directories, if you do not want to use the default one.

For more information about workspaces, see section Working with different workspace directories.

What isa Job? A Job isagraphical design, of one or more components connected together, that allows you to set
up and run dataflow management processes. It translates business needs into code, routines and programs. Jobs
address all of the different sources and targets that you need for data integration processes and all other related
processes.

For detailed information about how to design data integration processes in Talend Open Sudio for Big Data, see
chapter Designing a data integration Job.

What is a component? A component is a preconfigured connector used to perform a specific data integration
operation, no matter what data sources you are integrating: databases, applications, flat files, Web services, etc.
A component can minimize the amount of hand-coding required to work on data from multiple, heterogeneous
sources.

Components are grouped in families according to their usage and displayed in the Palette of the Talend Open
Sudio for Big Data main window.

For detailed information about components types and what they can be used for, see Talend Open Sudio for Big
Data Components Reference Guide.

What is an item? An item is the fundamental technical unit in a project. Items are grouped, according to their
types, as. Job Design, Context, Code, etc. One item can include other items. For example, the Jobs you design are
items, and routines you use inside your Jobs are items as well.

2.2. Launching Talend Open Studio for Big
Data

2.2.1. How to launch the Studio for the first time

To open Talend Open Sudio for Big Data for the first time, complete the following:
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How to launch the Studio for the first time

4.

Unzip the Talend Open Sudio for Big Data zip file and, in the folder, double-click the executable file
corresponding to your operating system.

The Studio zip archive contains binaries for several platformsincluding Mac OS X and Linux/Unix.

Inthe[License] window that appears, read and accept the terms of the end user license agreement to continue.

The startup window appears.

Welcome ko Talend Open Studio

Before wou can begin working with Talend, wou need ko create a project,
You can skart with a demo project that contains useful examples, or
create an empky project of wour own,

Select A Demo Project | TALENDDEMOS 1844 v| [wmport |
Create & Mew Project | projectiame Create

v

This screen appears only when you launch the Talend Open Sudio for Big Data for the first time or if al existing
" projects have been deleted.

Click the Import button to import the selected demo project, or typein aproject name in the Create A New
Project field and click the Create button to create a new project, or click the Advanced... button to go to
the Studio login window.

In this procedure, click Advanced... to go to the Studio login widow. For more information about the other
two options, see section How to import the demo project and section How to create a project respectively.

YWelcome to Talend Cpen Studio.Pleasse select an existing
project to start work,or create a new one,

Project:

[Create... ] [Impnrt...] [ Demo Project... ]

Workspace! | E:\StudiosTalend_S{TOS-All+70871-V5.0.0M8 workspac| [ Change |
x A project is needed...

From the Studio login window:

Click... To...

Create... create a new project that will hold all Jobs designed in the Studio.

For more information, see section How to create a project.

Import... import one or more existing projects.

Talend Open Studio for Big Data User Guide 7
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10.

Click... To...
For more information, see section How to import projects.

Demo Project... import the Demo project including numerous samples of ready-to-use Jobs. This Demo
project can help you understand the functionalities of different Talend components.

For more information, see section How to import the demo project.

Open open the selected existing project.

For more information, see section How to open a project.

Delete... open adialog box in which you can delete any created or imported project that you do
not need anymore.

For more information, see section How to delete a project.

Asthe purpose of this procedureisto create a new project, click Create... to open the [New project] dialog
box.

In the dialog box, enter a name for your project and click Finish to close the dialog box. The name of the
new project is displayed in the Project list.

Welcome to Talend Open Studio, Please seleck an existing
project to skart work,or create a new one,

Project:  |Rfei=an

[Create... ] [Impnrt...] [ Dermno Project. .. ]

Workspace: | E1\Studios| Talend_SiTOS-All-+70207-45.0.0MB workspac
S

Select the project, and click Open.

The Connect to TalendFor ge page appears, inviting you to connect to the Talend Community so that you can
check, download, install external components and upload your own components to the Talend Community
to share with other Talend users directly in the Exchange view of your Job designer in the Studio.

To learn more about the Talend Community, click the read more link. For more information on using and
sharing community components, see section How to download/upload Talend Community components.

If you want to connect to the Talend Community later, click Skip to continue.

If you are working behind a proxy, click Proxy setting and fill in the Proxy Host and Proxy Port fields of
the Network setting dialog box.

By default, the Studio will automatically collect product usage data and send the data periodically to servers
hosted by Talend for product usage analysis and sharing purposes only. If you do not want the Studio to do
so, clear the | want to help to improve Talend by sharing anonymous usage statistics check box.

Y ou can also turn on or off usage data collection in the Usage Data Collector preferences settings. For more
information, see section Usage Data Collector preferences (Talend > Usage Data Collector).

Fill in the required information, select the | Agreeto the TalendForge Terms of Use check box, and click
Create Account to create your account and connect to the Talend Community automatically. If you aready
have created an account at http://www.talendforge.org, click the or connect on existing account link to sign
in.

Talend Open Studio for Big Data User Guide
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How to launch the Studio for the first time

11.

Be assured that any personal information you may provide to Talend will never be transmitted to third parties nor

" used for any purpose other than joining and logging in to the Talend Community and being informed of Talend latest
updates.
% Connect to TalendForge §|

Connect your studio to TalendForge, the Talend online community,

talen
Download new components and connectors from Talend Exchange e
Access the most recent documentation and tech articles From 0 I e
the Talend social knowledgebase,

®  See the latest messages in the Talend discussion Forums

Create an account

Username: |testuser '

*

Ernail: |testuser@companv.com

*

Password{again): |******** #*

Password: |******** |

Country: |United States ~

[¥]1 Agree to the TalendForge Terms of Use
[#]1 wark to help to improve Talend by sharing anonymous usage skatistics

{read mare...)

[ Create Account

Proxy settings.,., Skip

This page will not appear again at Studio startup once you successfully connect to the Talend Community or if you
" click Skip too many times. Y ou can show this page again from the [Prefer ences] dialog box. For more information,
see section Exchange preferences (Talend > Exchange).

A progress information bar and a welcome window display consecutively. From this page you have direct
links to user documentation, tutorials, Talend forum, Talend Exchange and Talend latest news.

Click Start now! to open Talend Open Sudio for Big Data main window.
The main window opens on a welcome page which has useful tips for beginners on how to get started with
the Studio. Clicking an underlined link brings you to the corresponding tab view or opens the corresponding

dialog box.

For more information on how to open a project, see section How to open a project.
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How to set up a project

[ Talend Gpen studio 23 =8

Welcome to Talend Open Studio

This powerful and flexible tool helps you take control of your data.
Before you get started, here are the basics:

First, create a Job using Drop source, target, and Wiew and configure the

the Job Designer. transformation properties of your Job
Right click and select components from the components in the
Create Job. Palette to wour Job .. Component tab.

And finally, use the Run Job tab to execute your Job and wiew the results.

2.2.2. How to set up a project

To open the Talend Open Studio for Big Data main window, you must first set up a project.
Y ou can set up aproject by:
* creating anew project. For more information, see section How to create a project.

 importing one or more projects you already created in other sessions of Talend Open Sudio for Big Data. For
more information, see section How to import projects.

 importing the Demo project. For more information, see section How to import the demo project.

2.3. Working with different workspace
directories

Talend Open Studio for Big Data makes it possible to create many workspace directories and connect to a
workspace different from the one you are currently working on, if necessary.

This flexibility enables you to store these directories wherever you want and give the same project name to two
or more different projects as long as you store the projects in different directories.
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How to create a new workspace directory

2.3.1. How to create a new workspace directory

Talend Open Sudio for Big Data is delivered with a default workspace directory. However, you can create as
many new directories as you want and store your project foldersin them according to your preferences.

To create a new workspace directory:

1. Inthe project login window, click Change to open the dialog box for selecting the directory of the new
workspace.

Wglcome to Talend Open Studio, Please seleck an existing
project to skart work,or create a new one,

Project:  |Rfei=an

[Create... ] [Impnrt...] [ Dermno Project. .. ]

Workspace: |E:\Studios)Talend_S|TOS-AI-+70207-VS, 0,0MB workspac
S

2. Inthediaog box, set the path to the new workspace directory you want to create and then click OK to close
the view.

On the login window, a message displays prompting you to restart the Studio.
3. Click Restart to restart the Studio.
4. Onthere-initiated login window, set up a project for this new workspace directory.
For more information, see section How to set up a project.
5. Selecttheproject fromtheProject list and click Open to open Talend Open Sudio for Big Data main window.
All Jobsyou designinthe current instance of the Studio will be stored in the new workspace directory you created. .

When you need to connect to any of the workspaces you have created, simply repeat the process described in
this section.

2.4. Working with projects

In Talend Open Sudio for Big Data, the highest physical structurefor storing al different types of dataintegration
Jobs, routines, etc. isthe “project”.

From the login window of Talend Open Sudio for Big Data, you can:
» import the Demo project to discover the features of Talend Open Sudio for Big Data based on samples of
different ready-to-use Jobs. When you import the Demo project, it is automatically installed in the workspace

directory of the current session of the Studio.

For more information, see section How to import the demo project.
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How to create a project

create a local project. When connecting to Talend Open Sudio for Big Data for the first time, there are no
default projects listed. You need to create a project and open it in the Studio to store all the Jobs you create
in it. When creating a new project, a tree folder is automatically created in the workspace directory on your
repository server. Thiswill correspond to the Repository tree view displaying on Talend Open Sudio for Big
Data main window.

For more information, see section How to create a project.

import projects you have already created with previous releases of Talend Open Studio for Big Data into your
current Talend Open Sudio for Big Data workspace directory by clicking Import... .

For more information, see section How to import projects.

open a project you created or imported in the Studio.

For more information, see section How to open a project.

delete local projects that you already created or imported and that you do not need any longer.

For more information, see section How to delete a project.

Once you launch Talend Open Sudio for Big Data, you can export the resources of one or more of the created
projects in the current instance of the Studio. For more information, see section How to export a project.

2.4.1. How to create a project

When you launch the Studio for the first time, there are no default projectslisted. Y ou need to create a project that
will hold al dataintegration Jobs you design in the current instance of the Studio.

To create a project:
1. Launch Talend Open Sudio for Big Data.
2. Usedither of the following two options:
» Enter aproject nameinthe Create A New Project field and click Createto openthe[New project] dialog
box with the Project namefield filled with the specified name.
 Click Advanced, and then from the login window click Create... to open the [New project] dialog box
with an empty Project namefield.
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How to create a project

%* New project |Z|E

Project | 1.!
&

Project name |F‘ru:-jeu:t 1| |

Technical Mame | |

Project description

Finish l [ Cancel

3. IntheProject namefield, enter aname for the new project, or change the previously specified project name
if needed. Thisfield is mandatory.

A message shows at the top of the wizard, according to the location of your pointer, to inform you about the
nature of datato be filled in, such as forbidden characters

The read-only “technical name” is used by the application as file name of the actual project file. This name usually
¥ corresponds to the project name, upper-cased and concatenated with underscores if needed.

4. Click Finish. The name of the newly created project is displayed in the Project list in Talend Open Sudio
for Big Data login window.

Welcome to Talend Cpen Studio,Please select an existing
praoject ko skark wark, ar creake a new one.

Project:  |[S=TeR]=e) it

Delete. ..

[Create... ] [Impu:urt...] [ Derno Project... ]

Warkspace: |E:'I,5tLIdiDS'I,Ta|End_5'I,TOS-P-"-r?DE1I-VE.D.DRCI'I,WDrkspE [ Change ]

A

From version 5.0 onwards, Javais the only language generated.

-z

To open the newly created project in Talend Open Sudio for Big Data, select it from the Project list and then
click Open. A generation engine initialization window displays. Wait till theinitialization is complete.
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How to import the demo project

Later, if you want to switch between projects, on the Studio menu bar, use the combination File > Switch Pr oj ect.

If you aready used Talend Open Sudio for Big Data and want to import projects from a previous release, see
section How to import projects.

2.4.2. How to import the demo project

In Talend Open Sudio for Big Data, you can import the demo project that includes numerous samples of ready to
use Jobs. This demo project can help you understand the functionalities of different Talend components.

At thefirst launch of Talend Open Sudio for Big Data, you can:

* create anew project in your repository using the demo project as atemplate,
* import the demo project TALENDDEMOSIAVA into your repository.

To create anew project based on the demo project:

1. Click the Import button next to the Select A Demo Project list box. The [Import Demo Project] dialog

box opens.
% Import Demo Project |Z|@@

Project

Project name Demo-based project

Technical Mame

Project description

Finish l [ Cancel

2. Typeinaname for the new project, and click Finish to create the project.

A confirmation message is displayed, informing you that the demo project has been successfully imported
in the current instance of the Studio.

3. Click OK to close the confirmation message.

All the samples of the demo project are imported into the newly created project, and the name of the new
project is displayed in the Project list on the login screen.
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How to import projects

To import the demo project TALENDDEMOSIAVA into your repository:

1. Click Advanced..., and then from the login window click Demo Project.... The [Import demo pr oject]
dialog box opens.

Import demo project

Select the demo project to import,

Available demo projects.

; LB T A EMDDEMOSJAVA

The Java Demo project
can help you grasp all
functionalities and
components at a

glance Discover how to
setup and configure the
powerful components via
meaningful job samples

[ Finish l [ Cancel

2. Select the demo project and then click Finish to close the dialog box.

A confirmation message is displayed, informing your that the demo project has been successfully imported
in the current instance of the Studio.

3. Click OK to close the confirmation message.
The imported demo project displaysin the Project list on the login window.

To open the imported demo project in Talend Open Sudio for Big Data, select it from the Project list and then
click Open. A generation engine initialization window displays. Wait till the initialization is complete.

The Job samples in the open demo project are automatically imported into your workspace directory and made
available in the Repository tree view under the Job Designs folder.

Y ou can use these samples to get started with your own Job design.

2.4.3. How to import projects

In Talend Open Studio for Big Data, you can import projects you already created with previous releases of the
Studio.

1. If you are launching Talend Open Sudio for Big Data for the first time, click Advanced... to open to the
login window.

2. From the login window, click Import... to open the [Import] wizard.
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How to import projects

# Import - BX]
Import Projects —
Select a directory to search For existing Eclipse projects, :_: ;

<

() Select root directory: |E:'I.EI'I.T05--':'-||'F5?5??"'J'4-2-UF'~C1'|.WDrk5DE| Browse, .,

() select archive file: | |

Projects:

PROJECT 2010 (E:\a\ TOS-Al-S7S77-v4.2, 0RC 1 yworkspac | Select Al

PROJECT 2011 (E:\a\TOS-Al-r57577-v4. 2, 0RC 1 warkspac
Deselect Al
’ ,

Copy projects into workspace

Import project as Finish ] [ Zancel

Click Import several projectsif you intend to import more than one project simultaneously.
Click Select root directory or Select ar chive file depending on the source you want to import from.

Click Browse... to select the workspace directory/archive file of the specific project folder. By default, the
workspace in selection is the current release’s one. Browse up to reach the previous release workspace
directory or the archive file containing the projects to import.

Select the Copy projects into workspace check box to make a copy of the imported project instead of
moving it.

If you want to remove the original project folders from the Talend Open Sudio for Big Data workspace directory you
a7 import from, clear this check box. But we strongly recommend you to keep it selected for backup purposes.

From the Projectslist, select the projects to import and click Finish to validate the operation.

In the login window, the names of the imported projects now appear on the Project list.

Wglcome to Talend Open Studio, Please seleck an existing
project to skart work,or create a new one,

S = PR O IECT 2010
en
PROJECT_2011 B Op

[Create... ] [Impn:nrt...] [ Derno Project. .. ]

workspace: |E:'l,Stu|:|iDs'l,TaIend_S'l,TOS-.ﬁ.II-r?DS1I-VS.D.DRCI'I,WDrkspE

A

[ Zhange ]
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How to open a project

Y ou can now select the imported project you want to open in Talend Open Studio for Big Data and click Open
to launch the Studio.

A generation initialization window might come up when launching the application. Wait until the initialization is complete.

2.4.4. How to open a project

When you launch Talend Open Studio for Big Data for the first time, no project names are displayed on the Project list.
.Y First you need to create a project or import a Demo project in order to populate the Project list with the corresponding
project names that you can then open in the Studio.

To open aproject in Talend Open Sudio for Big Data:

On the Studio login screen, select the project from the Project list, and click Open.

Welcome to Talend Open Studio.Please select an existing
project to skart wark,or creake a new one,

Project:  |[E=TsRSm il

[Create... ] [Impnrt...] [ Dero Project... ]

Workspace!  E1\studios| Talend_S\TOS-Alr70511-v5.0.0RCLworksps
¥

A progress bar appears, and the Talend Open Sudio for Big Data main window opens. A generation engine
initialization dialog bow displays. Wait till initialization is complete.

When you open a project imported from a previous version of the Studio, an information window pops up to list a short
| description of the successful migration tasks. For more information, see section Migration tasks.

2.4.5. How to delete a project

1. Onthelogin screen, click Delete...to open the [Select Project] dialog box.
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How to export a project

# Select Project

Delete Project

[ & MyPROJECT Select Al

Ml 3rarALLELIZE
Deselect 4l

[ ]Do not delete prajects physically

Ik l [ Cancel

2. Select the check box(es) of the project(s) you want to delete.
3. Click OK to validate the deletion.

The project list on the login window is refreshed accordingly.

Be careful, thisaction isirreversible. When you click OK, thereis no way to recuperate the deleted project(s).

F1\

If you select the Do not delete projects physically check box, you can delete the selected project(s) only from the

a7 project list and till have it/them in the workspace directory of Talend Open Sudio for Big Data. Thus, you can
recuperate the deleted project(s) any time using the Import existing project(s) as local option on the Project list
from the login window.

2.4.6. How to export a project

Talend Open Sudio for Big Data, alows you to export projects created or imported in the current instance of
Talend Open Studio for Big Data.

1
On the toolbar of the Studio main window, click e to open the [Export Talend projectsin archivefile]

dialog box.
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Migration tasks

Archive file

Export resources to an archive file on the local file syskem,

[B]= FIRSTPROJECT %] .project
[¥] = MYPROJECT = talend. project
[ ]i=F TALEMDDEMOSIAYA

[Filter Types.., ] [ Select Al ] [ Deselect all ]
Ta archive File: | L\ CienkxML. zip V| [ Browse, ..
Options

(%) Save in zip Format (%) Create directory struckure For Files

() Save in tar format (") Create only selected directories

Compress the cantents of the file

(2] [ Finish l [ Cancel

2. Select the check boxes of the projects you want to export. You can select only parts of the project through
the Filter Types... link, if need be (for advanced users).

3. IntheTo archivefilefield, type in the name of or browse to the archive file where you want to export the
selected projects.

4. Inthe Option area, select the compression format and the structure type you prefer.
5. Click Finish to validate the changes.

The archived file that holds the exported projectsis created in the defined place.

2.4.7. Migration tasks

Migration tasks are performed to ensure the compatibility of the projects you created with a previous version of
Talend Open Sudio for Big Data with the current release.

As some changes might become visible to the user, we thought we' d share these update tasks with you through
an information window.

This information window pops up when you launch the project you imported (created) in a previous version of
Talend Open Sudio for Big Data. It lists and provides a short description of the tasks which were successfully
performed so that you can smoothly roll your projects.
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Setting Talend Open Sudio for Big Data preferences

x]

# Migration tasks done

Hete are the migration tasks applied on this session on this project,

B Rename tDBAxTotOraclexx

Migrate database generic components connecked to a Oracle dakabase to the corresponding specific Cracle
compaonents,

B Hename tDBxxTotMySOLxx

Migrate database generic components connected to a MySOL database to the corresponding specific MyS0L
cormponents,

B Rename tDBRXTotPostgresqlx

Migrate database generic companents connecked ko a PostareaL dakabase ba the corresponding specific
PostgrescL components,

B Rename tDBHHTotMssqlux

Migrate database generic components connecked to a Microsoft S0L Server database ko the corresponding "

Some changes that affect the usage of Talend Open Sudio for Big Data include, for example:

» tDBInput used with a MySQL database becomes a specific tDBMysgll nput component the aspect of which
isautomatically changed in the Job where it is used.

» tUnigRow used to be based on the Input schemakeys, whereas the current tUnigRow allows the user to select
the column to base the unicity on.

2.5. Setting Talend Open Studio for Big Data
preferences

Y ou can define various properties of Talend Open Sudio for Big Data main design workspace according to your
needs and preferences.

Numerous settings you define can be stored in the Preference and thus become your default values for all new
Jobs you create.

The following sections describe specific settings that you can set as preference.

First, click the Window menu of your Talend Open Studio for Big Data, then select Preferences.

2.5.1. Java Interpreter path (Talend)

The Java Interpreter path is set default in the Java file of your computer (by default Program Files\Java\jre6\bin
\java.exe).
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Designer preferences (Talend > Appearance)

Talend =1 - -
Temporary files  ChUsers\fbensaidDesktoph TMDMCE-5Studio-All-ri9933-V5.0.0MB termp Browse...
Java interpreter  C:M\Program Files'Javajref\bin\java.exe Browse...
Preview limit 50

[ Multi Thread execution (Default value for job creaticn)

iReport path Browse...

Always show welcome view when startup

I Restore Defaults I I Apply I

| ok || canced |

To customize your Java Interpreter path:
1. If needed, click the Talend node in the tree view of the [Prefer ences] dialog box.
2. Enter apathinthe Javainterpreter field if the default directory does not display the right path.

On the same view, you can also change the preview limit and the path to the temporary files or the OS language.

2.5.2. Designer preferences (Talend > Appearance)

Y ou can set component and Job design preferencesto let your settings be permanent in the Studio.
1. Fromthe menu bar, click Window > Preferences to open the [ Pr efer ences] dialog box.

2. Expandthe Talend > Appearance node.

3. Click Designer to display the corresponding view.

On this view, you can define the way component names and hints will be displayed.
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BPM Runtime preferences (Talend > BPM Runtime Configuration)

4.

Designer oo -
Components default label __UMNIQUE_MAME
Components defaulk hink <b=_ UMIQUE_MAME__ =/b=<hbr=_ COMMENT

Component default conneckion | Fow
[ ] 5how components' hink
Ilse the Repository name as label for the components dragged and dropped From the Repository Metadata,

[ Juse antialiasing and interpolation in the Job Designer

Compaonent defaulk Filepath S _Buildsi TOS-all-k23793-43, 1 0RC3hworkspace

Icon size:
(%) 24 pixels ()32 pixels
Component setkings tab layout:

(%) compact view () table view

[ ]Compute byte length of source codes generated by components

Restare Defaulks ] [ Apply

Select therelevant check boxes to customize your use of Talend Open Sudio for Big Data design workspace.

2.5.3. BPM Runtime preferences (Talend > BPM
Runtime Configuration)

When creating aBPM service, you can set its URI aswell asthe connection information to the BPM Web console.

1.  Fromthe menu bar, click Window > Prefer ences to open the [ Pr efer ences] dialog box.
2.  Expandthe Talend > BPM Runtime Configuration node.
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External or User components (Talend > Components)

£ Preferences I. | =] |_ihl
type filter text BPM Runtime Configuration =1 v v
EMF Compare 0 Default configuration for tBonitalnstantiateProcess when
» Groovy creating a DataService from Bonita Process
» Help - dm
> Install/Update sEmame admin
- lava Password o
» JobScript E

4

language preference pa
Maven

Model Validation
Plug-in Development
remote engine preferen
Report Design

run preference page
Run/Debug

ppp— )

I I

.”‘3‘1
b

REST Address http://localhost:E040/bonita-server-rest/
REST Usernarne  restuser

REST Password  #&Zfsss

Service URI http:/127.0.0.1:8090
*Mote: httpe/127.0.0.1:8090 is used if no Service URI specified.

’ Restore Defaults] ’ Apply ]

[ ok || Caneel |

3.  Fill intheinformation as follows.

Field Name

Action

Username and Password

Enter the username and password to connect to the BPM Web
console. By default, it isadmin and bpm.

REST Address

Enter the URL of the BPM REST server. By default, itishttp://
local host: 8040/bonita-server-rest/.

REST Username and REST Password

Enter the username and password to connect to the BPM REST
server. By default, it is restuser and restbpm.

Service URI

Enter the URI of the BPM service. By default, it is
http://127.0.0.1:8090. Note that this default URI will be used
if no service URI is specified.

4. Click Apply and then OK to validate the set preferences and close the dialog box.

2.5.4. External or User components (Talend >
Components)

Y ou can create and develop your own components for use in Talend Open Sudio for Big Data.

For further information about the creation and devel opment of user components, refer to the component creation
tutorial on our wiki at http://www.talendforge.org/wiki/doku.php?d=component_creation.

1. Inthetreeview of the[Preferences| dialog box, expand the Talend node and select Components.
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Exchange preferences (Talend > Exchange)

Components =1 -
User component Folder: | C:\Documents and SettingsihmassyBureauii
Mapper
Defaulk mapping links display as : | Auto W
ERunJob

[ ]oon't show corresponding job after double click on a tRunlob Component.

[Restnre Defaulks ] [ Apply ]

[ ok, ][ Cancel ]

Enter the User componentsfolder path or browse to the folder that holds the components to be added to the
Talend Open Sudio for Big Data Palette.

From the Default mapping links display as list, select the mapping link type you want to use in the tM ap.

Under tRunJob, select the check box if you do not want the corresponding Job to open upon double clicking
atRunJob component.

You will still be able to open the corresponding Job by right clicking the tRunJob component and selecting Open
@ tRunJob Component.

Click Apply and then OK to validate the set preferences and close the dialog box.

The external components are added to the Palette.

2.5.5. Exchange preferences (Talend > Exchange)

Y ou can set preferencesrelated to your connection with Talend Exchange, whichispart of the Talend Community,
in Talend Open Sudio for Big Data. To do so:

1. Fromthe menu bar, click Window > Prefer ences to open the [ Pr efer ences] dialog box.
2. Expand the Talend node and click Exchange to display the Exchange view.
Exchange Sl v
ser Logged :  _< MNone =
Motify me when updated extensions are available.
3. Set the Exchange preferences according to your needs:

« If you arenot yet connected to the Talend Community, click Sign In to go to the Connect to TalendForge
page to sign in using your Talend Community credentials or create a Talend Community account and
thensignin.
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Adding code by default (Talend > Import/Export)

If you are already connected to the Talend Community, your account is displayed and the Sign In button
becomes Sign Out. To get disconnected from the Talend Community, click Sign Out.

« By default, while you are connected to the Talend Community, whenever an update to an installed

community extension is available, a dialog box appears to notify you about it. If you often check for
community extension updates and you do not want that dialog box to appear again, clear the Notify me
when updated extensions ar e available check box.

For moreinformation on connecting to the Talend Community, see section Launching Talend Open Sudio for Big
Data. For more information on using community extensions in the Studio, see section How to download/upload
Talend Community components.

2.5.6. Adding code by default (Talend > Import/Export)

Y ou can add pieces of code by default at the beginning and at the end of the code of your Job.

1

2.

From the menu bar, click Window > Pr efer ences to open the [Prefer ences] dialog box.

Expand the Talend and Import/Export nodes in succession and then click Shell Setting to display the
relevant view.

Shell Setting AT v

Command

o GEMERATED_TOS_CALL%

Restore Qefaults] [ Apply

In the Command field, enter your piece/pieces of code before or after “eENERATED _TOS_CALL%to display
it/them before or after the code of your Job.

2.5.7. Language preferences (Talend >
Internationalization)

Y ou can set language preferences in Talend Open Studio for Big Data. To do so:

1.

2.

From the menu bar, click Window > Pr efer ences to open the [Pr efer ences] dialog box.

Expand the Talend node and click I nter nationalization to display the relevant view.
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Performance preferences (Talend > Performance)

Internationalization -

Local Languagelneed restart)
English W

Test translation with Balibi (warks only For current language, other language selection needs restark)

[Impu:urt all translations ]

[Impu:-rt only validated translations ]

[ Restore Defaults ] [ Apply ]

[ o, H Cancel ]

3. From the Local Language list, select the language you want to use for Talend Open Sudio for Big Data
graphica interface.

4. Click Apply and then OK to validate your change and close the [Pr efer ences] dialog box.

5. Restart Talend Open Sudio for Big Data to display the graphical interface in the selected language.

2.5.8. Performance preferences (Talend >
Performance)

You can set the Repository tree view preferences according to your use of Talend Open Sudio for Big Data. To
refresh the Repository view:

1. Fromthe menu bar, click Window > Prefer ences to open the [ Pr efer ences] dialog box.
2. Expand the Talend node and click Performance to display the repository refresh preference.
Performance T hd

[ ] Deactivate auto detectjupdate after a modification in the repository

[ ] check the property fields when generating code {disable will make the components properties fasker)
[ ]5enerate code when opening the: job

Check only the last version when updating jobs or joblets

[ ]Propagate add{delete variable changes in repositary contexts

Ackivate the timeout for database connection.

Conneckion timeout (seconds) | 15

add all user routines ko job dependencies, when create new job

8dd all syskem routines ta job dependencies, when create new job

[Resture DeFauIts] [ Apply ]

[ Ok H Cancel ]

Y ou can improve your performance when you deactivate automatic refresh.
]

3. Set the performance preferences according to your use of Talend Open Sudio for Big Data:

26 Talend Open Studio for Big Data User Guide



Debug and Job execution preferences (Talend > Run/Debug)

Select the Deactivate auto detect/update after a modification in the repository check box to deactivate the
automatic detection and update of the repository.

Select the Check the property fields when generating code check box to activate the audit of the property
fields of the component. When one property filed is not correctly filled in, the component is surrounded by red
on the design workspace.

Y ou can optimize performance if you disable property fields verification of components, i.e. if you clear the Check the
7 property fieldswhen generating code check box.

Select the Gener ate code when opening the job check box to generate code when you open a Job.

Select the Check only the last version when updating jobs or joblets check box to only check the latest
version when you update a Job.

Select the Propagate add/delete variable changes in repository contexts to propagate variable changes in
the Repository Contexts.

Select the Activate the timeout for database connection check box to establish database connection time out.
Then set thistime out in the Connection timeout (seconds) field.

Select the Add all user routinesto job dependencies, when create new job check box to add all user routines
to Job dependencies upon the creation of new Jobs.

Select the Add all system routinesto job dependencies, when createjob check box to add all system routines
to Job dependencies upon the creation of new Jobs.

2.5.9. Debug and Job execution preferences (Talend >
Run/Debug)

Y ou can set your preferences for debug and job executions in Talend Open Sudio for Big Data. To do so:

1.

2.

From the menu bar, click Window > Pr efer ences to display the [Prefer ences] dialog box.

Expand the Talend node and click Run/Debug to display the relevant view.
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Debug and Job execution preferences (Talend > Run/Debug)

Run/Debug = -

Fun process configuration
Talend client configur akion

Skats port range @ | 3334 to | 4333

Trace port range @ | 4334 ko | 5333

[ ]5ave before run Clear before run [ ]Exec time

[ ] Statistics [ Traces Pause Time(ms) | 1000

Job Run ¥M arguments

Argumenkt e

-RMs22EM
-srn 1024 M

Restore DeFauIts] [ Apply

» IntheTalend client configuration area, you can define the execution options to be used by default:

Stats port range Specify arange for the ports used for generating statistics, in particular, if the ports defined by
default are used by other applications.

Traceport range Specify arange for the ports used for generating traces, in particular, if the ports defined by default
are used by other applications.

Save beforerun Select this check box to save your Job automatically before its execution.

Clear beforerun Select this check box to delete the results of a previous execution before re-executing the Job.

Exec time Select this check box to show Job execution duration.

Statistics Select this check box to show the statistics measurement of data flow during Job execution.

Traces Select this check box to show data processing during job execution.

Pausetime Enter the time you want to set before each data line in the traces table.

* IntheJob Run VM argumentslist, you can define the parameter of your current VM according to your needs.
The by-default parameters -Xms256M and -Xmx1024M correspond respectively to the minimal and maximal
memory capacities reserved for your Job executions.

If you want to use some JVM parameters for only a specific Job execution, for example if you want to display
the execution result for this specific Job in Japanese, you need open this Job's Run view and then in the Run
view, configure the advanced execution settings to define the corresponding parameters.

For further information about the advanced execution settings of a specific Job, see section How to set advanced
execution settings.

For more information about possible parameters, check the site http://www.oracle.com/technetwork/javaljavase/
tech/vmoptions-jsp-140102.html.
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Displaying special characters for schema columns (Talend > Specific settings)

2.5.10. Displaying special characters for schema
columns (Talend > Specific settings)

You may need to retrieve a table schema that contains columns written with special characters like Chinese,
Japanese, Korean. In this case, you need to enable Talend Open Studio for Big Data to read the special characters.
To do so:

1. Fromthe menu bar, click Window > Preferences to open the [ Pr efer ences] dialog box.

2. Onthetree view of the opened dialog box, expand the Talend node.

w

Click the Specific settings node to display the corresponding view on the right of the dialog box.

4. Select the Allow specific characters (UTF8,...) for columns of schemas check box.

Specific Settings hd

[ ] allow specific characters {UTF&,...) For columns of schemas

2.5.11. Schema preferences (Talend > Specific
Settings)

Y ou can define the default data length and type of the schemafields of your components.

1.  Fromthe menu bar, click Window > Prefer ences to open the [ Pr efer ences] dialog box.

2. Expandthe Talend node, and click Specific Settings > Default Typeand L ength to display the data length
and type of your schema.
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Libraries preferences (Talend > Specific Settings)

# Preferences |Z|@@

|type filker best | Default Type and Length =T

General

Connectivity Default Settings For Fields with rull Yalues

Installflipdate Default Length |
Java

Perl EPTC Default Setkings For All Fields
Run)Debug Default Type

Talend Defaul Length | |
Appearance

Cornponents Default Length For Data Tyvpe
Import/Expart Boolean Ii’ BigDecimal I:I
Internationalization Byte |:| Integer |:|

Performance

runloos el [ Jumw [
%esqlBuilder

Default Type and Length

Metadata of TalendTvpe

Talend Component Designer Float |:| Lisk I:I

(0] ] ] ] ] ] - ]

Team
=ML

[Restnre Qefaults] [ Apply ]
f\':?:. [ Ok l [ Cancel ]

3.  Set the parameters according to your needs:

* Inthe Default Settingsfor Fieldswith Null Valuesares, fill in the datatype and the field length to apply
to the null fields.

» Inthe Default Settingsfor All Fields area, fill in the data type and the field length to apply to al fields
of the schema.

* Inthe Default Length for Data Type area, fill in the field length for each type of data.

2.5.12. Libraries preferences (Talend > Specific
Settings)

Y ou can define the folder where to store the different libraries used in Talend Open Sudio for Big Data. To do so:
1. From the menu bar, click Window > Preferences to display the [Prefer ences] dialog box.

2. ExpandtheTalend and Specific Settingsnodesin succession and then click Librariesto display the relevant
view.
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Libraries =T -

External libraries path  /C:/Users/fbensaid/Desktop/TMDMCE-Studio-All-r89939-Y5.0.0ME/lib Browse...

| Restore Defaults| | Apply |

[ 0K ] | Cancel |

3. Setthe access path in the External libraries path field through the Browse... button. The default path leads
to the library of your current build.

2.5.13. Type conversion (Talend > Specific Settings)

Y ou can set the parameters for type conversion in Talend Open Sudio for Big Data, from Java towards databases
and vice versa.

1.  Fromthe menu bar, click Window > Preferences to display the [Pr efer ences] dialog box.

2. Expand the Talend and Specific Settings nodes in succession and then click M etadata of Talend Typeto
display the relevant view.

Metadata of TalendType -

Talend Tvpe Mapping Files

Metadata Mapping File

mapping_Access. xml
mapping_A5400, xml
mapping_Firebird, xml
mapping_Greenplum. xml
rapping_HSOLDE, il
mapping_IEMDEZ . =ml
mapping_InfFormis,xml

The M etadata M apping File arealiststhe XML filesthat hold the conversion parameters for each database
type used in Talend Open Sudio for Big Data.

* You can import, export, or delete any of the conversion files by clicking Import, Export or Remove
respectively.

« You can modify any of the conversion files according to your needs by clicking the Edit button to open
the [Edit mapping file] dialog box and then modify the XML code directly in the open dialog box.

2.5.14. SQL Builder preferences (Talend > Specific
Settings)

Y ou can set your preferences for the SQL Builder. To do so:
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1. Fromthe menu bar, click Window > Prefer ences to open the [ Pr efer ences] dialog box.

2. Expand the Talend and Specific Settings nodes in succession and then click Sql Builder to display the
relevant view.

SqlBuilder Sl v

[] add quotes, when you generate sql statement
85400 501 generation
(%) Standard SQL Statement

{:} Swskem SOL Skatement

Enable check queries in the database components {disable to avoid warnings For specific queries)

3. Customize the SQL Builder preferences according to your needs:

» Select the add quotes, when you generated sgl statement check box to precede and follow column and
table names with inverted commasin your SQL queries.

* In the AS400 SQL generation area, select the Standard SQL Statement or System SQL Statement
check boxes to use standard or system SQL statements respectively when you use an AS400 database.

 Clear the Enable check queriesin the database components (disable to avoid warnings for specific
gueries) check box to deactivate the verification of queriesin al database components.

2.5.15. Usage Data Collector preferences (Talend >
Usage Data Collector)
By alowing Talend Open Studio for Big Data to collect your Studio usage statistics, you help users better

understand Talend products and help Talend better learn how users are using the products, thus enabling Talend
to improve product quality and performance to serve users better.

By default, Talend Open Sudio for Big Data automatically collects your Studio usage data and sends this data on
aregular basis to servers hosted by Talend. Y ou can view the usage data collection and upload information and
customize the Usage Data Collector preferences according to your needs.

Be assured that only the Studio usage statistics datawill be collected and none of your private information will be collected
a and transmitted to Talend.

1. Fromthe menu bar, click Window > Preferences to display the [Prefer ences] dialog box.

2. Expand the Talend node and click Usage Data Collector to display the Usage Data Collector view.

Usage Data Collector =T -
- Appearance - The Usage Data Collector callects information abaut how
*|- Companents individuals are using the Talend products. The intent is to use
Documentation this data to help users and organizations better understand
Exchange how developers are using Talend products.
- Import/Export Enable capture
Internationalization
Metadata
Performance
Run/Debug

+- Specific Settings

R | Isage Data Collector

Talend Compaonent Desian

32 Talend Open Studio for Big Data User Guide



Customizing project settings

3. Read the message about the Usage Data Collector, and, if you do not want the Usage Data Collector to collect
and upload your Studio usage information, clear the Enable captur e check box.

4. Tohaveapreview of the usage data captured by the Usage Data Collector, expand the Usage Data Collector
node and click Preview.

Preview =T v

The following Keys/Values have been captured by the Usage Data Collectar.

Key Value
= tokenStudio

typestudio tos

unigueld RURUfjefSckhad /(4RS 3EI0pJz+KTLzGScr YBBUAT. ..

VErsion 5.0.0.RC1_r70511

= properties

tos.count.businessModels 0
tos. count. componentsPerJob 0.0
tos.count.contextVariablesPerdob 0.0
tos. count. debugRuns 0
tos.count.generatedJobDocs 0
tos.count, jobExports u]
tos.count. jobs 0
tos.count, jobsPerProject 0.0
tos,count. localProjects 1
tos.count.metadatas 0
tos.count.runs 0
tos.count.usercomponents u]
tos.job. frequentComponents <Empty=
tos.user.components <Empty =

5. To customize the usage data upload interval and view the date of the last upload, click Uploading under the
Usage Data Collector node.

Uploading =T v
Information gathered by the Usage Data Collector is periodically uploaded to servers hosted by Talend.
Ipload Period | 10 Days

Last Upload

« By default, if enabled, the Usage Data Collector collects the product usage data and sends it to Talend
serversevery 10 days. To changethe dataupload interval, enter anew integer value (in days) in the Upload
Period field.

» Theread-only Last Upload field displays the date and time the usage datawas last sent to Talend servers.

2.6. Customizing project settings

Talend Open Studio for Big Data enables you to customize the information and settings of the project in progress,
including the Palette, Job settings, for example.

To customize project settings:

1
Click = on the Studio tool bar, or select File > Edit Project Properties from the menu bar.
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The [Project Settings] dialog box opens.

% Project Settings

= General

Version Management
[=- Designer

Palette Setkings RIS | BEE |
[=- Job Settings Descrpbion | This project gathers the Jobs created ko

Skats & Logs daocurnent the components in the Talend

Implicit context lnad Component Reference Guide,

Idse Project Settings

Stakus
Security

[Restnre Qefaults][ Apply ]
@:l Impart H Expart H (8] 4 H Cancel ]

2. Inthetree diagram to the left of the dialog box, select the setting you wish to customize and then customize
it, using the options that appear to the right of the box.

From the dialog box you can also export or import the full assemblage of settings that define a particular project:

» To export the settings, click on the Export button. The export will generate an XML file containing all of your
project settings.

» Toimport settings, click on the Import button and select the XML file containing the parameters of the project
which you want to apply to the current project.

2.6.1. Palette Settings

Y ou can customize the settings of the Palette display so that only the components used in the project are loaded.
Thiswill allow you to launch the Studio more quickly.

To customize the Palette display settings:

1
On the toolbar of the Studio’s main window, click = or click File > Edit Project Properties on the menu

bar to open the [Project Settings] dialog box.
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% Project Settings
General Palette Settings

= Designer
Palette Settings

[ Business

Job Settings [= Business Inteligence
Statu.s [= Customn Code
Security !

(== Data Quality

[= Databases

= ELT

[= File

[ File5cale

[= Internet

[ Logs & Errors

= Misc

[= Orchestration

(= Processing

(== System

[Z= Talend MDM

[= Technical

=

[Resture gefaults] [ Apply ]

@:‘ [ Impork ][ Export H [0]4 H Cancel ]

In the General view of the [Project Settings] dialog box, you can add a project description, if you did not do so
" when creating the project.

2. In the tree view of the [Project Settings] dialog box, expand Designer and select Palette Settings. The
settings of the current Palette are displayed in the panel to the right of the dialog box.

3. Select oneor several components, or even set(s) of components you want to remove from the current project’s
Palette.

4. Use the left arrow button to move the selection onto the panel on the left. This will remove the selected
components from the Palette.

5. Tore-display hidden components, select them in the panel on theleft and use the right arrow button to restore
them to the Palette.

6. Click Apply to validate your changes and OK to close the dialog box.

To get back to the Palette default settings, click Restor e Defaults.
r

For more information on the Palette, see section How to change the Palette layout and settings.

2.6.2. Status management

Y ou can also manage the status of each item in the Repository tree view through General > Status Management
of the [Project Settings] dialog box.
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To do so:

1.

On the toolbar of the Studio main window, click = or click File > Edit Project Propertiesfrom the menu
bar to open the [Project Settings] dialog box.

2. Inthetreeview of thedialog box, expand General and select Status M anagement to open the corresponding
view.
# Project Settings |:|@®
=) Genersl Status Management
Version M
.Stat_ls M: £4 Job Designs Options
?;;IEZtEi;ngs /e Ez;;e’(ts (") Change all technical items to a fixed status.
Status [J& Routines (") Change all documentation items to a fixed status.
security |:|=__|l SQL Templates
(%) Update the Status of each item.
Items Status Mew Status
’Eb Job0i1_bd development | development v 3§
T globalcontext development | testing | ¥
= | = ’Restore Defaults] l Apply ]
@:l l Import ] l Export ] [ Ok l l Cancel ]
3. Inthe Repository tree view, expand the node holding the items you want to manage their status and then
select the check boxes of these items.
The selected items display in the Items list to the right along with their current status in the Status column
and the new status set in the New Status column.
4. Inthe Options area, select the Change all technical itemsto a fixed status check box to change the status
of the selected items to the same fixed status.
5. Click Revert if you want to undo the changes.
6. Toincrement each status of the items, select the Update the version of each item check box and change
them manually.
7. Click Apply to apply your changes and then OK to close the dialog box.
For further information about Job status, see section Status settings.
J
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2.6.3. Job Settings

You can automatically use Implicit Context Load and Stats and L ogs settings you defined in the [Project
Settings] dialog box of the actual project when you create a new Job.

To do so:

1.
On the toolbar of the Studio main window, click =

bar to open the [Project Settings] dialog box.

or click File> Edit Project Propertiesfrom the menu

2. Inthetreeview of the dialog box, click the Job Settings node to open the corresponding view.

3. SdecttheUseproject settingswhen create a new job check boxes of the Implicit Context L oad and Stats
and L ogs aress.

% Project Settings |Z|@@

= General Job Settings
Version Manac
Designer Implicit Conkexk Load
7 ) i )
- Il=e project settings when create a new job
Security Skats and logs
Iz project settings when create a new job
¢ 5 [Restn:-re DeFauIts] [ Apply ]
(@ Irnpott ] [ Expott ] [ (04 ] [ Cancel ]

4. Click Apply to validate your changes and then OK to close the dialog box.

2.6.4. Stats & Logs

When you execute a Job, you can monitor the execution through the tStatCatcher Statistics option or through
using alog component. Thiswill enable you to store the collected log datain .csv files or in a database.

Y ou can then set up the path to the log file and/or database once for good in the [Pr oj ect Settings] dialog box so
that the log data get always stored in this location.

To do so:
1.

On the toolbar of the Studio main window, click =
bar to open the [Project Settings] dialog box.

or click File> Edit Project Propertiesfrom the menu

2. Inthe tree view of the dialog box, expand the Job Settings node and then click Stats & L ogs to display
the corresponding view.
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Stats Logs

[Jon consale
O Files

File Path

Stats File Mame
Log File Mame
Meter file name
Encoding

Cn Datsbases
Property Type
Db Type

Host

Db Mame

User

Stats Table
Logs Table
Meter Table

=g statistics (tStatCatcher) Use logs (tLogCatcher) Use volumetrics (tFlowMeterCatcher)

| "E:/Studios  Talend_5,/TOS_BD-r82445-Y5, 1.0MB jworkspace/.metadata”

D

| "stats_file, twt”

*

| Togs_file, txt”

| ‘meter_file, twt”

—

*

[SO-8855-15 |w

|My5QL v |* Db Yersion *

| localhost” |F‘|:urt | "3308" |
| “talend” |.ﬁ.ddiﬁanal parameters | "noDatetimeStringSync=true |
|'r|:u:|t' |* Password |'*‘“*‘“*‘“*‘“*" |*
| “statistics” E]

| logs” E]

| "volumetrics'| E]

Catch runtime errors Catch user errors Catch user warnings
[Jcatch components statistics {tStatCatcher Statistics)

If you know that the preferencesfor Stats& Logswill not change depending upon the context of execution, then simply

set permanent preferences. If you want to apply the Stats & Logs settings individually, then it is better to set these

parameters directly onto the Stats & Logs view. For more information about this view, see section How to automate
the use of statistics & logs.

Select the Use Statistics, Use L ogs and Use Volumetrics check boxes where relevant, to select the type of
log information you want to set the path for.

Select aformat for the storage of the log data: select either the On Files or On Database check box. Or select
the On Console check box to display the datain the console.

The relevant fields are enabled or disabled according to these settings. Fill out the File Name between quotes or
the DB name where relevant according to the type of log information you selected.

2.6.5. Context settings

Alternatively, if you save your connection information in a Context, you can also access them through Ctrl+Space.

Y ou can define default context parameters you want to use in your Jobs.

To do so:

1

On the toolbar of the Studio main window, click = |
bar to open the [Project Settings] dialog box.

or click File> Edit Project Propertiesfrom the menu

In the tree view of the dialog box, expand the Job Settings node and then select the Implicit Context L oad
check box to display the configuration parameters of the Implicit tContextL oad feature.
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Project Settings use

Implicit context load

Implicit tZonkextLoad
Implicit EContextLoad

(%) From File

") From Database

From File context, IMPLICIT _TCOMTEXTLOAD_FILE E]
Field Separator "t

If a wariable lnaded, buk not in the conkext | Warning s

If a wariable in the conbext, buk not loaded | Warning s

|:| Print operations
[ ] pisable errars [¢] Disable warnings [] Disable infos

[Restu:ure Qefaults] [ Apply

Select the From File or From Database check boxes according to the type of file you want to store your
contextsin.

For files, fill in thefile path in the From File field and the field separator in the Field Separ ator field.
For databases, select the Built-in or Repository mode in the Property Typelist and fill in the next fields.
Fill in the Table Name and Query Condition fields.

Select the type of system message you want to have (warning, error, or info) in case avariableisloaded but
is not in the context or vice versa.

Click Apply to validate your changes and then OK to close the dialog box.

2.6.6. Project Settings use

From the [Project Settings] dialog box, you can choose to which Job in the Repository tree view you want to
apply the Implicit Context L oad and Stats and L ogs settings.

To do so:

1

On the toolbar of the Studio main window, click =~ or click File > Edit Project Propertiesfrom the menu
bar to open the [Project Settings] dialog box.

In the tree view of the dialog box, expand the Job Settings node and then click Use Project Settings to
display the use of Implicit Context Load and Stats and L ogs option in the Jobs.
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Use Project Settings

Select the itern you wank to use project setkings

Implicit Context Load Settings Skaks Logs Settings
= [E]sp Job Designs = [E]ip Job Designs
-] misc -] misc
=-[w] (= roadshow =[] = roadshow
+py roadshow_exoZ 0,1 py roadshow_exoZ 0,1
“py roadshow_exo3 0.1 py roadshow_exo3 0,1
S test 0.1 S best 0.1
=[] sco -] sco

+
+

[0 t01_cCompo

[]0 t02_cencatening
[0 to3_DemoRoutines
[ to4_Conkext

[0 t01_cCompo

[0 t02_cConcatening
[0 to3_DemoRoutines
[ tos_Conkext

+
+

+
+

+
+

[ Jrip beforeRundobs 0.1 [Jrin beforerunlobs 0.1
[Jih job 0.1 [Jih job 0.1
[riy positionalfile 0.1 [rin positionalfile 0.1
ety priorTest 0.1 [Jeta priorTest 0.1
ety readme 0.1 et readme 0.1
[ ity regex 0.1 [etp regex 0.1
ipy retrievecustomerscherna 0,1 ipy retrievecustomerscherna 0.1
[eigy =ml 0,1 [ty =oml 001
IRestDre DeFauItsI [ Apply

In the Implicit Context Load Settings area, select the check boxes corresponding to the Jobs in which you
want to use the implicit context load option.

In the Stats L ogs Settings area, select the check boxes corresponding to the Jobs in which you want to use
the stats and logs option.

Click Apply to validate your changes and then OK to close the dialog box.

2.6.7. Status settings

In the [Project Settings] dialog box, you can aso define the Status.

To do so:

1

o

On the toolbar of the Studio main window, click
bar to open the [Project Settings] dialog box.

or click File> Edit Project Propertiesfrom the menu

2. Inthetree view of the dialog box, click the Status node to define the main properties of your Repository
tree view elements.
The main properties of a repository item gathers information data such as Name, Purpose, Description,
Author, Version and Status of the selected item. Most properties are free text fields, but the Status field
isadrop-down list.
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% Project Settings

General Status
Desigrer
Job Settings Technical status
Skak
3 U,S Code Label
Security -
DEY development
TEST kesting Remove
PROD production

Mew. ..

Davan

Documentation skatus

Code Label
1st 15k wersion
2nd 2nd wersion
WAL Yalidate
[Restnre Qefaults] [ apply ]
':':’:' Irnpork ] [ Export ] [ (04 ] [ Cancel ]

3. Click the New... button to display a dialog box and populate the Status list with the most relevant values,
according to your needs. Note that the Code cannot be more than 3-character long and the L abel is required.

Code:

Label: | Cualiby Assurance| |

[ Ok, H Cancel ]

Talend makes a difference between two status types: Technical status and Documentation status.

The Technical statuslist displays classification codes for elements which are to be running on stations, such
as Jobs, metadata or routines.

The Documentation status list helps classifying the elements of the repository which can be used to
document processes.

4. Onceyou completed the status setting, click OK to save

The Status list will offer the status levels you defined here when defining the main properties of your Job
designs.

5. Inthe[Project Settings] dialog box, click Apply to validate your changes and then OK to close the dialog
box.
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2.6.8. Security settings

Y ou can hide or show your passwords on your contexts, and so on when they are stored inthe Repository treeview.
To hide your password:

1
On the toolbar of the Studio main window, click = or click File > Edit Project Propertiesfrom the menu

bar to open the [Project Settings] dialog box.
2. Inthetreeview of the dialog box, click the Security node to open the corresponding view.
3. Sdlect the Hide passwor ds check box to hide your password.

4. Inthe[Project Settings] dialog box, click Apply to validate your changes and then OK to close the dialog
box.

2.7. Filtering entries listed in the Repository
tree view

Talend Open Sudio for Big Data provides the possibility to choose what nodes, Jobs or items you want to list
in the Repository tree view.

You can filter the Repository tree view by job name, Job status, the user who created the Job/items or simply

by selecting/clearing the check box next to the node/ item you want to display/hide in the view. Y ou can also set
several filters ssimultaneously.

2.7.1. How to filter by Job name

To filter Jobslisted in the Repository tree view by Job name, complete the following:

1.

In the Studio, click the 9 Lv@ icon in the upper right corner of the Repository tree view and select Filter
settings from the contextual menu.

The [Repository Filter] dialog box displays.
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# Repository Filter Setting

0 EE [ Filter By Mame :
Job Designs

B=1E

[ Contexts |

=] Code
[*]#3 Routines

':‘J. SQL Templates Filter By User : All Users

[#]/E} Recycle bin
Login FirstMame LastMame
.t | =

Filter By Status :
Code Label
DEV development
TEST testing
PROD production
not set status
kK, ] [ Cancel

Select the Filter By Name check box.

The corresponding field becomes available.

Filter By Mame :

| kMap*, kest®

The patterns are separated by comma, where
* = any string, ? = any character, ,, =,

Follow the rules set below the field when writing the patterns you want to use to filter the Jobs.

In this example, we want to list in the tree view al Jobs that start with tMap or test.

In the [Repository Filter] dialog box, click OK to validate your changes and close the dialog box.

Only the Jobs that correspond to the filter you set are displayed in the tree view, those that start with tMap

and test in this example
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A x | | $[@]Y = O
LCAL: companent
=1ty Job Designs
=I-[= components
=-[=- tMap
i tMap_03_persiskence_01_n_lookup
i tMap_08_persistence_01_n_laokup
#- [ Databases
=I-[= Impactanalysis
ipy TestImpactanalysisl 0,1
i1y TestImpackanalysisz 0,1
=-[== tMap
1y tMap_dieonerror 0.1
1y EMap_in_joblet 0.1

Y ou can switch back to the by-default tree view, which lists all nodes, Jobs and items, by simply clicking theicon 2. This
will cause the green plus sign appended on the icon to turn to aminus red sign (£.).

2.7.2. How to filter by user

To filter entries in the Repository tree view by the user who created the Jobs/items, compl ete the following:

1
In the Studio, click the - ng icon in the upper right corner of the Repository tree view and select Filter
settings from the contextual menu.

The[Repository Filter] dialog box displays.
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2.

# Repository Filter Setting |'._| |E| E|
[ Filter By Mame :
EE Job Designs
[ Contexts | |
= Code
[#]®=Y Routines
L] soL Templates Filter By User : [+] All Users
[#]/E} Recycle bin
Login FirstMame LastMame
< | >
Filter By Status :
Code Label
DEY development
TEST testing
FROD production
not set status
(0] ] [ Cancel

Clear the All Users check box.

The corresponding fields in the table that follows become available.
Filter By User : [_] all Users

Login FirstMarne LastMame
admin@company, com Adminiskr akar Adniniskrakor
nha@talend. com kalend nha
Copy_of_Copw_of,.. talend nha

This table lists the authentication information of all the users who have logged in to Talend Open Studio for
Big Data and created a Job or an item.

Clear the check box next to auser if you want to hide all the Jobs/items created by him/her in the Repository
tree view.

Click OK to validate your changes and close the dialog box.

All Jobs/items created by the specified user will disappear from the tree view.

Y ou can switch back to the by-default tree view, which lists all nodes, Jobs and items, by simply clicking theicon L2 This
will cause the green plus sign appended on the icon to turn to aminus red sign (I@).
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2.7.3. How to filter by job status

To filter Jobsin the Repository tree view by the job status, complete the following:

1 =1
In the Studio, click the |§| l}s icon in the upper right corner of the Repository tree view and select Filter

settings from the contextual menu.

The [Repository Filter] dialog box displays.

# Repository Filter Setting |'._| |'E| E|
[CFilter By Mame :
£ Job Designs
[ Contexts | |
=] Code
[*]®=3 Routines
':-J‘ 5QL Templates Filter By User : [+] All Users
[#]'El Recycle bin
Login Firstiame LastiMame
< |
Filter By Status :
Code Label
DEV development
TEST testing
PROD production
not set status
[ (0] ] [ Cancel

2. Inthe Filter By Status area, clear the check boxes next to the status type if you want to hide all the Jobs
that have the selected status.

3. Click OK to validate your changes and close the dialog box.

All Jobs that have the specified status will disappear from the tree view.

Y ou can switch back to the by-default tree view, which lists all nodes, Jobs and items, by simply clicking theicon 9. This

will cause the green plus sign appended on the icon to turn to aminus red sign (I@).

2.7.4. How to choose what repository nodes to display

To filter repository nodes, complete the following:

1. =
In the Studio, click the |§| Lv@ icon in the upper right corner of the Repository tree view and select Filter
settings from the contextual menu.

46 Talend Open Studio for Big Data User Guide



How to choose what repository nodes to display

2.

The [Repository Filter] dialog box displays.

# Repository Filter Setting __ E' E|
[ Filter By Mame :
EE Job Designs
I Contexts | |
=] Code
[*]#3 Routines
':‘J. SQL Templates Filter By User : All Users
[*]'E Recycle bin
Login FirstMame LastMame
< | 3
Filter By Status :
Code Label
DEV development
TEST testing
PROD production
not set status
[ OK ] [ Cancel

Select the check boxes next to the nodes you want to display in the Repository tree view.

’Eh Job Designs
[ Contexts
=[] & Code
[J#¥ Routines
.=_r SOL Templates
[1/El Recycle bin

Consider, for example, that you want to show in the tree view all the Jobslisted under the Job Designs node,
and the SQL Templates node.

Click OK to validate your changes and close the dialog box.

Only the nodes/folders for which you selected the corresponding check boxes are displayed in the tree view.
Repository &3 = O
LOCAL: Projectiame = 'l.’>{h |@| L=

)_:E Job Designs
.=_r SOL Templates
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If you do not want to show all the Jobs listed under the Job Designs node, you can filter the Jobs using the Filter By Name
i check box. For more information on filtering Jobs, see section How to filter by Job name.
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Chapter 3. Designing a data integration Job

Talend Open Sudio for Big Data is the tool with the capabilities that treat all of the different sources and targets
required in data integration processes and al other associated operations.

This chapter helps you to design data integration Jobs that alow you to put in place up and run dataflow
management processes.

Before starting any data integration processes, you need to be familiar with the Talend Open Sudio for Big Data
Graphical User Interface (GUI). For more information, see appendix GUI.
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What isaJob design

3.1. What is a Job design

A Job Design isagraphical design, of one or more components connected together, that allows you to set up and
run dataflow management processes. A Job Design trand ates business needs into code, routines and programs, in
other words it technically implements your data flow.

The Jobsyou design can address all of the different sources and targetsthat you need for dataintegration processes
and any other related process.

When you design a Job in Talend Open Sudio for Big Data, you can:
 put in place dataintegration actions using alibrary of technical components.

 change the default setting of components or create new components or family of components to match your
exact needs.

* set connections and relati onshi ps between componentsin order to define the sequence and the nature of actions.
* access code at any time to edit or document the components in the designed Job.

 create and add items to the repository for reuse and sharing purposes (in other projects or Jobs or with other
users).

In order to be able to execute the Jobs you design in Talend Open Studio for Big Data, you need toinstall an Oracle JVM 1.6
&3 or later (IBM JVM isnot supported). You can download it from http: //www.or acl e.com/technetwor k/java/javase/downl oads/
index.html.

3.2. Getting started with a basic Job design

_ Until a Job is created, the design workspace is unavailable and the Pal ette does not display.
£5

A Job design is made of one or several subjobs, which are themselves defined by one or, most likely, severa
components linked together. The properties of each component require to be configured individually, in order to
function properly.

For more information, see section How to connect components together and section How to define component
properties.

3.2.1. How to create a Job

Talend Open Sudio for Big Data enables you to create a Job Design by dropping different technical components
from the Palette onto the design workspace and then connecting these components together.

You can aso create different folders to better classify these Jobs.
To create a Job, complete the following:

1. Open Talend Open Studio for Big Data following the procedure detailed in section Launching Talend Open
Sudio for Big Data.

2. Inthe Repository tree view, right-click the Job Designs node and select Create job from the contextual
menu.
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How to create a Job

f Repository 57 = B
LOCAL: ProjectMame t:;.':h g ~
BRI ) Create job
®- 5 Code | (9 Create folder
. Expand,/Collapse
o IE]' Recydle [& Export Job
(gl Import items
Ga Export items

The [New job] wizard opens to help you define the main properties of the new Job.

New job
Add a job in the repositary %

Mame | DECuskam |

Purpose | |

Description | description goes here. .,

author | user@company.com |
Locker | |
Version | (.1 [m][m]
Status | v
Path | | select |

@ L Firish ”_ Cancel

Enter the Job properties according to the following table:

Field Description

Name the name of the new Job. A message comes up if you enter prohibited characters.

Purpose Job purpose or any useful information regarding the Job use.

Description Job description.

Author aread-only field that shows by default the current user login.

L ocker aread-only field that shows by default the login of the user who owns the lock on the current Job. This
field is empty when you are creating a Job and has data only when you are editing the properties of
an existing Job.

Status alist to select from the status of the Job you are creating.

Path alist to select from the folder in which the Job will be created.
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How to drop components to the workspace

An empty design workspace opens up showing the name of the Job as atab label.

4. Drop the components you want to use in your Job design from the Palette onto the design workspace and
connect them together. For more information, see section How to drop components to the workspace and
section How to connect components together.

5. Define the properties of each of the components used in the Job. For more information, see section How to
define component properties.

6. Saveyour Job and then press F6 to execute it. For more information, see section How to run a Job.
The Job you created is now listed under the Job Designs node in the Repository tree view.

Y ou can open one or more of the created Jobs by simply double-clicking the Job label in the Repository tree view.
2

To create different folders for your Jobs, compl ete the following:
1. IntheRepository tree view, right-click Job Designs and select Create folder from the contextual menu.
The [New folder] dialog box displays.

% New folder, |:|@E|

Folder

Create a new Folder in repository | i 7

Label | testing3si|

'.f?:' Firish ] [ Cancel

2. IntheLabel field, enter a name for the folder and then click Finish to confirm your changes and close the
dialog box.

The created folder islisted under the Job Designs node in the Repository tree view.

If you have already created Jobs that you want to move into this new folder, simply drop them into the folder.
r

For a scenario showing how to create a real-life data integration Job, see appendix Theory into practice: Job
examples.

3.2.2. How to drop components to the workspace

3.2.2.1. How to drop components from the Palette

To actually start building a Job, click a component on the Palette. Then click again on the design workspace to
drop it there and add it to your Job Design.

If the Palette does not show in the Studio, see section How to show, hide the Palette and change its position.
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How to search components in the Palette

Y ou can drop a note to your Job the same way you drop components. For more information, see section How to add notes
i to a Job design.

Each newly added component displays generally in a blue square that symbolizesit as an individual Subjob.

41y *Job Customdob 0.1 532 = O .7 palette 232 =0
. . . . . . . . . . . search component, | Ok
[= Business Inteligence
— [.—= Business
(%) [== Cuskom Code
@' | = Data Ouality
trilelnputDelimited_1 [ ' ' - || SaBaishasss
[==ELT
(== File £
[—= Input
Designer | Code T bt
A s = PR ELP| d b » = H =5 tFileInputARFF
= EFileInputDelimited

Connect componentstogether in alogical order using the connections offered, in order to build afull Job or subjab.
For more information about component connection types, see section Connection types.

The Job or subjob gets highlighted in one single blue rectangle. For more information about Job and subjob
background color, see section How to manage the subjob display.

Multiple information or warnings may show next to the component. Browse over the component icon to display
the information tooltip. This will display until you fully completed your Job design and defined all basic (and
sometimes advanced) component properties of the Component view.

_ You will be reguired to use Java code for your project.
25

Related topics:
* section How to connect components together.
* section Warnings and error icons on components.

* section How to define component properties.

3.2.3. How to search components in the Palette

If you do not want to browse the components families in the Palette to find the components you want to use in
your Job, you can search the desired component directly in the search field at the top of the Palette.

-5 Palette 3 = B8

o
]
e

Find companent. .. -

== Big Data
[=- Business Inteligence

[ Business

Talend Open Studio for Big Data User Guide 53



How to connect components together

To search for acomponent, do the following:

L Click “ to clear the search field of any text.

2. Enter the name of the component you want to look for and click OK.

The Palette displays only the family/families that hold(s) the component.

.2 Palette P2 = O

tRunJob| O

[== Qrchestration £
¥ tRunlob

== Svstem 0
¥ tRunlob

To go back to the default Palette settings, click

3.2.4. How to connect components together

A Job or asubjob is defined by agroup of componentsinterconnected in alogical way. The Job itself can be built
with several subjobs carrying out various processings.

The component forming a subjob, as well as the subjobs are connected to each other using various types of
connections.

Also, a Job (made of one or more subjobs) can be preceded by a pre-job and followed by a post-job components,
in order to ensure that some specific tasks (often not related to the actual data processing) are performed first or
last in the process. For more information, see section How to use the tPrejob and tPostjob components.

To connect two components, right-click the source component on your design workspace, select your type of
connection from the contextual menu, and click the target component.

When dragging the link from your source component towards the target component, a graphical plug indicates if
the destination component is valid or not. The black crossed circle disappears only when you reach avalid target
component.

Only the connections authorized for the selected component are listed on the right-click contextual menu.

The types of connections proposed are different for each component according to its nature and role within the
Job, i.e. if the connection is meant to transfer data (from a defined schema) or if no datais handled.

The types of connections available also depend if data comes from one or multiple input files and gets transferred
towards one or multiple outputs.

For more information about the various types of connections and their specific settings, see section Using
connections.

3.2.5. How to drop components in the middle of a Row
link

When creating a Job, Talend Open Sudio for Big Data enables you to insert acomponent in the middle of a Row
> Main, Row > Reject or Row > Combine connection.
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How to drop components in the middle of a Row link

To do so, complete the following:
1. Drop two combine and two file components from the Palette onto the design workspace.

2. Connect the component pairs using a Row > Main (or a Row > Reject) connection and a Row > Combine
one.

% _ ~ rowd {C-:nml;uine]l _ _ .':Q:I

tCombinedsQLInput_1 tCombinedSQLFilker 1

B- - - rl:l'.;'\'S {Ma:il'ljl . . . =.@.

tFileInputDelimited 2 ’ ' " tFileCutputDelimited 1

3. Drop the component you want to insert in the middle of the row. The link gets bold and then a dialog box
displays, prompting you to type in a name for the output link.

[} [}

- - - .& - L . . . .
% rowll (Cumbine}l;% i
tCombinedSQLInpuUE_1 ' tMap_17 ' [ ' tCombinedSQLFilker 1
% tMap_170utput fgl

new Cubput name?

@_ (o] |

EFileInputDelimite

Ok H Cancel ]

4. Typeinaname and click OK to close the dialog box.

Y ou may be asked to retrieve the schema of the target component. In that case, click OK to accept or click No to deny.

The component isinserted in the middle of the link, which is now divided in two links.

% rowd {Combine) =E 4 ok (Main) =$]

tCombinedSOLInput_1 tap_ 12 tCombinedsoLFilker 1

B. ru:w.uS {Ma:in]l = %. . l:nut:Ell {Ma:.in} . =.@.

tFileInputDelimited 2 tMap_14 ' EFileCubputDelimited 1
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How to define component properties

3.2.6. How to define component properties

The properties information for each component forming a Job or a subjob allows to set the actua technical
implementation of the active Job.

Each component is defined by basic and advanced properties shown respectively on the Basic Settings tab and
the Advanced Settings tab of the Component view of the selected component in the design workspace. The
Component view gathers also other collateral information related to the component in use, including View and
Documentation tabs.

For detailed configuration for each component displaying in the Palette, check Talend Open Sudio for Big Data
Components Reference Guide.

3.2.6.1. Basic Settings tab

The Basic Settingstab is part of the Component view, which islocated on the lower part of the designing editor
of Talend Open Sudio for Big Data.

=0
@ tFileInputDelimited_1 =S G

Basic settings Property Type

Advanced settings "When the input source is a stream or a zip file, footer and random shouldn't be bigger than 0.
Dynamic settings File name/Stream | "D /Talend,Input/California_Clients.csy” * E]
L= Row Separator “In’ Field Separator | " *
Documentation D CSV options

Header 1 Footer |0 Limit

Schema Edit schema E]

Skip empty rows |:| IUncompress as zip file |:| Die on error

Each component has specific basic settings according to its function requirements within the Job. For a detailed
description of each component properties and use, see Talend Open Studio for Big Data Components Reference
Guide.

Some components require code to be input or functions to be set. Make sure you use Java code in properties.

How to set a schema

Click the Edit Schema button to create your built-in schema by adding columns and describing their content,
according to the input file definition.
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How to define component properties

% Schema of tFilelnputDelimited_1

tFileInputDelimited_1

Colurmn kKey  Type w] Mull,.. DatePatt... | Length Fr.. D,

I%___--

Firstiame String

LastiMame |:| String 1|II

Address [] string 0

City [] string g
< >
BIEREDIEIRIEIE

[ K, ] [ Cancel

In al output properties, you aso have to define the schema of the output. To retrieve the schema defined in the

input schema, click the Sync columns tab in the Basic settings view.

Some extrainformation isrequired. For moreinformation about Date pattern for example, check out: http://docs.oracle.com/

2 javasel/6/docg/api/index.html.

How to set a field dynamically (Ctrl+Space bar)

On any field of your Job/component Properties view, you can use the Ctrl+Space bar to access the global and

context variable list and set the relevant field value dynamically.

1. Placethe cursor on any field of the Component view.

2. PressCtrl+Space bar to access the proposal list.

3. Select onthelist therelevant parametersyou need. Appended to the variablelist, ainformation panel provides

details about the selected parameter.

Description: Error Message

Twpe: Skring
Availability: After

Global variable, property of component EMap [HMap_1].

Yariable Mame: {({String)globalMap,get("tMap_1_ERROR_MESSAGE™)

tFileInputDelimited_2 . ERROR_MESSAGE
tFileInputDelimited_2.ME_LIME
tMap_1.ERR.OR_MESSAGE
tFileCutputDelimited_1 ERROR,_MESSAGE
tFileCutputDelimited_1.MNE_LIME
kFileCutpukDelimited_2 ERROR,_MESSAGE
tFileCutputDelimited_2 NE_LIME
tFileInputDelimited_3, ERROR_MESSAGE
tFileInputDelimited_3.ME_LINE
tFlowMeter 1, ERROR_MESSAGE
tFFlowMeter 2 ERROR_MESSAGE

This can be any parameter including: error messages, number of lines processed, or else... The list varies
according to the component in selection or the context you are working in.

Related topic: section How to centralize contexts and variables.

3.2.6.2. Advanced settings tab

Some components, especialy File and Databases components, provides numerous advanced use possibilities.
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How to define component properties

Iﬁ tFileInputDelimited_1

[ ] advanced separator (For numbers)

Easic settings
[Extract lines at randam  Encoding Type | 1S0-8852-15

Advanced settings

Dvnamic settings [ Ttim all calumn ] Check each row skructure againsk schema

Wit Check columin to trir Calumn 1 Trim

Documnentation ke ]
valle ]

] split row before Field
[ ]tstatCakcher Skatiskics

The content of the Advanced settings tab changes according to the selected component.

Generally you will find on this tab the parameters that are not required for a basic or usual use of the component
but may be required for a use out of the standard scope.

How to measure data flows

You can aso find in the Advanced settings view the option tStatCatcher Statistics that allows you, if selected,
to display logs and statistics about the current Job without using dedicated components. For more information
regarding the stats & log features, see section How to automate the use of statistics & logs.

3.2.6.3. Dynamic settings tab

The Basic settings and Advanced settingstabs of al all components display various check boxes and drop-down
lists for component parameters. Usually, available values for these types of parameters are either true or false and
can only be edited when designing your Job.

The Dynamic settings tab, on the Component view, allows you to customize these parameters into code or
variable.

This feature alows you, for example, to define these parameters as variables and thus let them become context-
dependent, whereas they are not meant to be by default.

Another benefit of this feature is that you can now change the context setting at execution time. This makes full
sense when you intend to export your Job in order to deploy it onto a Job execution server for example.
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How to define component properties

' =10
= tContextload_1 B D

Basic setktings

Advanced settings Mame Code

Dynamic settings Print operations conkext.verbose
kSkabZatcher Statistics ¥ False

Wigw If a variable in the context, but not loded A

Disable errors
Disable warnings
Dizable infos

Dacument ation

To customize these types of parameters, as context variables for example, follow the following steps:

1. Select the relevant component basic settings or advanced settings view that contains the parameter you want
to define asavariable.

2. Click the Dynamic settings tab.
3. Click the plus button to display a new parameter line in the table.

4. Click the Name of the parameter displaying to show the list of available parameters. For example: Print
operations

5.  Then click in the facing Code column cell and set the code to be used. For example: context.verbose if you
create the corresponding context variable, called verbose.

As code, you can input a context variable or a piece of Java code.

The corresponding lists or check boxes thus become unavailable and are highlighted in yellow in the Basic
settings or Advanced settings tab.

‘ =0
i#ps) tContextlLoad_1 == E
Basic settings Schema Tvpe Built-In ~ || Edit schema E]
Advanced settings If a wariable loaded, but not in the conkesxt | Info w
Dynamceetines If & variable in the cantext, but not loaded | Info v
Wien
Documentakion

Disable errars Disable warnings Disable infos

If you want to set a parameter as context variable, make sure you create the corresponding variable in the Context view.

For more information regarding the context variable definition, see section How to use variablesin the Contexts view.

You can aso use aglobal variable or pieces of Java code to store the values to be used for each parameter.
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<y Component 75 Job Settingsi Contexts(Ioh | B Run (Iob Cop | (210 Problems | =, Modules Y scheduler | — B

I, tWwarn_1

Basic setkings

Advanced settings Mame Code

- . Prictity {{IntegeriglobalMap. get("tFilelnputDelimited _1_ME_LINE")=673:4)
Dynamic settings

Wiew

Documentation

[ e nddl [ x Delete]

For example, use some global variable available through the Ctrl+Space bar keys, and adapt it to your context.

3.2.6.4. View tab

The View tab of the Component view alows you to change the default display format of components on the
design workspace.

Field Description

Label format Free text label showing on the design workspace. Variables can be set to retrieve and display
values from other fields. The field tooltip usually shows the corresponding variable where the
field valueis stored.

Hint format Hidden tooltip, showing only when you mouse over the component.

Connection format Indicates the type of connection accepted by the component.

Y ou can graphically highlight both L abel and Hint text with HTML formatting tags:

Bold: <b> Y ourLabel OrHint </b>

Italic: <i> YourLabelOrHint </i>

* Return carriage: Y ourLabelOrHint <br> ContdOnNextLine

Color: <Font color=‘#RGBcolor’ > Y ourL abel OrHint </Font>

To change your preferences of this View panel, click Window>Pr efer ences>Talend>Designer.

3.2.6.5. Documentation tab

Feel free to add any useful comment or chunk of text or documentation to your component.
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+. Job DEoutput X — 0
136 +
137
138

139==headl tDBOutput tDBEOutput 1

140 Here goes the chunk of text doocumenting the component selected.
141 This comment displays as POD code in the Code panel.

142 =cut

143

144 $_glubals{tDBOutput_1}{OK} = falze:
14C

Cesigner | Code

= Properties &7 PerlDoc | RegExp | Tasks | Run (Job DEoutput) | Problems (Job DB, .. | Modules | Scheduler = 0O

o
s
M c@ tDBOutput
Properties
Wiew Camrment Here goes the chunk of text documenting the

Docurmentation Thi=s comment di=splayv=s as POD code in the Cod

W

In the Documentation tab, you can add your text in the Comment field. Then, select the Show Information
check box and an information icon display next to the corresponding component in the design workspace.

Y ou can show the Documentation in your hint tooltip using the associated variable  COMMENT _, so that when
you place your mouse on thisicon, the text written in the Comment field displays in atooltip box.

For advanced use of Documentations, you can use the Documentation view in order to store and reuse any type
of documentation.

3.2.7. How to run a Job

You can execute a Job in several ways. This mainly depends on the purpose of your Job execution and on your
user level.

If you are an advanced Java user and want to execute your Job step by step to check and possibly modify it on
the run, see section How to run a Job in Java Debug mode.

If you do not have advanced Java knowledge and want to execute and monitor your Job in norma mode, see
section How to run a Job in normal mode.

For how to run a Job on aremote Hadoop server via Oozie scheduler, see section How to run a Job on a remote
HDFSserver.

3.2.7.1. How to run a Job in normal mode

Make sure you saved your Job before running it in order for all properties to be taken into account.
-z

To run your Job in a normal mode, complete the following:
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How to run a Job

1. Click the Run view to accessiit.
2. Click the Basic Run tab to access the normal execution mode.

3. Inthe Context areato the right of the view, select in the list the proper context for the Job to be executed
in. You can also check the variable values.

If you have not defined any particular execution context, the context parameter table is empty and the context is
the default one. Related topic: section How to centralize contexts and variables.

1. Click Run to start the execution.

2. On the same view, the console displays the progress of the execution. The log includes any error message
as well as start and end messages. It also shows the Job output in case of atL ogRow component is used
in the Job design.

3. Todefine the lines of the execution progress to be displayed in the console, select the Line limit check box
and typein avauein thefield.

4. Select the Wrap check box to wrap the text to fit the console width. This check box is selected by default.
When it is cleared, a horizontal scrollbar appears, allowing you to view the end of the lines.

7 Jobikemp Contexts{ | ¢ Compone LB 4 [2¢ Problems | 7o, Modules | s Talend Ex EY Scheduler ?g JobHiera | — O

Job tempdata Frod 7

. Execution
Basic Run

Marne | Walue
Debug Run File: D:jtalend_Files/Prodfcu...

Advanced Setkings

Target Exec Starting job feapdses a6 11087 Flogresqia,

[statistics] connecting to socket on port
3620

[=tatistic=] connected

[=tatistic=s] disconnected

Sl fanmdaes anded 6 187 SRS
fowr s oode=i

[Juire limit | 100 Wrap < 3

Before running again a Job, you might want to remove the execution statistics and traces from the designing
workspace. To do so, click the Clear button.

If for any reason, you want to stop the Job in progress, smply click the Kill button. Y ou will need to click the
Run button again, to start again the Job.

Talend Open Studio for Big Data offers various informative features displayed during execution, such as statistics
and traces, facilitating the Job monitoring and debugging work. For more information, see the following sections.

3.2.7.2. How to run a Job in Java Debug mode

To follow step by step the execution of a Job to identify possible bugs, you can run it in Debug mode.
To access the Debug mode:

1. Click the Run view to accessit.

2. Click the Debug Run tab to access the debug execution modes.

In order to be able to run a Job in Debug mode, you need the EPIC module to be installed.
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Before running your Job in Debug mode, add breakpoints to the major steps of your Job flow.

1]

Lot

. —n
Contracks_Ref

This will alow you to get the Job to automatically stop at each breakpoint. This way, components and their
respective variables can be verified individually and debugged if required.

To add breakpoints to a component, right-click it on the design workspace, and select Add breakpoint on the
contextual menu.

A pause icon displays next to the component where the break is added.

To switch to debug mode, click the Java Debug button on the Debug Run tab of the Run panel. Talend Open
Sudio for Big Data’ s main window gets reorganized for debugging.

Y ou can then run the Job step by step and check each breakpoint component for the expected behavior and variable
values.

To switch back to Talend Open Sudio for Big Data designer mode, click Window, then Per spective and select
Talend Open Sudio for Big Data.

3.2.7.3. How to run a Job in Traces Debug mode

The traces feature allows you to monitor data processing when running a Job in Talend Open Sudio for Big Data.

It provides arow by row view of the component behavior and displays the dynamic result next to the Row link
on the design workspace.

=

@ rowl (Main =$§E auk {Main) ’ @
tFileInputDelimited 1 ' ' ' ' tMap_1 ' ' ' " tFileOutputDelimited 1
= rowl (Main) & Current rov ;4 F}' out {Main} & Currenkrow : 4
Postal ' ' ' ' ' ' '
State
Capital
MostPopulousCity

This feature alows you to monitor all the components of a Job, without switching to the debug mode, hence
without requiring advanced Java knowledge.

The Traces function displays the content of processed rowsin atable.

Exception is made for external components which cannot offer this feature if their design does not include it.
f

Y ou can activate or deactivate Traces or decide what processed columnsto display in the traces table that displays
on the design workspace when launching the current Job.

To activate the Traces mode in a Job:
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B. .rc'wl I.{Main]l: .':Eiﬁ . alLk l{r:ﬂain]l . ' %

kFileInputDelimited_1 ' EMap_1 ' tFileOuEpUEDelmited_1
. 4 . 4

1. Click the Run view.
2. Click the Debug Run tab to access the debug and traces execution modes.

3. Click thedown arrow of the Java Debug button and select the Traces Debug option. Anicon displays under
every flow of your Job to indicate that process monitoring is activated.

4. Click the Traces Debug to execute the Job in Traces mode.

To deactivate the Traces on one of the flows in your Job:

B. .rl:uwl I:{Main]l: =.§zﬁ. . ok {r:'-“lain]l . =.@.

kFileInputDelimited 1 EMap_1 ' tFileutput Delimited 1
L L]

1. Right-click the Tracesicon under the relevant flow.

2. Select Disable Tracesfrom thelist. A red minus sign replaces the green plus sign on the icon to indicate that
the Traces mode has been deactivated for this flow.

To choose which columns of the processed data to display in the traces table, do the following:

1. Right-click the Tracesicon for the relevant flow, then select Setup Tracesfrom thelist. The [Setup Traces]

dialog box appears.

Zolumn

o
[] postal

Capital
[] MastPopulou.. .

Ok l [ Cancel

2. Inthe dialog box, clear the check boxes corresponding to the columns you do not want to display in the
Tracestable.

3. Click OK to close the dialog box.
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@. .rcu.-'-.ll l::Main]I: =Eiﬁ . out {r:'-ﬂain]l . =.@.

tFileInputDelimited_1 tMap_1 ' FFileCutputDelimited _1
- = out (Main) & Current row: 2
D
State
Capital

Monitoring data processing starts when you execute the Job and stops at the end of the execution.

To remove the displayed monitoring information, click the Clear button in the Debug Run tab.

3.2.7.4. How to set advanced execution settings

Several advanced execution settings are avail able to make the execution of the Jobs handier:

» Statistics, thisfeature displays processing performance rate. For more information, see section How to display
Satistics.

» Exec time, this feature displays the execution time in the console at the end of the execution. For more
information, see section How to display the execution time and other options.

» Save Job before execution, this feature allows to automatically save the Job before its execution.
» Clear beforerun, thisfeature clears al the results of a previous execution before re-executing the Job.

* JVM Setting, thisfeature allowsyou to define the parameters of your JVM according to your needs, for example
the parameters used to display specia characters.

How to display Statistics
The Statistics feature displays each component performance rate, under the flow links on the design workspace.
51 rows in 0,035 51 rows in 0,035

[ T OIS I8 ronES E';% T i 18 ronsE ’ ’
@ rowl (Main) o auk (Main o @

EFileInputDelimited_1 ' EMap_1 ' tFileCutputDelimited 1

It shows the number of rows processed and the processing time in row per second, allowing you to spot straight
away any bottleneck in the data processing flow.

For trigger links like OnComponentOK, OnComponentError, OnSubjobOK, OnSubjobError and If, the
Statistics option displays the state of this trigger during the execution time of your Job: Ok or Error and True
or False.

Exception is made for external components which cannot offer this feature if their design does not include it.
7

In the Run view, click the Advanced settings tab and select the Statistics check box to activate the Stats feature
and clear the box to disableit.

The calculation only starts when the Job execution is launched, and stops at the end of it.
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Click the Clear button from the Basic or Debug Run views to remove the calculated stats displayed. Select the
Clear before Run check box to reset the Stats feature before each execution.

The statistics thread slows down Job execution as the Job must send these stats data to the design workspace in order to
| be displayed.

Y ou can aso save your Job before the execution starts. Select the relevant option check box.

How to display the execution time and other options

To display the Job total execution time after Job execution, select in the Advanced settings tab of the Run view
the Exec time check box before running the Job.

Thisway you can test your Job before going to production.
Y ou can also clear the design workspace before each Job execution by sel ecting the check box Clear before Run.

Y ou can a'so save your Job before the execution starts. Select the relevant option check box.

How to display special characters in the console

Talend Open Sudio for Big Data can display specia charactersin the console. To enable the display of Chinese,
Japanese or Korean characters, for example, proceed as follows before executing the Job:

£ Jo Co |52 Co [BRu E2 - [Bipr |[Zomo| dTa|EPsc | | ®mp| =0

Job MySAP

Biasic Fun Statistics Save Job before execution
Debug Run [JExec time Clear befare run
Advanced Settings WM Setting

Target Exec Job Run Y¥M arguments

Use specific 1M arguments

Argqument

d Mew, ., E
-Rms25EM
-mmx 10240

1. Select the Advanced settingstab.

2. IntheJVM settings area of the tab view, select the Use specific JVM arguments checkbox to activate the
Argument table.

3. Nexttothe Argument table, click the New... button to pop up the [Set the VM ar gument] dialog box.
4. Inthedialog box, typein-Dfil e. encodi ng=UTF- 8.
5. Click OK to close the dialog box.

This argument can be applied for all of your Job executionsin Talend Open Sudio for Big Data. For further
information about how to apply this VM argument for all of the Job executions, see section Debug and Job
execution preferences (Talend > Run/Debug).
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3.2.7.5. How to run a Job on aremote HDFS server

Talend Open Sudio for Big Data provides an Oozie scheduler, afeature that enables you to schedule executions
of aJob you have created or run it immediately on aremote Hadoop Distributed File System (HDFS) server, and
to monitor the execution status of your Job. For more information on Apache Oozie and Hadoop, check http://
oozie.apache.org/ and http://hadoop.apache.org/.

Before you can run or schedule executions of a Job on an HDFS server, you need first to define the HDFS
connection details either in the Oozie scheduler view or in the Talend Open Sudio for Big Data preference
settings, and specify the path where your Job will be deployed.

How to set HDFS connection details

Defining HDFS connection details in Oozie scheduler view

To define HDFS connection detailsin the Oozie scheduler view, do the following:
1. Click the Oozie schedule view beneath the design workspace.

£ Job{Californial 0 | 5F Component | 0B Run (Job Californi E‘? £ ., Modules
S ————————————S-l l s

Dozie Californial

Execute Job

| Eﬁ' Schedule | = Run | {ﬁ} Setting
Path juser fhdp /et ftalend fizhangiobs

2. Click Setting to open the connection setup dialog box.

Mame node end paint |hu:|fs:,-",-"192. 163.0.81

Job fracker end paint | 192, 1568.0,81:50300

Oozie end paint |htt|:|:,-",-"192. 168.0.81: 11000 /oozie

|zer Mame |hu:||:|

Ok ] [ Cancel

é{% The connection settings shown above are for an example only.

3. Fill inthe required information in the corresponding fields, and click OK close the dialog box.

Field Description
Name Node End Point URI of the name node, the centerpiece of the HDFS file system.
Job Tracker End Point URI of the Job Tracker node, which farms out MapReduce tasksto specific nodesin the cluster.
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Field Description
Oozie End Point URI of the Oozie endpoint, for Job execution monitoring.
User Name Login user name.

Once the connection details are defined viathe Oozie scheduler view, the Oozie preference settings are automatically
" updated, and vice versa. For information on Oozie preference settings, see section Defining HDFS connection details

in preference settings.

Once the connection details are defined in the Oozie scheduler view, the HDFS connection settings in the
[Preferences] dialog box are automatically updated, and vice versa.

Upon defining the deployment path in the Oozie scheduler view, you are ready to schedule executions of your
Job, or run it immediately, on the HDFS server.

Defining HDFS connection details in preference settings

To define HDFS connection detailsin the Talend Open Studio for Big Data preference settings, do the following:

1

2.

3.

From the menu bar, click Window > Pr efer ences to open the [Prefer ences] dialog box.

Expand the Talend node and click Oozie to display the Oozie preference view.

¥ Preferences

| Oozie 5
Install/Update s
Java T User Mame ||-,.:||:.
- Talend Mame node end paint |hdfs:,.",."192, 163.0.81

Appearance

Components Job Tracker End Paint | 192, 1658.0,81: 50300

Exchange Oogzie End Point |htt|:|:,-",-"1'§2. 168.0.81: 11000 /00zie

Import/Export
Internationalization

Metadata
Run/Debug
Spedfic Settings
Usage Data Collector o [RESt':'rE DEFE"-'HS] [ Apply
.
@J I OK ] [ Cancel

é’\_, The Ooz e settings shown above are for an example only.

Fill in the required information in the corresponding fields:

Field Description

User Name Login user name.

Name Node End Point URI of the name node, the centerpiece of the HDFS file system.

Job Tracker End Point URI of the Job Tracker node, which farms out MapReduce tasks to specific nodesin the cluster.
Oozie End Point URI of the Oozie endpoaint, for Job execution monitoring.

Oncethe connection detail s are defined in the[ Pr efer ences] dialog box, the HDFS connection settingsinthe Oozie
scheduler view are automatically updated, and vice versa. For information on the Oozie scheduler view, see
section How to run a Job on a remote HDFS server.
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How to run a Job on the HDFS server

To run a Job on the HDFS server,

1. Inthe Path field on the Oozie scheduler tab, enter the path where your Job will be deployed on the HDFS
server.

2. Click the Run button to start Job deployment and execution on the HDFS server.

Your Job data is zipped, sent to, and deployed on the HDFS server based on the server connection settings and
automatically executed. Depending on your connectivity condition, this may take sometime. The console displays
the Job deployment and execution status.

To stop the Job execution before it is completed, click the Kill button.

Oozie Californial

Execute Job
Kill 400 Setting
Path B Monitor

Rermote running is start-up...
Deploying a job to Hadoop. ..
Deployment complete!

Job is running ...

How to schedule the executions of a Job

The Oozie scheduler feature integrated in Talend Open Studio for Big Data enables you to schedule executions
of your Job on the HDFS server. Thus, your Job will be executed based on the defined frequency within the set
time duration. To configure Job scheduling, do the following:

1. Inthe Path field on the Oozie scheduler tab, enter the path where your Job will be deployed on the HDFS
server if the deployment path is not yet defined.

2.  Click the Schedule button on the Oozie scheduler tab to open the scheduling setup dialog box.

» E3

Frequency |1 | Time Unit [, v
Start Time |2012-04-27 15:13:05 (]
EndTime |2012-04-27 15:16:11 [

[ Ok, ] [ Canicel

3. Fill inthe Frequency field with an integer and select a time unit from the Time Unit list to define the Job
execution frequency.
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4. Click the[...] button next to the Start Time field to open the [Select Date & Time] dialog box, select the
date, hour, minute, and second values, and click OK to set the Job execution start time. Then, set the Job
execution end time in the same way.

# Select Date & Time

. . s m T w T F st . .
s 2 27 2 2 30 31|

i 2 3 4 5 § 7 -

A [T S x|

Frequency |1 15 1 17 1@ 19 20 21

22 023 24 25 % [27] =

Start Time 29 30 1 2 3 4 5

End Time Hr: | 15 = | Min: | 14 | | Sec |36 - |

[Mnrning][ Moon ][Evening][ Mow ]

= == |

5. Click OK to close the dialog box and start scheduled executions of your Job.

The Job automatically runs based on the defined scheduling parameters. To stop the Job, click Kill.

ﬁ Schedule = Run il @' Setting
Path user fhdp/fet ftalend MarvinJab | [onitor

Job is running ...

Job is preparing to run...

Coornidator application id[0000205-120413034704693-00zie -00zi-C] status[PREF]

Job is running...

Coornidator application id[0000205-120418034704698 -00zie -00zi-C] status[RUMNIMG]
Job is running...

Coornidator application id[0000205-120415034704698 -007ie -00zi-C] status[RUMNIMG]
Job is running...

Coornidator application id[0000205-120413034704698 0ozie -0o0zi-C] status[RUMMNIMG]
Job is running...

Coornidator application id[0000205-1204180347046%3-00zie -00zi-C] status[RUNMING]
Job is running...

Coornidator application id[0000205-120418034704698 -00zie -00zi-C] status[RUMNIMG]

How to monitor Job execution status

To monitor Job execution status and results, click the Monitor button on the Oozie scheduler tab. The Oozie end
point URI opensin your Web browser, displaying the execution information of the Jobs on the HDFS server.
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Oozie Web Console

Workflow Jobs || Coordinator Jobs || Bundle Jobs || SystemInfo || Instrumentation

o AllJobs Active Jobs Done Jobs  Custom Filter v

EY

Job ld Mams Status Run | Use
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42 000017212 -00zZi-WW MarvinJob SUCCEEDED 0 hdp
43 | 0000170-12041803 zie-oozi-W ghdf 0 hdp
44 ' 0000189-12041803 -00Zi-W California1 0 hdp
45 -00ZHVY California1 0 hdp
5 -00zi-W California1 0 hdp
a7 zig-pozi-W ghdf o hdp
48 | 0000163-120418034704698- -00Zi-W ghdf 0 hdp
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To display the detailed information of a particular Job, click any field of that Job to open a separate page showing
the details of the Job.

_r Job (Name: MarvinJob/JobId: 0000216-120418034704698-00zie-cozi-W)

]

|

! e

Job Id:
Name:

&pp Path:
Run:

Status:

User:

Group:
Create Time:
Nominal Time:
Start Time:
Last Modified:
End Tirme:

Actions

Action Id

1 0000218-120418034

Job Info || Job Definition Job Configuration Job Log

0000216-120418034704638-00zie
Marvinlob

hdfs://192.168.0.81 user/hdp/etl
a

SUCCEEDED

hdp

LSErs

Thu, 26 Apr 2012 10:17:45 GMT

Thu, 26 Apr 2012 10:17:45 GMT

Thu, 26 Apr 2012 10:18:08 GMT
Thu, 26 Apr 2012 10:18:09 GMT

Mame Type

g-oozie-oozi-WE... Marvinlob java

Statuz Transition StariTime EndTime

oK

£nd Thu, 28 Apr2012 10:17:4...  Thu, 26 Apr2M210:18

3.2.8. How to customize your workspace

When using Talend Open Studio for Big Data to design a data integration Job, you can customize the Palette
layout and setting according to your needs. You can as well change the position of any of the panels that exist
in the Studio to meet your requirements.

All the panels, tabs, and views described in this documentation are specific to Talend Open Studio for Big Data. Some views
a2 listed in the [Show View] dialog box are Eclipse specific and are not subjects of this documentation. For information on
such views, check Eclipse online documentation at http://www.eclipse.org/documentation/.
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3.2.8.1. How to change the Palette layout and settings

The Palette contains all basic technical components necessary to create the most complex Jobs in the design
workspace. These components are grouped in families and sub-families.

For specific component configuration, check Talend Open Sudio for Big Data Components Reference Guide.

Talend Open Studio for Big Data enables you to change the layout and position of your Palette according to your
requirements. the below sections explain all management options you can carry out on the Palette.

How to show, hide the Palette and change its position

By default, the Palette might be hidden on the right hand side of your design workspace.

Show Palette

Palett

If you want the Paletteto show permanently, click theleft arrow, at the upper right corner of the design workspace,
to make it visible at all times.

You can aso move around the Palette outside the design workspace within Talend Open Studio for Big Data’s
main window. To enable the standalone Palette view, click the Window menu > Show View... > General >
Palette.

If you want to set the Palette apart in a panel, right-click the Palette head bar and select Detached from the
contextual menu. The Palette opensin a separate view that you can move around wherever you like within Talend
Open Studio for Big Data’ s main window.

How to display/hide components families

Y ou can display/hide components families according to your needs in case of visibility problems, for example.
To do so, right-click the Palette and select Display folder to display components families and Hide folder to
display components without their families.

= B | 2k palette i3 - = 0
Find component. .. (04

[ Business Inteligence

Add To Favorite
Displayw Folder ! |
Layouk L

Use Large Icons
Settings...

Find Cormponent in Jobs

This display/hide option can be very useful when you are in the Favorite view of the Palette. In thisview, you usually have
a2 alimited number of components that if you display without their families, you will have them in an alphabetical list and
thus facilitate their usage. for more information about the Palette favorite, see section How to set the Palette favorite.
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How to maintain a component family open

If you often use one or many component families, you can add a pin on their names to stop them from collapsing
when you select components from other families.

= Databases =

=

== MaxDE
L= My50L
[= Cracle

To add apin, click the pinicon on the top right-hand corner of the family name.

How to filter the Palette

You can select the components to be shown or hidden on your Palette. You can aso add to the Palette the
components that you devel oped yourself.

For more information about filtering the Palette, see section Palette Settings.

For more information about adding components to the Palette, either from Talend Exchange or from your own
development, see section How to download/upload Talend Community components and/or section External or
User components (Talend > Components).

How to set the Palette favorite

The Palette offers you search and favorite possibilities that by turn facilitate its usage.

Y ou can add/remove components to/from the Palette favorite view of Talend Open Sudio for Big Data in order
to have a quick access to all the components that you mostly use.

To do so:

1. Fromthe Palette, right-click the component you want to add to Palette favorite and select Add To Favorite.
[= File Ea]
== Input
3 tApacheLogInput
=3 tFileInputARFF
s EFileInputDelimited

m tFile INpUEEBCDIC
Hide Folder

Display Folder FFileInputExcel
kFileInpukFullRow
Layouk 3

Use Large Icons EFileInputLDIF

Settings... kFile InputMail

EFileInputiMultiPositional

Find Component in Jobs
——e L File InputMUltiSchema

o

Do the samefor all the components you want to add to the Pal ette favorite then click the Favorite “= button
in the upper right corner of the Palette to display the Palette favorite.
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.2 Palette &3 = B
Find component. .. (] 4
(= File £
[== Input

s tFileInputDelimited

[~ Cubput
s EFileCukputDelimited

[ Misc 45
noke

[~ Processing 40
B=f tMap

Only the components added to the favorite are displayed.
To delete a component from the Palette favorite, right-click the component you want to remove from the
favorite and select Remove From Favorite.

To restore the Palette standard view, click the Standard *# button in the upper right corner of the Palette.

How to change components layout in the Palette

You can change the layout of the component list in the Palette to display them in columns or in lists, as icons
only or asicons with short description.

Y ou can a'so enlarge the component icons for better readability of the component list.

To do so, right-click any component family in the Palette and select the desired option in the contextual menu or
click Settings to open the [Palette Settings] window and fine-tune the layout.

How to add external components to the Palette

Talend Open Sudio for Big Data enables you to add external components to the Palette of your Studio and use
them in your Job designs.

For more information about the creation and development of user components, refer to the component creation
tutorial on our wiki at http://www.talendforge.org/wiki/doku.php?d=component_creation.

For more information about how to download user components in your Studio, see section How to download/
upload Talend Community components.

3.2.8.2. How to change panels positions

All panelsin the open Studio can be moved around according to your needs.
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All you need to do isto click the head border of a panel or to click atab, hold down the mouse button and drag
the panel to the target destination. Release to change the panel position.

Click the minimize/maximize icons (E]/) to minimize the corresponding panel or maximize it. For more
information on how to display or hide a panel/view, see section How to display Job configuration tabs/views.

Click the closeicon (£2) to close atab/view. To reopen aview, click Window > Show View > Talend, then click
the name of the panel you want to add to your current view or see section Shortcuts and aliases .

If the Palette does not show or if you want to set it apart in a panel, go to Window > Show view...> General >

Palette. The Palette opens in a separate view that you can move around wherever you like within Talend Open
Sudio for Big Data’ s main window.

3.2.8.3. How to display Job configuration tabs/views

The configuration tabs are located in the lower half of the design workspace. Each tab opens a view that displays
detailed information about the selected element in the design workspace.
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Designer | Code

5 o Contexts(Job 1| ¥ Component | OB Run {(Job Jobo g" Oozie schedule | Z Modules | [2( Problems =8

+ Job001_bd 0.1

Main Mame
Extra B} A
Authar Version
Stats & Logs
Purpose Status
Description
Creation Modification

The Component, Run Job, Contexts, and Oozie scheduler views gather all information relative to the graphical
elements selected in the design workspace or the actual execution of the open Job.

By default, when you launch Talend Open Studio for Big Data for the first time, the Problems tab will not be displayed
a until the first Job is created. After that, Problems tab will be displayed in the tab system automatically.

The Modules and Scheduler[deprecated] tabs are located in the same tab system as the Component, L ogs and
Run Job tabs. Both views are independent from the active or inactive Jobs open on the design workspace.

Some of the configuration tabs are hidden by default such as the Error Log, Navigator, Job Hierarchy,
Problems, M odules and Scheduler[deprecated] tabs. Y ou can show hidden tabs in this tab system and directly
open the corresponding view if you select Window > Show view and then, in the open dialog box, expand the
corresponding node and select the element you want to display.

For detailed description about these tabs, see section Configuration tabs .

3.3. Using connections

In Talend Open Sudio for Big Data, a Job or a subjob is composed of a group of components logically linked to
one another via connections. This section will describe the types of connections and their related settings.

3.3.1. Connection types

There are various types of connections which define either the data to be processed, the data output, or the Job
logical sequence.

Right-click a component on the design workspace to display a contextual menu that lists all available links for
the selected component.

The sections below describe all available connection types.

3.3.1.1. Row connection

A Row connection handlesthe actual data. The Row connections can bemain, lookup, r g ect or output according
to the nature of the flow processed.

76 Talend Open Studio for Big Data User Guide



Connection types

Main
Thistype of row connection is the most commonly used connection. It passes on data flows from one component

to the other, iterating on each row and reading input data according to the component properties setting (schema).

Data transferred through main rows are characterized by a schema definition which describes the data structure
intheinput file.

Y ou cannot connect two Input components together using a main Row connection. Only one incoming Row connection is

2 possible per component. Y ou will not be able to link twice the same target component using a main Row connection. The
second row linking a component will be called L ookup.

3

. -—a—= .
kFileInputDelinited_1

3

LED | . @ r’D'.:‘\.ll I{Ma.in]l " :

tFileList_1 ' tFileInputDelimited_2 " tFileCurpRESAL 2

To connect two components using a Main connection, right-click the input component and select Row > Main
on the connection list.

Alternatively, you can click the component to highlight it, then right-click it and drag the cursor towards the
destination component. This will automatically create a Row > Main type of connection.

For information on using multiple Row connections, see section Multiple Input/Output.

Lookup

This row link connects a sub-flow component to a main flow component (which should be allowed to receive
more than one incoming flow). This connection is used only in the case of multiple input flows.

i

' tFileInpltLDIF 1

-— -]
<2 Undo Move Node
FowZ (L
1
L@ I% rowl {Main! E
tFilelist 1 tFileInputDelimited 1 EMa
¥ Delete

Select Al

Deactivate rowz

'E-Eet&his conneckion as Main

Settings

Talend Open Studio for Big Data User Guide 77



Connection types

A Lookup row can be changed into amain row at any time (and reversely, amain row can be changed to alookup
row). To do so, right-click the row to be changed, and on the pop-up menu, click Set this connection as Main.

Related topic: section Multiple Input/Output.

Filter

This row link connects specifically atFilter Row component to an output component. This row link gathers the
data matching the filtering criteria. This particular component offers also a Reject link to fetch the non-matching
data flow.

Rejects

Thisrow link connects a processing component to an output component. This row link gathers the data that does
NOT match thefilter or are not valid for the expected output. Thislink allows you to track the data that could not
be processed for any reason (wrong type, undefined null value, etc.). On some components, this link is enabled
when the Die on error option is deactivated. For more information, refer to the relevant component properties
available in Talend Open Sudio for Big Data Components Reference Guide.

ErrorReject

This row link connects atMap component to an output component. This link is enabled when you clear the Die
on error check box in the tMap editor and it gathers data that could not be processed (wrong type, undefined
null value, unparseable dates, etc.).

Related topic: section Handling errors.

Output

Thisrow link connectsatM ap component to one or several output components. Asthe Job output can be multiple,
you get prompted to give a name for each output row created.

The system also remembers deleted output link names (and properties if they were defined). This way, you do not have to
i fill in again property datain case you want to reuse them.

Related topic: section Multiple Input/Output.

Uniques/Duplicates

These row links connect atUnigRow to output components.

The Uniques link gathers the rows that are found first in the incoming flow. This flow of unique datais directed
to the relevant output component or else to another processing subjob.

The Duplicates link gathers the possible duplicates of the first encountered rows. This reject flow is directed to
the relevant output component, for analysis for example.
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Multiple Input/Output

Some components help handle data through multiple inputs and/or multiple outputs. These are often processing-
type components such as thetM ap.

If thisrequiresajoin or sometransformation in oneflow, you want to use the tM ap component, which isdedicated
to thisuse.

For further information regarding data mapping, see chapter Mapping data flows.

For properties regarding the tM ap component as well as use case scenarios, see Talend Open Sudio for Big Data
Components Reference Guide.

3.3.1.2. lIterate connection

The Iterate connection can be used to loop on files contained in a directory, on rows contained in afile or on
DB entries.

A component can be the target of only one Iterate link. The Iterate link is mainly to be connected to the start
component of aflow (in asubjob).

Some components such asthetFilel ist component are meant to be connected through an iterate link with the next
component. For how to set an | ter ate connection, see section |terate connection settings.

The name of the Iteratelink isread-only unlike other types of connections.

3.3.1.3. Trigger connections

Trigger connections define the processing sequence, i.e. no data is handled through these connections.

The connection in use will create a dependency between Jobs or subjobs which therefore will be triggered one
after the other according to the trigger nature.

Fow L
on Subjob Error

<) Unda Delete items
Run if

2n Component Ok,
=| Zopy On Camponent Errar

Trigger connections fall into two categories:
 subjob triggers: On Subjob Ok, On Subjob Error and Run if,

» component triggers: On Component Ok, On Component Error and Run if.
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. N = RS |

ileList_1 tFileInputDelimited_1 ' ' " tMysgicitput_1
'OnCDrhp entError ' ' ' .OI'ICDH.'ID entError
onSufobErrar  Cnsubiobok
' ' ' ' ' ' ' ' ' tr\"isgBu:ux'_z ' ' ' ' ' tr'ﬂ'isgBu:ux'_l
@ rowz (fain) . u.;‘
tsendMail_1 ' " tMysglInput_1 ' ' ' ' " tLogRow 1

OnSubjobOK (previously Then Run): Thislink is used to trigger the next subjob on the condition that the main
subjob completed without error. This connection is to be used only from the start component of the Job.

These connections are used to orchestrate the subjobs forming the Job or to easily troubleshoot and handle
unexpected errors.

OnSubjobError: This link is used to trigger the next subjob in case the first (main) subjob do not complete
correctly. This“on error” subjob helps flagging the bottleneck or handle the error if possible.

Related topic: section How to define the Sart component.

OnComponentOK and OnComponentError are component triggers. They can be used with any source
component on the subjob.

OnComponentOK will only trigger the target component once the execution of the source component iscomplete
without error. Its main use could beto trigger a notification subjob for example.

OnComponentError will trigger the sub-job or component as soon as an error is encountered in the primary Job.

Run if triggers a subjob or component in case the condition defined is met. For how to set a trigger condition,
see section Run if connection settings.

3.3.1.4. Link connection

The Link connection can only be used with ELT components. These links transfer table schema information to
the ELT mapper component in order to be used in specific DB query statements.

Related topics: ELT componentsin Talend Open Sudio for Big Data Components Reference Guide.

TheLink connection therefore does not handl e actual data but only the metadata regarding the table to be operated
on.

When right-clicking the ELT component to be connected, select Link > New Output.

Be aware that the name you provide to the link MUST reflects the actual table name.

In fact, the link name will be used in the SQL statement generated through the ETL Mapper, therefore the same
name should never be used twice.
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3.3.2. How to define connection settings

Y ou can display the properties of a connection by selecting it and clicking the Component view tab, or by right-
clicking the connection and selecting Settings from the contextual menu. This section summarizes connection
property settings.

3.3.2.1. Row connection settings

The Basic settings vertical tab of the Component view of the connection displays the schema of the data flow
handled by the connection. Y ou can change the schema by clicking the Edit schema button. Once you change the
schema of the data flow, the schematype of the two components across the connection will become Built-In. For
more information, see section How to set a schema.

= rowl

Basic settings Edit schema E]

e ereetings Schema from tFilelnputDelimited_1 oukpuk

Colurnn Key  T... »| M., Date..| L... P.. D. ©C..
G id In... z 0
Cuskame, .. St 255 0
Cuskame, .. St 255 0
idskate In... 2 0
idz In... z2 o
RegTime =l S0 o

Reqister. .. at... B0 0 b

The Advanced settings vertical tab lets you monitor the data flow over the connection in a Job without using a
separate tFlowM eter component. The measured information will be interpreted and displayed in a supervising
tool such as Talend Activity Monitoring Console. For information about Talend Activity Monitoring Console, see
Talend Activity Monitoring Console User Guide.

o rowl

IJse input connection name as label
Basic settings D a

Advanced settings Labed My Label
Mode dbsolube a4 ¥
Thresholds Label — — —_
£ »

Manitar khis conneckion

To monitor the data over the connection, perform the following settings in the Advanced settings vertical tab:

1. Select the Monitor thisconnection check box.
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Select Useinput connection name aslabel to use the name of the input flow to label your datato be logged,
or enter alabel in the Label field.

From the M odelist, select Absoluteto log the actual number of rows passes over the connection, or Relative
to log the ratio (%) of the number of rows passed over this connection against a reference connection. If you
select Relative, you need to select a reference connection from the Connections List list.

Click the plus button to add a line in the Thresholds table and define a range of the number of rows to be
logged.

For moreinformation about flow metrics, see the documentation of thetFlowM eter Catcher component in Talend
Open Sudio for Big Data Components Reference Guide and see Talend Activity Monitoring Console User Guide.

3.3.2.2. Iterate connection settings

You can set an Iterate link to run parallel iterations:

1.

Simply select the Iterate link of your subjob to display the related Basic settings view of the Components
tab.

Select the Enable par allel execution check box and set the number of executionsto be carried out in parallel.
o iteratel

v i -

Basic settings Enable parallel execution  mumber of parallel execution | 4

Advanced settings

When executing your Job, the number of parallel iterations will be distributed onto the available processors.

——EEec - EEEL T s, 3ET R rowssecond
exec 2 1 71946 rows, 34740 rows/second

4 Execs running ) ExeC 3 72811 rows, 36406 ru:u_ws,l'seu:_u:und ) )
I_l‘ 0 exec finished * Fp  Exec 45 71999 raws, 36.EIEIIZI roms ) secand =@
| M- | = ol (Maim)
tLoop_1 ' ' ' "tRowGenerator 1 ' ' ' ' EFileCutputelimited_1

Select the Statistics check box of the Run view to show the real time parallel executions on the design
workspace.

3.3.2.3. Trigger connection settings

Run if connection settings

In the Basic settings view of aRun if connection, you can set the condition to the Subjob in Java. Pressing Ctrl|
+Space allows you to access all global and context variables.
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o Ifl
" -
Basic settings Condition i (Integer) globalMap.get ("tFileInput
Advanced settings Delimited 1 NE LINE"))
w

3.4. Using the Metadata Manager

Talend Open Sudio for Big Data is a metadata-driven solution, and can therefore help you ensure the whole Job
consistency and quality through a centralized M etadata Manager.

In the integration process, the Metadata Manager consolidates all project information in a repository.

3.4.1. How to centralize contexts and variables

Depending on the circumstances the Job is being used in, you might want to manage it differently for various
execution types (Prod and Test in the example given below). For instance, there might be various testing stages
you want to perform and validate before a Job is ready to go live for production use.

Talend Open Studio for Big Data offers you the possihility to create multiple context data sets. Furthermore you
can either create context data sets on a one-shot basis, from the context tab of a Job or you can centralize the
context data setsin the Contexts node of the Repository tree view in order to reuse them in different Jobs.

A context is characterized by parameters. These parameters are mostly context-sensitive variables which will be
added to the list of variables for reuse in the component-specific properties on the Component view through the
Ctrl+Space bar keystrokes.

3.4.1.1. How to use variables in a Job

Variables represent values which change throughout the execution of a program. A global variable is a system
variable which can be accessed by any module or function. It retainsits value after the function or program using
it has completed execution. A context variable is a variable which is defined by the user for a particular context.

You can use an existing global variable or context variable in any component properties field. Press Ctrl+Space
bar to display the full list of global and context variables used in various predefined Java functions.

Descripkion: Error Message tFileInputDelimited_2 ERROR_MESSAGE
EFileInputDelimited_2, ME_LINE

Global variable, property af companent EMap [fMap_1]. tMap 1.ERROR MESSAGE
Ugreleh S tFileCutputDelimited_1 ERROR_MESSAGE
Availabilicy: After tFileCutputDelimited_1,ME_LTME

Variable Mame: ((StringiglobalMap.get("tMap_1_ERROR_MESSAGE™) EE::EgEEﬁEEg:::E:E:S—E'EEREEEMEESAGE
tFileInputDelimited_3.ERROR._MESSAGE
kFileInputDelimited_3,ME_LINE
tFlowmMeter 1 ERROR_MESSAGE
tFlowieter 2 ERROR_MESSAGE
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Thelist grows along with new user-defined variables (context variables).
Related topics:
* section How to define variables from the Component view

» section How to use variables in the Contexts view

3.4.1.2. How to use variables in the Contexts view

Various ways are at your disposal to create and define variables. You can manage your variables through the
Contexts view or directly on the Component view.

For moreinformation regarding the variable definition directly on the Component view, see section How to define
variables from the Component view.

The Contexts view is positioned on the lower part of the design workspace and is made of three tabs: Variables,
Valuesastreeand Values astable.

If you cannot find the Contexts view on the tab system of Talend Open Sudio for Big Data, go to Window > Show view
2 > Talend, and select Contexts.

Variables tab

The Variables tab is part of the Contexts tab and shows al of the variables that have been defined for each
component in the current Job.

Yariables | Yalues as tree | Values as table

Marme Source Tvpe Script code
TST_DEMAME built-in String conkexk, TST_DEMNAME
TST_IJSER. built-in Skring context, TST_IJSER,
TST_PA&SS built-in Skring conkexk TST_PASS

= context4Prod context4Prod - -

conkext4Prod context, File
niew 1 context4Prod  String conkexk, newl
Mewvariable built-in Skring conkexk, Mewwvariable

L4
D [ Joriginal order

From this panel, you can manage your built-in variables:

» Add aparameter lineto the table by clicking on [+]

Edit the Name of the new variable and type in the <Newvariable> name.

Delete built-in variables. (Reminder: repository variables are read-only.)

Import variables from arepository context source, using the Repository variables button.
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 Display the context variablesin their original order. They are sorted automatically by the studio upon creation
in the tab view or when imported from the Repository. To do this, select the Original order check box.

Reorganize the context variables by selecting the variable of interest and then using the and buttons.

To do so, you need select the Original order check box to activate the two arrow buttons.

To define the actual value of anewly created variable, click the Value astree tab.

Y ou can add as many entries as you need on the Variables tab. By default the variable created is of built-in type.

Fields Description

Name Name of the variable. Y ou can edit this field, on the condition that the variable is of Built-in
type. Repository variables are read-only.

Source Built-in: The variableis created in this Job and will be used in this Job only.
<Repository entry name>: The variable has been defined in acontext stored inthe repository.
The source is thus the actual context group you created in the repository.

Type Select the type of data being handled. Thisis required in Java.

Script code Code corresponding to the variable vaue. Displayed code will be:
cont ext . Your Par anet er Nane. This Script code is automatically generated when you
define the variable in the Component view.

Comment Add any useful comment.

Y ou cannot create contexts from the Variables view, but only from the Values astable or astree views.

For further information regarding variable definition on the component view, see section How to define variables
from the Component view.

For more information about the repository variables, see section How to store contexts in the repository.

Values as tree tab

This tab shows the variables as well astheir valuesin atree view.

Variables |Yalues as tree | Walues as table

Yariable Conkext Prampk Yalue

+.

s
s
s
s

TST_DEMAME
TST_LISER.
TST_PASS
File

rew 1

new\ar
DieFault | newsz? My Compary-Dbms|

Prod | newz? null

From this view, you can:
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» Definethevaue of abuilt-in variable directly in the Valuefield. Note that repository variables values are read-
only and can only be edited in the relevant repository context.

 Define aquestion to prompt the user for variable value confirmation at execution time.
 Create or Edit a context name through the top right dedicated button.

» Rearrange the variable/context groupby display.

Fields Description

Variable Name of the variables.

Context Name of the contexts.

Prompt Select this check box, if you want the variable to be editable in the confirmation dialog box at

execution time.

If you asked for aprompt to popup, fill inthisfield to define the message to show on the dialog box.

Value Vaue for the corresponding variable. Define the value of your built-in variables. Note that
repository variables are read-only.

You can manage your contexts from this tab, through the dedicated button *# placed on the top right hand
side of the Contexts view. See section How to configure contexts for further information regarding the context
management.

Onthe Values astree tab, you can display the values based on the contexts or on the variables for more clarity.

To change the way the values are displayed on the tree, click the small down arrow button, then click the group
by option you want.

For more information regarding variabl e definition, see section How to define variables from the Component view
and section How to store contexts in the repository.

Values as table tab

This Values astable tab shows the context and variable settings in the form of atable.

Fields Description
Name Name of the variable.
<Y our ContextName> Corresponding value for the variable.

Y ou can manage your contexts from this tab, through the Configur e contexts button placed on the top right hand
side of the Contexts panel. See section How to configure contexts for further information regarding the context
management.

For more information regarding variabl e definition, see section How to define variables from the Component view
and section How to store contexts in the repository.

3.4.1.3. How to configure contexts

You can only manage your contexts from the Values as table or Values as tree tabs. A dedicated button &
shows up on the top right hand side of the Contexts view.

Click the Configure Contexts... icon to open the management dialog box.
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% Configure Contexts @

Default is default context, it can nok be removed,
Peloefaul|
T Prod
Select Al
Deselect All
Mew.. || Ed |
@ [ Ok, l [ Cancel

The default context cannot be removed, therefore the Remove button is unavailable. To make it editable, select another
2 context on the list.

Creating a context

Based on the default context you set, you can create as many contexts as you need.
To create anew context:

1. Click New inthe [Configure Contexts] dialog box.

2. Typeinaname for the new context.

% New Context

x)

Give a name far the new conkexk

| Prod| |

Ok H Cancel ]

3. Click OK to validate the creation.

When you create a new context, the entire default context legacy is copied over to the new context. Y ou hence
only need to edit the relevant fields on the Value as tree tab to customize the context according to your use.

The drop-down list Default Context shows all the contexts you created.

You can switch default context by simply selecting the new default context on the Default Context list on the
Variablestab of the Contexts view.

Note that the Default (or last) context can never be removed. There should always be a context to run the Job, be
this context called Default or any other name.

Renaming or editing a context

To change the name of an existing context:
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1. Click Edit onthe[Configure contexts] dialog box and enter the new context namein the dialog box showing
up.

2. Click OK to validate the change.

To carry out changes on the actual values of the context variables, go to the Values as tree or Values as table
tabs. For more information about these tabs, see section How to use variables in the Contexts view.

3.4.1.4. How to define variables from the Component view

Various ways are at your disposal to create and define context variables. Y ou can mostly manage your variables
from the Contexts view, but you can also create them directly on the Component view.

For moreinformation related to the variable definition through the Contextsview, see section How to usevariables
in the Contexts view.

For more information regarding the variable definition in the repository, see section How to store contexts in the
repository.

Context variables creation

The quickest way to create context variables on the spot is to use the F5 key:
1. Ontherelevant Component view, place your cursor on the field that you want to parameterize.

2. PressF5to display the context parameter dialog box:

% Mew Context Parameter, §|

Context parameter |

Creake a new conkext parameter, D

Mame kalendDE

Cornrmenk

Type STRIMG =z

Prormpt Is 'talend-dbrns' a walid database host connection For this session?
Prompt for value:

Default value | talend-dbms'

(2 Einish l [ Cancel

3. GiveaNameto this new variable, fill in the Comment area and choose the Type.

4. Enter a Prompt to be displayed to confirm the use of this variable in the current Job execution (generally
used for test purpose only). And select the Prompt for value check box to display the field as editable value.
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5. If you filled in a value already in the corresponding properties field, this value is displayed in the Default
valuefield. Else, typein the default value you want to use for one context.

6. Click Finish to vaidate.
7. Goto the Contexts view tab. Notice that the context variables tab lists the newly created variables.

The newly created variables are listed in the Contexts view.

The variable name should follow sometyping rules and should not contain any forbidden characters, such as space character.
2

The variable created this way is automatically stored in all existing contexts, but you can subsequently change
the value independently in each context.

For more information on how to create or edit a context, see section How to configure contexts.

StoreSQLQuery

StoreSQL Query is a user-defined variable and is mainly dedicated to debugging.

StoreSQL Query isdifferent from other context variablesin thefact that itsmain purposeisto be used as parameter
of the specific global variable called Query. It alows you to dynamically feed the global query variable.

The global variable Query, isavailable on the proposals list (Ctrl+Space bar) for some DB input components.

For further details on StoreSQL Query settings, see Talend Open Sudio for Big Data Components Reference
Guide, and in particular the scenarios of the tDBInput component.

3.4.1.5. How to store contexts in the repository

You can store centrally all contexts if you need to reuse them across various Jobs.

How to create a context group
To create a context group, proceed as follows:

Create the context group and add required infor mation

1. Right-click the Contexts node in the Repository tree view and select Create new context group from the
contextual menu.

{21 *Repositary 52 - wn @ Y T 0O

LOCAL: rE2575
+-riqy Job Designs

s Code Create conkext group
#- L[ 5oL Tem 9 Create Folder
(5} Recycle | (3 Import ikems
[yl Export items

A 2-step wizard appears to help you define the various contexts and context parameters, which you will be
able to select in the Contexts view of the design workspace.
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2. In Step 1 of 2, type in aname for the context group to be created, and add any general information such as
adescription if required.

3. Click Next to go to Step 2 of 2, which allows you to define the various contexts and variables that you need.

YWariables '-.-'alueJ%s kree | Malues as table

Marme Tvpe Script code Comment
Servername Skring conbexk, Servernarne

coritext. Dbrame I

< *

Definethe default context’s variable set to be used as basisfor other contexts

1. OntheVariablestab, click the[+] button to add as many new variable lines as needed and define the name
of the variables.

In this example, we define the variables that can be used in the Name field of the Component view.
2. Select the type of the variable from the Type list.

The Script code varies according to the type of variable you selected, and will be used in the generated code.
The screen shot above shows the Java code produced.

3. OntheTreeor Table views, define the various contexts and the values of the variables.

Yariables | Yalues as tree |Values as table

&
Mame Defaulk Prod
Servernamne Testserver ProdSerwver
Dbname TestDE ProdDE

First, define the values for the default (first) context variables, then create a new context that will be based
on the variables values that you just set.

For more information about how to create a new context, see section How to configure contexts.

4. OntheValuesastreetab, add aprompt if you want the variable to be editable in a confirmation dialog box
at execution time,

Vatiables | Yalues as tree | Values as table

o
=
Conkext YWariahble Prampk Yalue ™
= Default
SErvEernams | Confirm Server name?  Teskserver
Dhnarne | newl? TestDE
= Prod v
< >
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To add a prompt message, select the facing check box, then type in the message you want to display at
execution time.

Once you created and adapted as many context sets as you want, click Finish to validate. The group of contexts
thus displays under the Contexts node in the Repository tree view.

3.4.1.6. How to apply context variables to a Job from the
repository

Once a context group is created and stored in the Repository, there are two ways of applying it to a Job:
1. Drop acontext group. Thisway, the group is applied as awhole.

2.
Use the context icon button G Thisway, the variables of a context group can be applied separately.

How to drop a context group onto a Job

To drop a context group onto a Job, proceed as follows:
1. Double-click the Job to which a context group is to be added.

2. Once the Job is opened, drop the context group of your choice either onto the Job workspace or onto the
Contexts view beneath the workspace.
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{5} *Reposit 53 = O || {4 *JobDEMO 0.1 52 = F
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M... Source Tvpe Scripk code
= Conkexkc Conkext.., - -
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a Conkexk...  String conkexk.a
= b Conkexk,..  Skring context. b
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How to use the context icon button

To use the context icon button to apply context variables to a Job, proceed as follows:
1. Double-click the Job to which a context variableis to be added.
2. Oncethe Job is opened in the workspace, click the Contexts view beneath the workspace to open it.

3. At the bottom of the Contexts view, click the button to open the wizard to select the context variables to
be applied.
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&4 Select Context Variables

= jall Corbest: best

Yar: newl
Yar: news
Yar: news
Yar: newv
War: news

Select variables from repository contexks,

) Context: Contexbgroup

- B

View, .,
Select Al

Deselect Al

Expand All

Collapse Al

Ik

[ Cancel

4. Inthewizard, select the context variables you need to apply or clear those you do not need to.

The context variables that have been applied are automatically selected and cannot be cleared.

-z

5. Click OK to apply the selected context variables to the Job.

3.4.1.7. How to run a Job in a selected context

Y ou can select the context you want the Job design to be executed in.

Context . Target execukion

Test
Marme Walue
hosk ‘talend-dbms-test'
pork ‘aos0’
db "Talend-test'

Click the Run Job tab, and in the Context area, select the relevant context among the various ones you created.

If you did not create any context, only the Default context shows on the list.

All the context variables you created for the selected context display, along with their respective value, in atable
underneath. If you clear the Prompt check box next to some variables, you will get a dialog box allowing you to

change the variable value for this Job execution only.

To make a change permanent in a variable value, you need to change it on the Context view if your variable is

of type built-in or in the Context group of the repository.

Related topics:

* section How to use variables in the Contexts view
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* section How to store contexts in the repository

3.4.2. How to use the SQL Templates

Talend Open Studio for Big Data allows you to benefit from using some system SQL templates since many query
structures are standardized with common approaches.

Talend Open Sudio for Big Data lists system SQL templates under the SQL Templates node in the Repository
tree view. There, you can find several standardized SQL templates for Hive.

ﬁj Repository oo = B8
LOCAL: Projectiame = béh J =

=1y Job Designs
iy Job001_bd 0.1
= Contexts
globalcontext 0.1
+ Code
T
== Hive
=0 system
_r HiveAggregate 0.1
_r HiveCreateSourceTable 0.1
_r HiveCreateTargetTable 0.1
_r HiveDropSourceTable 0.1
_r HiveDropTargetTable 0.1
_r HiveFilterColumns 0.1
| [ HiveFilterRow 0.1
[ UserDefined

In each of the above categories, you can create your own user-defined SQL templates using the SQL templates
wizard and thus centralize them in the repository for reuse.

For more information about the use of SQL templatesin Talend Open Studio for Big Data, see chapter Designing
a data integration Job.

For more information about how to create auser-defined SQL template and useit in a Job context, seethe scenario
of thetMysglTableList component in Talend Open Sudio for Big Data Components Reference Guide.

3.5. Handling Jobs: advanced subjects

The sections below give detail information about various advanced configuration situations of a data integration
Job including handling multipleinput and output flows, using SQL queries, using external componentsin the Job,
scheduling atask to run your Job.

3.5.1. How to map data flows

The most common way to handle multiple input and output flows in your Job including transformations and data
re-routing isto use the tMap component.
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For more information about the principles of using this component, see chapter Designing a data integration Job.

For examples of Jobs using this component, seetM ap in Talend Open Sudio for Big Data Components Reference
Guide.

3.5.2. How to create queries using the SQLBuilder

SQLBuilder helps you build your SQL queries and monitor the changes between DB tables and metadata tables.
Thiseditor isavailable in all DBInput and DBSQL Row components (specific or generic).

Fill in the DB connection details and select the appropriate repository entry if you defined it.

Remove the default query statement in the Query field of the Basic settings view of the Component panel. Then
click the[...] button to open the [SQL Builder] editor.

# SOL Builder M=
Database Struckure o @h kalendiClientDE), sql
Databases Repository DifF ,i'_’ = g |H j
= W talend ClientD
= E client client

B ID_CLIENT  ID_CLIENT

B CLIEMNT_MAME CLIEMT_MAME

B CLIEMT_BIRTHICLIEMT _BIR.THDAY

£ CLIENT_ACCOLCLIEMT ACCOUMT
EH dlient_conkract client-contrack

¢ [ S0L - Limit Rows | 100
Execute a query to see the results || Columns . Preview | Row Count Primary Kevs | Exported Keys sy
COLUMM_MAME  DATA_TYPE  TYPE_MAME  COLUMMN_SIZE | DECIME
ID_CLIENT 4 int 11 1]
CLIEMT _MAME 12 warchar 150 1]
CLIENT_BIRTH... 91 date 10 1]
CLIEMT _ACCO,,, § double 5 2
< | >

Columns For “talend” " client”

(04 ] [ Cancel

The[SQL Builder] editor is made of the following panels:
 Database structure,

* Query editor made of editor and designer tabs,

» Query execution view,

» Schemaview.
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The Database structure shows the tables for which a schemawas defined in your connection.

The schemaview, in the bottom right corner of the editor, shows the column description.

3.5.2.1. How to compare database structures

On the Database Structur e panel, you can see all the tables of the database.

The connection to the database might take quite some time.
-z

Click the refresh icon to display the differences between the DB metadata tables and the actual DB tables.

Database Struckure LS
Databases Repository Diff L
= B talend ClientDE &

= E client client *‘3{}@

B CLIENT_ACCOUNT CLIENT_ACCOUNT
B CLIENT_BIRTHDAY CLIENT_BIRTHDAY
B ID_cCLIEMT ID_CLIENT

'

= E dient_contract client-conkract ®
B COMTRACT_TYPE COMTRACT _TYPE
B COMTRACT _VALUE CONTRAZT WALUE
§ ID_CLIEMT ID_CLIENT
g ID_COMTRACT ID_COMTRACT

= [ axeltablel axeltablel
B ID_MONTH ID_MOMTH
B ID_TYPE ID_TYPE
B MOMNTH MONTH

I _IJSER
(7] sales L

The Diff iconspoint out that the table contains differences or gaps. Expand the table node to show the exact column
containing the differences.

The red highlight shows that the content of the column contains differences or that the column is missing from
the actual database table.

3.5.2.2. How to build a query

The [SQL Builder] editor is a multiple-tab editor that allows you to write or graphically design as many queries
as you want.

To create anew query, complete the following:
1. Right-click the table or on the table column and select Gener ate Select Statement on the pop-up list.

2. Click the empty tab showing by default and type in your SQL query or press Ctrl+Space to access the
autocompletion list. Thetooltip bubble showsthe whol e path to the table or table section you want to searchin.
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talend(Talend-DEMS), sql

X = B 4 B
zelect cars.Reg Car,owners. Nane Customer . owners. ID Ins
from cars.owners.resellers

"talend","resellers"."ID_Reseller" H ID_Cwner i

B Mame_Customer
E resellers

H address_Reseller
B city

B Name_%eseller

f ZipCode

ﬂ absolute

& add

&4l =

A

=58

£ »
SGL - Limit Rows | 100
Edit | Designer

Alternatively, the graphical query Designer allows you to handle tables easily and have real-time generation
of the corresponding query in the Edit tab.

Click the Designer tab to switch from the manual Edit mode to the graphical mode.

You may get a message while switching from one view to the other as some SQL statements cannot be interpreted
" graphically.

If you selected atable, all columns are selected by default. Clear the check box facing the relevant columns
to exclude them from the selection.

Add moretablesin asimple right-click. On the Designer view, right-click and select Add tablesin the pop-
up list then select the relevant table to be added.

If joins between these tables already exist, these joins are automatically set up graphically in the editor.

You can also create a join between tables very easily. Right-click the first table columns to be linked and
select Equal on the pop-up list, to join it with the relevant field of the second table.
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kalendiTalend-DEMS),sql [ talend(Talend-DEMS) . =gl &2
F (= E G 4 Ei |Talend-DBMS W

owners | cars [ resellers

* * x
w'i 10 _Owmer [w 10_0Owners v 10_Reseller
[W Mame_Customer [ Reg_car ¥ Hame_Reseller
|7 10_In=urance |7 Make P fddress_Reseller
[w Color W Ziptode
[w I0_Reseller W City

seleck owners, ID_Cwner, owners, Name_Cuskomer, owners, ID_Insurance,cars,ID_Owners.
From owners,cars, reselers
where owners, ID_Owner=cars,ID_COwners and cars, ID_Reseller=reselers. ID_Reseller

< >
Edit | Designer

The SQL statement corresponding to your graphical handlings is also displayed on the viewer part of the
editor or click the Edit tab to switch back to the manual Edit mode.

In the Designer view, you cannot include graphically filter criteria. Y ou need to add these in the Edit view.

Once your query is complete, executeit by clicking the * jcon on the toolbar.

The toolbar of the query editor allows you to access quickly usual commands such as; execute, open, save
and clear.

The results of the active query are displayed on the Results view in the lower |eft corner.

3.5.3. How to download/upload Talend Community
components

Talend Open Sudio for Big Data enables you to access alist of all community componentsin Talend Exchange
that are compatible with your current version of Talend Open Studio for Big Data. Y ou can then download and
install these components to use them later in the Job designs you carry out in the Studio. From Talend Open

Sudio for Big Data, you can also upload components you have created to Talend Exchange to share with other
community users.

A click on the Exchange link on the toolbar of Talend Open Sudio for Big Data opens the Exchange tab view
on the design workspace, where you can find lists of:

» components available in Talend Exchange for you to download and install,

» components you downloaded and installed in previous versions of Talend Open Sudio for Big Data but not
installed yet in your current Studio, and

» components you have created and uploaded to Talend Exchange to share with other Talend Community users.
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» Before you can download community components or upload your own components to the community, you need to sign
in to Talend Exchange from your Studio first. If you did not sign in to Talend Exchange when launching the Studio,
you till have achanceto sign in from the Talend Exchange preferences settings page. For more information, see section
Exchange preferences (Talend > Exchange).

« The community components available for download are not validated by Talend. This explains why you may encounter
component loading errors sometimes when trying to install certain community components, why an installed community
component may have adifferent namein the Palette than in the Exchange tab view, and why you may not be able to find
acomponent in the Palette after it is seemingly installed successfully.

3.5.3.1. How to install community components from Talend
Exchange

Toinstall community components from Talend Exchange to the Palette of your current Talend Open Sudio for
Big Data:

1

2.

3.

Click the Exchange link on the toolbar of Talend Open Sudio for Big Data to open the Exchange tab view
on the design workspace.

l\_3(‘.2.
Downloaded Extensions
My Extensions Extension Name Version Rating Author View
Facebook Application Insights o
0.1 saburo view /download
Component
tFileOutputDelimitedEx 1.0 Alezis wiew /download
tScriptRules 1.0 walkerca | wiew/download
tWorldBank components Demao 0.2 saburo view/download
pUpdateMailOffer Vo2 PayZen view/download
pCreateMailOffer Vo2 PayZen view/download
tDBFOUtput 1.1 A A4 BiSi view/download
tDBFInput 1.1 BiSi view/download
pCreatePayment V0BG A AA PayZen view/download

In the Available Extensions view, if needed, enter a full component name or part of it in the text field and
click the fresh button to find quickly the component you are interested in.

Click the view/download link for the component of interest to display the component download page.
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tPDFToText

Version 1.1
2011-05-17

Convert a PDF to text file. It's possible to extract a

delimited area.

User Reviews

-L" -l." -L"' - - oy
bien it's good
e e e o .
It works on 4.2.2 You can use it, it works o
n4.2.21

tPOFToText This does not seem compatible
with TOS 4.2.2r63143. I have installed it on TOS and it does n

ot generate an output file.

4. View the information about the component, including component description and review comments from
community users, or write your own review comments and/or rate the component if you want. For more
information on reviewing and rating a community component, see section How to review and rate a

community component.

write a review

If needed, click the left arrow button to return to the component list page.

5. Clickthelnstall buttonintheright part of the component download pageto start the download and install ation

process.

A progress indicator appears to show the completion percentage of the download and installation process.
Upon successful installation of the component, the Downloaded Extensions view opens and displays the

status of the component, which is I nstalled.
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Available Extensions Extension Name Downloaded Version

My Extensions tDBFInput 11
tDEFOuUtput 1.1
bcLogbackConfig 1.2
bcLogbackCatch 1.3
tLogd]d 1.4
tFileQutputDelimitedEx 1.0
null null
tScriptRules 1.0
BRules 1.1
tPODFTOText 1.1

Download Date

2011-

2011-

2011-

2011-

2011-

2011-

2011-

2011-

2011-

2011-

11-17

10-31

10-31

10-31

11-17

11-17

11-17

11-17

11-17

11-18

Install/Update

Install

,_.
=]
]
i
1]

,_.
=
&
i
L

,_.
=)
]
[,
o

,_.
=)
5]
ot
o

,_.
=
i)
[,
i)

._.
i
[
kL3
)

._.
=
[
B,
)

Installed

3.5.3.2. How to reinstall or update community components

Fromthe Exchangetab view, you can reinstall componentsyou already downloaded and installed in your previous
version of Talend Open Sudio for Big Data or install the updated version of Talend Open Sudio for Big Data

or componentsin your current Studio.

By default, while you are connected to Talend Exchange, a dialog box appears to notify you whenever an update to an
a2 installed community component is available. If you often check for community component updates and you do not want
that dialog box to appear again, you can turn it off in Talend Exchange preferences settings. For more information, see

section Exchange preferences (Talend > Exchange).

To reinstall acommunity component you already downloaded or update an installed one, complete the following:

1. From the Exchange tab view, click Downloaded Extensions to display the list of components you have

already downloaded from Talend Exchange.

In the Downloaded Extensions view, the components you have installed in your previous version of Talend
Open Sudio for Big Data but not in your current Studio have an Install link in the I nstall/Update column,
and those with updates available in Talend Exchange have an Update link.

2. Click theInstall or Update link for the component of interest to start the installation process.

A progress indicator appears to show the completion percentage of the installation process. Upon successful
installation, the Downloaded Extensions view displays the status of the component, which is Installed.

3.5.3.3. How to review and rate a community component

To review and rate a community component:

1. Fromthe Available Extensions view, click the view/download link for the component you want to review

or rate to open the community component download page.

2. Onthe component download page, click thewriteareview link to open the[Review the component] dialog

box.
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Review the component
@ Flease give a review for the component,
Title: ™
|Llseﬁ_|l.
%) (%% %] ]
Good: 4 stars out of 5
Review:®
Good thing to have,
o
@J Submit RE'-,'iE'A'] [ Cancel

Fill in the required information, including atitle and areview comment, click one of thefive starsto rate the
component, and click Submit Review to submit you review to the Talend Exchange server.

Upon validation by the Talend Exchange moderator, your review is published on Talend Exchange and
displayed in the User Review area of the component download page.

3.5.3.4. How to upload a component you created to Talend
Exchange

Y ou can create your own components for use in your Jobsin Talend Open Sudio for Big Data and upload them
to Talend Exchange to share with other Talend Community users. For information on how to create your own
components and deploy them in Talend Open Sudio for Big Data, see section External or User components
(Talend > Components).

To upload a component you created to Talend Exchange, compl ete the following:

1. Fromthe Exchangetab view, click My Extensions to open the My Extensions view.
Available Extensions Add New Extension
Downloaded Extensions
Extension Name Version Upload Date Operation
2. Click the Add New Extension link in the upper right part of the view to open the component upload page.
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&

Extension Title:

Compatibility:

Description:

File:

tExEvaluate Initial 10

Version:
All versions

Version and older:

IR IR

Versions and newer:|5.0

All versions except:

IR

Only these versions:

tExEvaluate evaluates the execution of a Job.

D-\WWork\ComponentsitExEvaluate zip | & Upload Extension

3. Complete the required information, including the component title, initial version, Studio compatibility
information, and component description, fill in or browse to the path to the source package in the File field,
and click the Upload Extension button.

Upon successful upload, the component islisted in the My Extensions view, where you can update, modify
and delete any component you have uploaded to Talend Exchange.

Available Extensions

Downloaded Extensions

Add New Extension
Extension Name Version Upload Date Operation

tExEvaluate 1.0 2011-11-18 ¥ 7 R

3.5.3.5. How to manage components you uploaded to Talend

Exchange

From the Exchange tab view, you can manage components you have uploaded to Talend Exchange,
including updating component version, modifying component information, and deleting componentsfrom Talend

Exchange.

To update the version of a component, compl ete the following:

1

From the My Extensions view, click the T iconinthe Operation column for the component your want to

update to open the component update page.
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<5

Initial a0
Version:
Compatibility: All versions
Version and older:

>

~

" | Versions and newer:
" | All versions except:
~

Only these versions:

File: Upload Extension

2. Fill in the initial version and Studio compatibility information, fill in or browse to the path to the source
package in the File field, and click the Update Extension button.

Upon successful upload of the updated component, the component isreplaced with thenew versionon Talend
Exchange and the My Extension view displays the component's new version and update date.

To modify the information of a component uploaded to Talend Exchange, complete the following:

L From the My Extensionsview, click the # iconinthe Operation column for the component your want to

modify information for to open the component information editing page.
(4=
Extension Title:  {ExBvaluate

Compatibility: Al versions

Version and older:

~
~
| versions and newer:|5.1
" | All versions except:

~

Only these versions:

Description: tExEvaluate evaluates the excecution of a Job.
It requires tExCather to work with it.

Modify Extension

2. Complete the Studio compatibility information and component description, and click the M odify Extension
button to update the component information to Talend Exchange.
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To delete a component you have uploaded to Talend Exchange, click ¥ icon for the component from the My
Extensions view. The component is then removed from Talend Exchange and is no longer displayed on the
component list in the My Extensions view.

3.5.4. How to install external modules

Talend Open Sudio for Big Data requires specific third-party Java libraries or database drivers to be installed to
connect to sources and targets. Those libraries or drivers, known as external modules, can be required by some of
Talend components. Due to license restrictions, Talend may not be able to ship certain external modules within
Talend Open Sudio for Big Data.

3.5.4.1. Identifying required external modules

On your design workspace, if a component requires the installation of an external module before it can work
properly, ared error indicator appears on the component. With your mouse pointer over the error indicator, you
can see a tooltip message showing which external module is required. For more information on handling error
icons, see section How to handle error icons on components or Jobs.

The Modules view lists al the modules required to use the components embedded in the Studio, including those
missing Java libraries and drivers that you must install to get the relevant components working.

If the M odules tab does not show on the tab area of your design workspace, go to Window > Show View... > Talend and
a then select M odules from the list.

To access the M odules view, click the M odules tab in the design workspace.

iy Job(test) Contexts(Job test ) | 52 Component | I Run (Job test) | = Modules &3 %1 Problems =8
| o 0, ¥

Status Context Module Description Required i

¥ Installed tMongoDBWriteConf ezmorph-1.06.jar Required for using this component. v

i@ Mot installed tR5SInput feedd).jar Required for using this component. v

| Installed tFileCopy filecopy.jar Required for using this component. v

@ Mot installed tFTPConnection ftpdj-1.5.1,ar Required for using this compoenent. v

i@ Mot installed tFTPGet ftpdj-1.5.1.jar Required for using this component. v

¥ Installed tSCPPut ganymed-ssh2.jar Required for using this component. v

| Installed tSCPFileExists ganymed-ssh2.jar Required for using this component. v

| Installed tSCPDelete ganymed-ssh.jar Required for using this component. v

¥ Installed tSCPClose ganymed-ssh.jar Required for using this component. v

¥ Installed tSCPConnection ganymed-ssh2.jar Required for using this component. v -

The table below describes the information presented in the M odules view.

Column Description

Status pointsout if amoduleisinstalled or not installed on your system.

The % icon indicates that the module i's not necessarily required for the corresponding component

listed in the Context column. The (X] icon indicates that the moduleis absolutely required for the
corresponding component.

Context lists the name of Talend component using the module. If this column is empty, the moduleis then

required for the general use of Talend Open Sudio for Big Data.

This column lists any external libraries added to the routines you create and save in the
" ] Studiolibrary folder. For moreinformation, see section Howto edit user routinelibraries.
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Column Description

Module lists the module exact name.

Description explains why the modulée/library is required.

Required the selected check box indicates that the module is required.

In addition to the M odules view, Talend Open Sudio for Big Data provides a mechanism that enables you to
easily identify, download and install most of the required third-party modules from Talend website and directs
you to valid websites for the rest.

A Jar installation wizard appears when you:

* drop a component from the Palette if one or more external modules required for that component to work are
missing in Talend Open Sudio for Big Data, or

» click the Guessschema buttoninthe Component view of acomponent if one or more external modulesrequired
for that component to work are missing in Talend Open Studio for Big Data, or
click the ¥ button in the M odules tab view.

When you click this button, the wizard that appears will list al the required external modules that are not integrated in
7 Talend Open Studio for Big Data.

£ Compenent tFTPGet reguires the following third party modules; =ANCN X

List of modules not installed for component tFTPGet

"

Jar Module Required by component  Required  License More information Action
edtftpj.jar Alava FTP library  tFTPGet v LGPL_v... bhitpfwww.enterprisedt.com/ |Downleoad and Install
ftpdj-1.51.jar Alava FTP library  tFTPGet vl LGPL_v.. http://sourceforge.net/ Download and Install

Click here to obtain more informations about external modules Download and install all modules available

[ Do not show again

.’5‘1
e/

The table below describes the information presented in the wizard.

Item Description

Jar The file name of the external module.

Module A short description about the nature of the module.

Required by component Lists the components that require the external module.

Required The selected check box indicates that the moduleis required.

License The license under which the module is provided.

Moreinformation Providesthe URL of the valid website where you can find more information about this module and

download the module manually.

Action PresentsaDownload and I nstall button if the moduleisavailable on Talend website, click to start
downloading and installing the module; or alink to direct you to the valid website to download the
module manually if the moduleis not available on Talend website.

Download and install all|Click to download and install al the required modules that are available on Talend website.
modules available
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Item Description

Do not show again 3
Select to prevent the wizard from appearing again unless you click the button in the M odules

tab view. This check box shows only when you drop a component, or guess the schema of a
database, that requires amissing external module.

~ Click to go to Talend online documentation on installing third-party modul es.

When you drop acomponent, or guess the schema of a database, that requires an external module, if neither the Jar
file nor its download URL information is available on Talend website, the Jar installation wizard does not appear,
but the Error Log view will present error information informing you that the download URL for that module is
not available, so that you can try to find and download it by yourself.

For more information about the Error L og view, see section Configuration tabs.

3.5.4.2. Installing external modules

To download and install missing modules automatically, do the following:

1. Inthe Jar installation wizard, click the Download and Install button to install a particular module, or click
the Download and install all modules available button to install all the available missing modules.

2. Click Accept in the[License] dialog box that appears to continue the installation.

The [License] dialog box appears for each license under which the relevant modules are provided until that license
7 is accepted.

Upon installation of the chosen external module or modules, adialog box appears to notify you about the number
of modules successfully installed and/or about the modules failed to install, if any.

To install manually a missing external module that you have already downloaded, do the following:

Inthe M odulesview, click the L jconinthe upper right corner of the view to browse your local file system.
2. Inthe[Open] diaog box, browse to the module you want to install.

For Oracle9i, the required JDBC driver downloadable from Oracle website is named ojdbcl4.jar, the same as that
5 for Oracle 10g. To make the JDBC driver for Oracle9i you have downloaded work in Talend Open Sudio for Big
Data, you have to change the file name to ojdbc14-9i.jar beforeinstalling it into the Studio.

3. Double-click Jar file, or select it and then click Open to install it.
The dialog box closes and the selected module isinstalled in the library folder of the current Studio.

Y ou can how use the component dependent on this module in any of your Job designs.

3.5.5. How to use the tPrejob and tPostjob
components
The tPrejob and tPostjob components are designed to make the execution of tasks before and after a given job

easier to manage. These components differ from other components in that they do not actually process data and
they do not have any components properties to be configured. A key feature of these componentsisthat they are
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always guaranteed to be executed, even if the main data Job fails. Therefore, they are very useful for setup and
teardown actions for a given Job.

AstPrejob and tPostjob are not meant to take part in any data processing, they cannot be part of a multi-thread execution.
i They are meant to help you make your Job design clearer.

To use these tPrejob and tPostjob components, ssmply drop them onto the design workspace as you would do
with any other components, and then connect tPr g ob to acomponent or subjob that is meant to perform apre-job
task, and tPostjob to a component or subjob that is meant to perform a post-job task, using Trigger connections.
An orange square on the pre- and post-job parts indicates that they are different types of subjobs.
Prejob:
p

tPrejbb_i

OnCarmponent ok

r 1 rows in 0,025
25 mwsis

-y
i % rowZ [Felain) =
tFileInputCelirnited 1 - " bCantextload 2

onSulfiobok
) ) [ Postjole

L 479 powes in 0,565

.j. S I’& gg‘:ﬁﬁiﬂ =,:s L D

My sqlConnection 1 | ' | califomiaCites " Mysql_Local DB | | tPastipb_1

OnCornponentCl

.I -;ﬂ .
tFileCelete 1
Tasks that require the use of atPrejob component include:
 Loading context information required for the subjob execution.
» Opening a database connection.
e Making surethat afile exists.
Tasks that require the use of atPostjob component include:
 Cleaning up temporary files created during the processing of the main data Job.
» Closing a database connection or a connection to an external service.

» Any task required to be executed, even if the preceding Job or subjobs failed.

3.5.6. How to use the Use Output Stream feature

The Use Output Stream feature allows you to process the datain byte-arrays using ajava.io.outputstream() class
which writes data using binary stream without data buffering. When processing data with a linear format, for
example, when all datais of Sring format, this feature will help you improve the overall output performance.
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=E
% tFileOutputDelimited_1 E

Basic settings Property Type Bl I ¥ H

Advanced settings IJse Cukpuk Strearn

Crynarmic setkings Cukput Skream (java.io, QutputStream)globalap, get"ouk_File")
Wigw Row Separakar " Field Separatar  |"}"
Documentation Include Header [ | Compress as zip file

Walidation Rules 7
Schema Bult-ln % | Editschema [)

The Use Output Stream feature can be found in the Basic settings view of a number of components such as
tFileOutputDelimited.

To usethisfeature, select Use Output Stream check box in the Basic settings view of acomponent that has this
feature. In the Output Stream field that is thus enabled, define your output stream using a command.

Prior to use the output stream feature, you have to open astream. For adetailed example of theillustration of this prerequisite

2 and the usage of the Use Output Stream feature, see section Using the output stream feature. For an example of Job using
this feature, see the second scenario of tFileOutputDelimited in Talend Open Sudio for Big Data Components Reference
Guide.

3.6. Handling Jobs: miscellaneous subjects

The sections below give detail information about various subjects related to the management of adata integration
Job including defining the start component, handling errors, and searching for jobs that use specific components.

3.6.1. How to share a database connection

If you have various Jobs using the same database connection, you can factorize the connection by using the Use
or Register a shared connection option.

This option has been added to all database connection components in order to reduce the number of connections
to open and close.

The Use or Register a shared connection option of all database connection components is incompatible with the Use
£5 dynamic job and Use an independent process to run subjob options of the tRunJob component. Using a shared database
connection together with a tRunJob component with either of these two options enabled will cause your Job to fail.

Assume that you have two related Jobs (a parent Job and a child Job) that both need to connect to your remote
MySQL database. To use a shared database connection in the two Jobs, to the following:

1. Drag and drop atMysglConnection (assuming that you work with aMySQL database)

2. Connect it to the first component of your parent Job using aTrigger > On Subjob Ok link.
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_ [i@l OnSubjobOK ’% OnSubjobOK "’_@_ rowl (Main) + Sy
tMysqlConnection_1 tRunlob_ 1 tMysqlinput_1 tlogRow 1
OnSubjebOk

‘tMysglCommit_1’

3. IntheBasic settings view of the tMysglConnection component, fill in the database connection details..

4. SelecttheUseor Register a shared connection check box, and give aname to the connection in the Shared
DB Connection Name field.

£y Job(DE Context | %2 Compon £4 [ Run {Job ﬁ Oozie Sc | o, Modules 'f’;jl Errar Lo | (21 Problem = B8
=)
[i(]] tMysqgIConnection_1 =

Basic settings Fraperty Type

Advanced settings DE Yersion Mysgl 5 s

Crynamic setkings Hask "lacalhost” Part "m0t

e Database “mytalenddb” * ndditional JDBC Parameters | "noDaketimestringSyr

Dacumentation " "
Usernarme "rook" Passwiopg |k

Use or register a shared DB Connection  shared DB Connection Name  |Mame_of_my_Connection |*

Y ou are now able to re-use the connection in your child Job.

5. In the Basic settings view of the tMysqglConnection component in the child Job, simply select Use or
Register a shared connection check box, and fill the Shared DB Connection Name field with the same
name as in the parent Job.

Among the different Jobs sharing the same database connection, you need to define the database connection details
" only in thefirst Job that needs to open the database connection.

For more information about how to use the Connection components, see Talend Open Sudio for Big Data
Components Reference Guide.

3.6.2. How to define the Start component

The Start component is the trigger of a Job. There can be several Start components per Job design if there are
several flows running in parallel. But for one flow and its connected subflows, only one component can be the
Start component.

Drop a component to the design workspace, al possible start components take a distinctive bright green
background color. Notice that most of the components, can be Start components.

Only components which do not make sense to trigger a flow, will not be proposed as Start components, such as
the tMap component for example.
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~

" tFilelnputlDIF 1

rowz {Lookup)

. . . . . . . . ‘r . - - - .G
: sl .
‘_Eb @ ol (fain =E 4 output {Main) *
kFileList_1 tFileInputDelimited_2 EMap_1 EFileCutput L1

Todistinguish which component isto bethe Start component of your Job, identify the main flow and the secondary
flows of your Job.

» The main flow should be the one connecting a component to the next component using a Row type link. The
Start component isthen automatically set on the first component of the main flow (icon with green background).

» The secondary flows are also connected using a Row-type link which is then called Lookup row on the design
workspaceto distinguish it from the main flow. ThisLookup flow isused to enrich the main flow with more data.

Be aware that you can change the Start component hence the main flow by changing a main Row into a Lookup
Row, simply through aright-click the row to be changed.

Related topics:
* section How to connect components together

* section Activating/Deactivating a Job or a sub-job

3.6.3. How to handle error icons on components or
Jobs

When the properties of a component are not properly defined and contain one or several errors that can prevent
the Job code to compile properly, error icons will automatically show next to the component icon on the design
workspace and the Job name in the Repository tree view.

3.6.3.1. Warnings and error icons on components

When a component is not properly defined or if the link to the next component does not exist yet, ared checked
circle or awarning sign is docked at the component icon.

Mouse over the component, to display thetooltip messages or warningsalong with the label. Thiscontext-sensitive
help informs you about any missing data or component status.
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Lx]

b tsasInput_1

. - (rasndngs:
ESasInput
s - This component should have outputs linked,

. |Erroes:

- Mo schema has been defined wet,

- Module sas,core.jar required

- Module sas, 5w, conneckion, jar required

- Module sas.intrnet.javatnnlijar required

When thetooltip messages of acomponent indicate that amoduleisrequired, you must install thismodulefor this component
2 using the M odule view. This view is hiden by default. For further information about how to install external modules using
this view, see section How to install external modules.

3.6.3.2. Error icons on Jobs

When the component settings contain one or several errors that can prevent the Job code to compile properly, an
icon will automatically show next to the Job name in the Repository tree view.

a x =0

LOCAL: companent — '%’gh Rl =
- v23a i
- w23c

== v2da
B ]

oy durnney L Forimpackyiew 0,1

iy Forgdloop 0,1

o msgdisplay 0.1

The error icon displays as well on the tab next to the Job nhame when you open the Job on the design workspace.
The compilation or code generation does only take place when carrying out one of the following operations:
 opening a Job,

* clicking on the Code Viewer tab,

 executing aJob (clicking on Run Jab),

* saving the Job.

Hence, the red error icon will only show then.

When you execute the Job, awarning dialog box opensto list the source and description of any error in the current
Job.
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Find Errors in Jobs

Warning! Some errors exisk in jobs, Would yvou like ko continue?

Resource Description

= ’EE kContextload_and_file
= General

_ &) Invalid escape sequence (valid ones are ...

Cancel H Conkinue

Click Cancel to stop your Job execution or click Continue to continue it.

For information on errors on components, see section Warnings and error icons on components.

3.6.4. How to add notes to a Job design

Inthe Palette, click the Misc family and then drop the Note element to the design workspace to add atext comment
to a particular component or to the whole Job.

[~ Logs & Errors
[ Misc

nake

Y ou can change the note format. To do so, select the note you want to format and click the Basic setting tab of
the Component view.

Cpacity

Fonts and Colars

| Tirme Mew Roman | 10 | Adjust horizontal adjust vertical

ilefe Covight (&) centre itop (O batkarn (5) centre

Text text

Select the Opacity check box to display the background color. By default, this box is selected when you drop a
note on the design workspace. If you clear this box, the background becomes transparent.

You can select options from the Fonts and Colors list to change the font style, size, color, and so on as well as
the background and border color of your note.

You can select the Adjust horizontal and Adjust vertical boxes to define the vertical and horizontal alignment
of the text of your note.
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The content of the Text field is the text displayed on your note.

3.6.5. How to display the code or the outline of your
Job

This panel is located below the Repository tree view. It displays detailed information about the open Job in the
design workspace.

The Information panel is composed of two tabs, Outline and Code Viewer, which provide information regarding
the displayed diagram.

3.6.5.1. Outline

The Outline tab offers a quick view of the open Job on the design workspace and also a tree view of all used
elements in the Job. As the design workspace, like any other window area can be resized upon your needs, the
Outline view is convenient to check out where about on your design workspace, you are located.

0= Outline 57 |8 T O
'
lF:I-:‘Irp-\J;LI:-IF_'.
5 o
. X .
Filedlisk_1 FilelnputiDeliribed 2 Pap_L FileOubputhL,_L
E Code Viewer &3 = =B
”
if i
Wy =
print {
I{: 1
!
map {
ssooklt g
= hgt [ g
= e AMp g
I< 1
T
1.
‘<7 Sdesc : tAML_ 18
4 >

Thisgraphical representation of the diagram highlightsin a blue rectangle the diagram part showing in the design
workspace.

Click the blue-highlighted view and hold down the mouse button. Then, move the rectangle over the Job.
The view in the design workspace moves accordingly.

The Outline view can also be displaying afolder tree view of componentsin use in the current diagram. Expand
the node of a component, to show the list of variables available for this component.
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To switch from the graphical outline view to the tree view, click either icon docked at the top right of the panel.

3.6.5.2. Code viewer

The Code viewer tab provides lines of code generated for the selected component, behind the active Job design
view, aswell the run menu including Start, Body and End elements.

Using a graphical colored code view, the tab shows the code of the component selected in the design workspace.
Thisis a partial view of the primary Code tab docked at the bottom of the design workspace, which shows the
code generated for the whole Job.

3.6.6. How to manage the subjob display

A subjob is graphically defined by a blue sguare gathering all connected components that belong to this subjob.
Each individual component can be considered as a subjob when they are not yet connected to one another.

RN T QTR N GEEERIR

tFileList_1 ' tFileInputDelimited_1 tap_z " EMywsgloutput 1 |

This blue highlight helps you easily distinguish one subjob from another.

A Job can be made of one single subjob. An orange square shows the prejob and postjob parts which are different types
| of subjobs.

For more information about prejob and postjob, see section How to use the tPrejob and tPostjob components.

3.6.6.1. How to format subjobs

Y ou can modify the subjob color and itstitle color. To do so, select your subjob and click the Component view.
Job(Job tDTDYalidator 0,10 Conkexts{Job tDTOYalidakor 0. | gy Component &3 |
[z Subjob
Show subiob Eitle
Title DTD Walidation

Title calar E Subjob colar @]

Basic settings

Advanced setkings

In the Basic setting view, select the Show subjob title check box if you want to add atitle to your subjob, then
fill in atitle.

To modify thetitle color and the subjob color:

1. IntheBasic settingsview, click the Title color/Subjob color button to display the [Colors] dialog box.
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2. Setyour colors as desired. By default, the title color is blue and the subjob color is transparent blue.

3.6.6.2. How to collapse the subjobs

If your Job is made of numerous subjobs, you can collapse them to improve the readability of the whole Job.
The minus (-) and plus (+) signs on the top right-hand corner of the subjob allow you to collapse and restore the
complete subjob.

=
—lp ~ :??5
ro2 (THain) "—a Xi !
tFileInputExcel 1 ' ' ' © tMysgloutput_1 1 | tFileInputExcel_1

Click theminussign (-) to collapse the subjob. When reduced, only the first component of the subjob is displayed.

Click the plus sign (+) to restore your subjob.

3.6.6.3. How to remove the subjob background color

If you do not want your subjobsto be highlighted, you can remove the background color on all or specific subjobs.

To remove the background color of all your subjobs, click the Toggle Subjobsicon on the toolbar of Talend Open
Sudio for Big Data.

|| 100%

=y |
Toggle Subjobs |

To remove the background color of a specific subjob, right-click the subjob and select the Hide subjob option
on the pop-up menu.

N
£ Fio

. : : - | < Unda Move Mode i

tRowGenerator 1 ' ' put_1
=| Copy

¥ Delete
Select All

Settings
Bring Forward
Bring to Fronk
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3.6.7. How to define options on the Job view

Onthe Job view located on the bottom part of the design workspace, you can define Job’ s optional functions. This
view is made of two tabs: Stats & Logstab and Extra tab.

The Stats & L ogs tab allows you to automate the use of Stats & L ogs features and the Context |oading feature.
For more information, see section How to automate the use of statistics & logs.

The Extra tab lists various options you can set to automate some features such as the context parameters use, in
the Implicit Context L oading area. For more information, see section How to use the featuresin the Extra tab.

3.6.7.1. How to automate the use of statistics & logs

If you have a great need of log, statistics and other measurement of your data flows, you are facing the
issue of having too many log-related components loading your Job Designs. You can automate the use of
tFlowM eter Catcher, tStatCatcher, tL ogCatcher component functionalities without using the components in
your Job viathe Stats & L ogstab.

For more information regarding the L og component, see Talend Open Studio for Big Data Components Reference
Guide.

The Stats& L ogspanel islocated on the Job tab underneath the design workspace and prevents your Jobs Designs
to be overloaded by components.

This setting supersedes the log-related components with a general log configuration.
-

To set the Stats & L ogs properties.
1. Click the Job tab.

2. Select the Stats & L ogs pand to display the configuration view.

Main [Relu:uad from project settings ] [Sa'-.-'e to project settings ] Use Project Settings

Sxira [¥]Use statistics {t5tatCatcher)  [#]Use logs (tLogCatcher)  [¥] Use volumetrics (tFlowMeterCatcher)

Stats & Logs [Jon consale
On Files
File Path "Ei/Studios Talend_5/TOS_BD-r32443-V5, 1.0MB fworkspace /. metadata” E]
Stats File Mame “stats_file, tut” *
Log File Mame Togs_file.txt” *
Meter file name ‘meter_file. txt” *
Encoding 1S0-88593-15 |+
On Databases

Property Type

Db Type MySQL +|* Dbversion |[MySQL4 |&*

Host localhost”™ Port |*3308"

Db Mame “talend” Additional parameters | "noDatetimeStringSync=true
User “root” * Passwgrg | TEEssmwwm §
Stats Table “statistics” [3

Logs Table Togs” [3

Meter Table “volumetrics” [3

Catch runtime errors Catch user errors Catch user warnings

[]catch components statistics (tStatCatcher Statistics)
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3. Set therelevant details depending on the output you prefer (console, file or database).

4. Select therelevant Catch check box according to your needs.

2 Y ou can save the settings into your Project Settings by clicking the[ S 0D 0 AT ] button. This way, you can
access such settings via File > Edit project settings > Job settings > Stats & Logsor viathe “~  button on the toolbar.

When you use Stats & L ogs functionsin your Job, you can apply them to all its subjobs.
iy Job b_father D.1

Main [Belu:uad from preferences ] [iave ko preferences ] [.ﬁ.ppl':.-' ko sub jobs ]

Extra

Stats & Logs

[ ]use statistics (tStatCatchery [ |Use logs (tlogCatcherd  []Use volumetrics {tFlowMeterCatcher)

Version

To do so, click the Apply to subjobs button in the Stats & L ogs panel of the Job view and the selected stats &
logs functions of the main Job will be selected for all of its subjobs.

3.6.7.2. How to use the features in the Extra tab

The Extra tab offers some optional function parameters.
» Select the Multithread execution check box to allow two Job executions to start at the same time.

» Set the Implicit tContextL oad option parameters to avoid using the tContextL oad component on your Job
and automate the use of context parameters.

Choose between File and Database as source of your context parameters and set manually the file or database
access.

Set notifications (error/warning/info) for unexpected behaviors linked to context parameter setting.

* When you fill in Implicit tContextL oad manually, you can store these parametersin your project by clicking
the Save to project settings button, and thus reuse these parameters for other components in different Jobs.

» Select the Use Project Settings check box to recuperate the context parameters you have already defined in
the Project Settings view.

The Implicit tContextL oad option becomes available and all fields are filled in automatically.
For more information about context parameters, see section Context settings.

» Click Reload from project settings to update the context parameters list with the latest context parameters
from the project settings.

3.6.8. How to find components in Jobs

Y ou should open one Job at least in the Studio to display the Palette to the right of the design workspace and thus start
2 the search.

From the Palette, you can search for all the Jobs that use the selected component. To do so:
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1.

2.

In the Palette, right-click the component you want to look for and select Find Component in Jobs.

= Databases £
W trysgiemnm
i tMysglConnection
& tMysgllnput
Add To Favarite EMysolLastInsertd
Hide Folder I
Display Folder dhigejellesllls
EMysgloukputBulk,
Layauk k
EMysgloukputBUlkE e

se Large Icons

Setkings...

Find Component in Jobs

A progress indicator displays to show the percentage of

tMysglRollback,
kM sglFow
trlysqlaCD

the search operation that has been completed then

the [Find a Job] dialog box displays listing al the Jobs that use the selected component.

¥ Find a Job

Type job name prefix or patkern(™®, ¥, or camel case);

B=1E

=00 o _1oE
£ DWH_Load_CRM 0.1
=2- k01 _Campa
== Databases
== InCut
== MySOL
’Eb thysglInput 0.1
== 50D
£ stepzMadifyData 0.1
£ tMysglsCD 0.1
’EE dragdrop_rompaonents 0,1

Cancel

From thelist of Jobs, click the desired Job and then click OK to open it on the design workspace.
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3.6.9. How to set default values in the schema of an
component

You can set default values in the schema of certain components to replace null values retrieved from the data
source.

At present, only tFilelnputDelimited, tFilel nputExcel, and tFixedFlowl nput support default values in the schema.

In the following example, the company and city fields of some records of the source CSV file are left blank, as
shown below. The input component reads data from the source file and compl etes the missing information using
the default values set in the schema, Talend and Paris respectively.

i d; firstName; | ast Nanme; conpany; ci ty; phone
1; M chael ; Jackson; | BM Romm; 2323

2; Eli sa; Bl ack; M crosoft; London; 4499

3; M chael ; Duj ardi n; ; ; 8872

4; Mari e; Dol vi na; ; ; 6655

5; Jean; Perfide; ;; 3344

6; Em | i e; Tal dor; Oracl e; Madri d; 2266

7; Anne- Laur e; Pal dufi er; Appl e; ; 4422

To set default values:

1. Double-click the input component tFilel nputDelimited to show its Basic settings view.

a—a—n

1 rowed (Main) 4
tFileInputDelimited _1 ' ' ' ' ' " tLogRow 1

Designer | Code

1 Job(DE Contex | 5e Compo 23 [E= run (Jo [_:-5' Dozie 5 | & Module @] Errar L (%1 Proble =08

SiE
H tFileInputDelimited_1 ==

Basic settings Property Tyvpe

Advanced settings "When the input source is a stream or a zip file,Footer and random shouldn't be bigger than 0."
Dynamic settings File namefStreamn "Dy Talend/InputfoontackInfo, csw" * [I]
= Fow Separakor " Field Separator  |";" *
Documentation D €Y aptions

Header 1] Footer |0 Lirnit

Schema Edit schema E]

[]5kip empty rows [ ]Uncompress as zip file [ ] Die on error

2. Click the[...] button next to Edit schema, and select the Change to built-in property option from the pop-
up dialog box to open the schema editor.

3. Enter Talend between quotation marks in the Default field for the company column, enter Paris between
quotation marksin the Default field for the city column, and click OK to close the schema editor.
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# Schema oftFilelnputDelimited_1 X

tFileInputDelimited_1

Calumn Key | Type w| M.| Dat.. | Le... | Pr... | Default C...
id ] 1nt... 1 0
firzstame [ ] String 10 0
lasthame [ ]  String g 0
company [ ]| String g 0 Talend’
city [] string g 0 Parig’
phone ] 1nt... 4 0

2)[)(«)[W]

[ OK ][ Cancel

4. Configure the output component tL ogRow to display the execution result the way you want, and then run
the Job.

Execution

SEArtIing Jof s86 Jefand e 3¢ JE 5T ST

[ztati=tic=s] connecting to socket on port 3371
[ztati=stics] connected

tLogRow_1
id|firstHame |lastFWame |company |citvy | phone
1 |Hicha=sl | JTackson | IEM |Boma | 2323
2 |Eli=a |Blaclk |[Microsoft |London | 4499
3 |Hichael |[Dujardin |Talend |Pari=s |8872
4 |HMarie |[Dolwina | Talend |Paris |B6GE
£ |Jean |Perfide |Talend |Paris |3344
6 |Emilie [Taldor |[Oracle |Madrid| 2266
7 |Anne-Laure|Paldufier |Apple |Paris |4422

[statistics] disconnected
Joah maf defaunlt amdasd s 180 5F SRS fasr b oodes=g7

In the output data flow, the missing information is completed according to the set default values.
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Chapter 4. Managing data integration Jobs

This chapter describesthe management proceduresyou can carry out on the Jobsyou design in Talend Open Sudio
for Big Data or you can carry out on any of the itemsincluded in a project, for example routines or metadata.

These management procedures include importing and exporting Jobs and items between different projects or
machines, scheduling Job execution, etc.

Before starting any data integration processes, you need to be familiar with Talend Open Sudio for Big Data
Graphical User Interface (GUI). For more information, see appendix GUI.
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4.1. Activating/Deactivating a Job or a sub-
job
You can enable or disable the whole Job, sub-job directly connected to the selected component. By default, a

component is activated.

In the Main properties of the selected component, select or clear the Activate check box.

* '# rowE (M - @_ ......... T > 0

‘tRowSenerator 1 bFileQuktputDelimited 1 tDie 1

*— <) Undn Desactivate component

=| Copy

¥ Delete
Select All

Add breakpnig

Alternatively, right-click the component and select the relevant Activate/Deactivate command according to the
current component status.

If you disable acomponent, no codewill be generated, you will not be able to add or modify links from the disabled
component to active or new components.

Related topic: section How to define the Start component.

4.1.1. How to disable a Start component

In the case the component you deactivated is a Start component, components of all types and links of all nature
connected directly and indirectly to it will get disabled too.

4.1.2. How to disable a non-Start component

When you clear the Activate check box of aregular (non Start) component, are deactivated only the selected
component itself along with al direct links.

If adirect link to the disabled component isaMain Row connection to a sub-job, all components of this subjob
will also get disabled.
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4.2. Importing/exporting items or Jobs

Talend Open Sudio for Big Data enables you to import/export your Jobs or items in your Jobs from/to various
projects or various versions of the Studio. It enables you as well to export Jobs and thus deploy and execute those
created in the Studio on any server.

4.2.1. How to import items

Y ou can import items from previous versions of Talend Open Studio for Big Data or from a different project of
your current version.

Theitems you can possibly import are multiple;

» Jobs Designs

* Routines

Follow the steps below to import them to the repository:

1. Inthe Repository tree view, right-click any entry such as Job Designs, and select Import Items from the
contextual menu to open the [Import items] dialog box.

ﬁj Repository &4 =0
LOCAL: ProjectMame = '»‘DQ g™
+ ’_h

- Cont ’_E Create job

gl =T Create folder
+ Code Expand,Collapse
=-LJ sqL 1 iy Export Job

_+ —H ftTerortitans

@ Recy (g} Export items

Alternatively, you can directly click the & jcon on the tool bar.

2. Inthedialog box that appears, select the root directory or the archive file to import the items from.

« If theitemsto import are still stored on alocal repository, usethe Select root directory option and browse
to the relevant project directory on your system, and then proceed to the next step.

« If you exported theitemsfrom your local repository into an archivefile (including source files and scripts),
use the Select ar chive file option, browse to the file and then click Open to go to Step 6.

3. Browse down to the relevant Project folder within the workspace directory. It should correspond to the
project name you picked up.
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4. If you only want to import very specific items such as some Job Designs, you can select the specific folder,

Select rook directary of the projects to impark

= [ TOS-Win3z-r3034-w2.0.0
+ ) configuration
+ | ) features
+ | lb
+ | ) plugins
|0 kemp
=l | ) workspace
# ) JJava
# [} .JETEmitters
# |} .metadata
I Perl
= |3 1ava_PROJECTL
+ | ) businessProcess

+ | ) code

Java_PROJECTI

such as Process where al the Job Designs for the project are stored.

5. Butif your project gather various types of items (Jobs Designs, Routines...), we recommend you to select the

Project folder to import al itemsin one go, and click OK to continue.
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% Import items |Z|@@

™,

Impart ikems from an archive file or direckory, E - 5
(%) Select rook directory: | D:\2_Perl_TOS-All-r16077-¥2 .4, 14TEx

i) Select archive File:

Ikems List

kyvpe filker bext
= [9]1= TALENDDEMOSPERL Select Al

[ select & |
[E]ih Job Designs
=[] LA Contexts
[]HA commonContest 0.1 1 ;
[ commonContest 0.1
=-[]#3 Routines
[]=4 demon.l

[]=3 demoo.1
[ #d Db Connections

Errors and Warnings

'Conkexts globalConkext 0.1' ¢ wou kry bo add a java item in a perl project

|:| overwribe existing items

)] Finish ] [ Cancel

6. Select the overwirte existing items check box if you want to overwrite existing items with those having the
same names to be imported. Thiswill refresh the ItemsList.

7. From the Items List whih displays all valid items that can be imported, select the items that you want to
import by selecting the corresponding check boxes.

8. Click Finish to vaidate the import.

The imported items are displayed in the repository in the relevant folder respective to their nature.

4.2.2. How to export Jobs

The Export Job feature allows you to deploy and execute a Job on any server, independent of Talend Open Sudio
for Big Data.

The export Job feature adds all of the files required to execute the Job to an archive, including the .bat and .sh
along with any context-parameter files or other related files.

To export Jobs, compl ete the following:
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Inthe Repository treeview, right-click the Job you want to export, and select Export Job to openthe[Export
Jobs| dialog box.

You can show/hide a tree view of all created Jobs in Talend Open Sudio for Big Data directly from the [Export

Jobs] dialog box by clicking the '™ and the ! buttons respectively. The Jobs you earlier selected in the Studio tree
view display with selected check boxes. This accessibility helps to modify the selected items to be exported directly
from the dialog box without having to close it and go back to the Repository tree view in Talend Open Sudio for
Big Data to do that.
4 Export Jobs l of X
L b =
Select the items to Export: = =
ot To archive file: - Browse...
[7] 3 tRunJobRow =
0 XML Job Version
[y tAdvancedF Select the Job version
[] £ tDTDValidat
[ tXSDValidat: Export type
[l eX5LT0L Collapse Al
[T &% smiSample2 Select the export type [ Extract the zip file
[F] 0 t02_Concatening
[Ty link_if0.1 Options
[T 5 link_with_tDie_t
[T enComponentt
& OnSubjobError! Shell launcher All -
|H] = tD3_DemoRoutines [¥] Context scripts I:‘Appl)r Context to children
[t demobl tava 0 [Override parameter's values]
[T dema02_define
& demol3_tMap (
!.j to demolé_tRowG [¥] Java sources
[T 2 t04_Context [l Htems
[ built_inContext,
15 built_inContext | =
[] £ repositoryConte
[7]#y tContextload_a ~
] I G " o >
'@:‘ [ Finish ] ’ Cancel

Inthe To archivefilefield, browse to the directory where you want to save your exported Job.

Select the Export Type from the list between Autonomous Job, Axis Webservice (WAR), Axis
Webservice (Zip), JBoss ESB, Petals ESB and OSGI Bundle For ESB.

Select the Extract the zip file check box if you want the archive file to be automatically extracted in the
target directory.

Inthe Optionsarea, select the file type(s) you want to add to the archivefile. The check boxes corresponding
to the file types necessary for the execution of the Job are selected by default. You can clear these check
boxes depending on what you want to export.

Option Description

Shell launcher Select this check box to export the .bat and/or .sh files necessary to launch the exported Job.
¢ All: exportsthe .bat and .shfiles.
¢ Unix exportsthe .shfile.

* Windows exports the .bat file.

Context scripts Select this check box to export ALL context parameters files and not just those you select
in the corresponding list.
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Option Description
To export only one context, select the context that fits your needs from the
2 Context scriptslist, including the .bat or .sh files holding the appropriate context
parameters. Thenyou can, if youwish, edit the .bat and .sh filesto manually modify
the context type.

Apply to children Select this check box if you want to apply the context selected from thelist to al child Jobs.

Java sour ces Select this check box to export the .java file holding Java classes generated by the Job when
designing it.

Items/ Sourcefiles Select this check box to export the sources used by the Job during its execution including the
.itemand .propertiesfiles, Javaand Talend sources.

If you select the Items or Sour ce files check box, you can reuse the exported Job
a2 in a Talend Open Sudio for Big Data installed on another machine. These source
files are only used in Talend Open Sudio for Big Data.

6. Click the Override parameters values button, if necessary.

In the window which opens you can update, add or remove context parameters and values of the Job context
you selected in thelist.

7. Click Finish to validate your changes, complete the export operation and close the dialog box.
A zipped file for the Jobs is created in the defined place.

If the Job to be exported calls a user routine that contains one or more extra Java classes in parallel with the public class

i ] named the same as the user routine, the extraclass or classeswill not beincluded in the exported file. To export such classes,
you need to include them within the class with the routine name as inner classes. For more information about user routines,
see section Managing user routines. For more information about classes and inner classes, see relevant Java manuals.

4.2.2.1. How to export Jobs as Autonomous Job

In the case of a Plain Old Java Object export, if you want to reuse the Job in Talend Open Sudio for Big
Data installed on another machine, make sure you selected the Items check box. These source files (.item and
.properties) are only needed within Talend Open Sudio for Big Data.

Select a context from the list when offered. Then once you click the Override parameters' values button below
the Context scripts check box, the opened window will list al of the parameters of the selected context. In this
window, you can configure the selected context as needs.

All contexts parameter files are exported along in addition to the one selected in the list.

After being exported, the context selection information is stored in the .bat or .sh file and the context settings are stored
2 in the context .propertiesfile.

4.2.2.2. How to export Jobs as Webservice

In the [Export Jobs] dialog box, you can change the type of export in order to export the Job selection as
Webservice archive.

Export bvpe

Select the export bype | Autonomous Job w | []Extract the: zip File

Bubonomous Job
Axis WebService (WAR)
Ais WebService (ZIP)
JBoss ESE

Opkions
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Select the type of archive you want to use in your Web application.

Archivetype Description

WAR The options are read-only. Indeed, the WAR archive generated includes al
configuration files necessary for the execution or deployment from the Web
application.

ZIP All options are available. In the case the files of your Web application config are all
set, you have the possibility to only set the Context parametersif relevant and export
only the Classes into the archive.

Once the archive is produced, place the WAR or the relevant Class from the ZIP (or unzipped files) into the
relevant location, of your Web application server.

The URL to be used to deploy the Job, typically reads as follow:

http://1 ocal host: 8080/ Webappnane/ ser vi ces/ JobNarme?net hod=r unJob&ar gs=nul |

where the parameters stand as follow:

URL parameters Description

http://local host:8080/ Typein the Webapp host and port.

/Webappname/ Typein the actual name of your web application.

[services/ Typein “services’ asthe standard call term for web services.
/JobName Type in the exact name of the Job you want to execute.
?method=runJob& args=null The method is RunJob to execute the Job.

The call return from the Web application is 0 when there is no error and different from O in case of error. For a
real-life example of creating and exporting a Job as a Webservice and calling the exported Job from a browser,
see section An example of exporting a Job as a Web service.

The tBuffer Output component was especially designed for this type of deployment. For more information
regarding this component, see Talend Open Sudio for Big Data Components Reference Guide.

4.2.2.3. An example of exporting a Job as a Web service

This scenario describes first a simple Job that creates a .txt file and writes in it the current date along with first
and last names. Second, it shows how to export this Job as a Webservice. And finally, it calls the Job exported
as a Webservice from a browser. The exported Job as a Webservice will smply return the “return code” given
by the operating system.

Creating the Job:

1. Drop the following components from the Palette onto the design workspace: tFixedFlowlnput and
tFileOutputDelimited.

2. Connect tFixedFlowl nput to tFileOutputDelimited using aRow > Main link.

o rowl (Main)

[tFizedFlowInput_1 tFileCutpukDelinited_1
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In the design workspace, select tFixedFlowl nput, and click the Component tab to define the basic settings
for tFixedFlowl nput.

Set the Schema to Built-In and click the[...] button next to Edit Schema to describe the data structure you
want to create from internal variables. In this scenario, the schemais made of three columns, now, firstname,
and lastname.

% Schema of tFixedFlowlnput_1 E|
tFiwedFlowInpuk_1
Colurmn key  Type | Mulable | DatePa... Le...  Pr... | D.. Coo,
G now Date "dd-Mm-. .
firstname [] string
lastranme [] string

[ 8] 4 ] [ Cancel

Click the [+] button to add the three parameter lines and define your variables, and then click OK to close
the dialog box and accept propagating the changes when prompted by the system.

The three defined columns display in the Values table of the Basic settings view of tFixedFlowlnput.

Walues
Colurmn Walue

o
firstname
lastname

In the Value cell of each of the three defined columns, press Ctrl+Space to access the
global variable list, and select TalendDate.getCurrentDate(), talendDatagenerator.getFirstName, and
talendDataGener ator .getLastName for the now, firstname, and lastname columns respectively.

Inthe Number of rowsfield, enter the number of linesto be generated.

Eb tFixedFlowInput_1 == [:

' ”
Basic settings Schemna Edit schema [Z]
Advanced settings Mumber of rows 3
Drynamic settings Maode
- (%) se Single Table
Docurnentation Values iy Yalue
M TalendDate, aetZurrentDated)
firstname TalendDataisenerakar , getFirsthamel)
lastname TalendDataGenerakor . getlastMNamel)
w

In the design workspace, select tFileOutputDelimited, click the Component tab for tFileOutputDelimited,
and browse to the output file to set its path in the File name field. Define other properties as needed.
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.. =

=y tFileOutputDelimited_1 — [:
Basic settings Froperty Type Buit-In hs

Advanced setkings File Marne " foukput fiouk, css” * [II
Dynamics settings Row Separatar " Field Separator | ;"

Wie Cappend [ Include Header

Lacumentation Schema Built-In v | Edischema [

If you press F6 to execute the Job, three rows holding the current date and first and last names will be written
to the set output file.

Exporting the Job as a Webservice:

1. Inthe Repository tree view, right-click the above created Job and select Export Job. The [Export Jobs]
dialog box appears.

To archive file: | C:\Program Filesidpache Software Foundation), Tome | s

Job Wersion

Select the job version (0.1 %

Export bype

Select the export bype | Axis WebService (WARY  w

Options

Defaule  » [ ]apply to chidren

() Finish ] [ Cancel

2. Click the Browse... button to select a directory to archive your Job in.

3. IntheExport typearea, select theexport typeyou want to useinyour Web application (WAR inthisexample)
and click Finish. The [Export Jobs] dialog box disappears.

4. Copy the War folder and paste it in the Tomcat webapp directory.
Calling the Job from a browser:
1. Type the following URL into your browser: http://localhost:8080//export_job/services/export job2?

method=runJob where “export_job” is the name of the webapp directory deployed in Tomcat and
“export_job2" isthe name of the Job.

132 Talend Open Studio for Big Data User Guide



How to export Jobs

e
I_E_T httpsfflocalbost: 80580/ export_jobfservicesfexpart_jobz?method=runlab

2. Click Enter to execute the Job from your browser.

iZe fichier XM ne semble pas avoir d'information de style i

— <soapenv:Envelope~
— <soapenv: Body=
— <runJohReturn xsi:type="ns 1 runfobEeturn">
— <nsl:item xsi:type="ns L ArrayOf zsd string">
<nsl:item xsi:type="z:sd:stnng">0</nsl:item>
<fnsl:item>
<frundJobReturn>
</soapenv: Body>=
</soapenv:Envelope>

The return code from the Web application is 0 when there is no error and 1 if an error occurs.

For areal-life example of creating and exporting aJob asaWebservices using thetBuffer Output component,
see the tBuffer Output component in Talend Open Studio for Big Data Components Reference Guide.

4.2.2.4. How to export Jobs as JBoss ESB

Talend Open Studio for Big Data provides the possibility to expose Talend Jobs as services into JBoss ESB
(Enterprise Service Bus) in order to execute these Jobs on the messaging engine (the bus).
In order to be able to export a Job to be deployed on a JBoss ESB server, make sure that the jar specific to JBoss ESB
&3 isinstalled in the Java library and that it displays in the Modules view of Talend Open Studio for Big Data . For more
information about the Modules view, see section How to install external modules.

In the [Export Jobs] dialog box, you can change the type of export in order to export the selected Job as an ESB
archive. Y ou can then deploy this exported Job on a JBoss ESB server.

To export a Job on ESB:
1. IntheJob Version area, select the version of the Job you want to execute on a JBoss ESB server.
2. From the Select export type list in the Export type area, select JBoss ESB.

3. IntheOptionsarea, select the file type you want to add to the archive. When the Context scriptslist displays
more than one context, select the one you need, and select the Apply to children check box if you want to
apply the context selected from the list to all child Jobs.

4. To export the sources used by the Job during its execution including the files .item, .properties and Java
sources of Jobs and routines, select the Sour ce files check box.

If you select the Sour ce files check box, you can reuse the exported Job in a Talend Open Studio for Big Data installed
a7 on another machine. These sourcefiles are only used in Talend Open Studio for Big Data.

5. Inthe ESB Export type list, select between JBoss MQ or JBoss Messaging.
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In the Service Name field, type in the name of the service on which you will deploy your Job.
In the Category field, type in the category of the service on which the Job will be deployed.

In the M essage Queue Name field, type in the name of the queue that is used to deploy the Job.

© © N o

Click the Browse... button next to the To archive file field and browse to set the path to the archive filein
which you want to export the Job. Then click Finish.

Thedialog box closes. A progressindicator displaysto show the progress percentage of the export operation.
The Job is exported in the selected archive.

When you copy the ESB archive in the deployment directory and launch the server, the Job is automatically
deployed and will be ready to be executed on the ESB server.

4.2.2.5. How to export Jobs as Petals ESB

Talend Open Studio for Big Data provides the possibility to expose Talend Jobs as services into petals ESB
(Enterprise Service Bus) in order to execute these Jobs on the messaging engine (the bus).

Integrating Talend with petals ESB

Talend provides a smooth approach to expose services on petals ESB and thus facilitates:

 application integration on the bus: This will enable the integration of systems and applications across the
enterprise.

* service interactions: The ESB provides connectivity between services. i.e. alows services with varying
interfaces to communicate.

The Java Business Integration (JBI) is the approach used to implement a service-oriented architecture (SOA) and
export Talend Jobs on petals ESB.

Petals ESB is complemented with Binding Components (BC) and Talend Service Engine (SE) in order to provide:
first the access methods necessary for different types of servicesincluding FileTransfer, WebService, MOM, and
second the engine to deploy the service. For more information about interaction between Petals and Talend Jobs,
check http://doc.petal slink.com/display/petal sesh/A+Simple+Tal end+Job.

Then, with theintegration of Talend and petals ESB, you can execute the Jobs designed in Talend Open Studio for
Big Data on petals ESB. For moreinformation, see section How to export Jobs as Petal s ESB. Several mechanisms
are provided to pass information and data to a Job and to retrieve information and data from a Job.

Using Talend Open Sudio for Big Data and petals ESB, you can execute a Job which has no specific interaction
with Petals. You can:

e expose a context as a parameter into the service's WSDL,
* pass attachment filesto a Job,
* pass hative parameters and options to a Job,

* get the Job's execution result.

How to export Jobs to petals ESB

From the [Export Jobs] dialog box, you can export a selected Job as a petals ESB archive. Y ou can then execute
the exported Job on the bus (the messaging engine).
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To export a Job as a petals ESB archive, complete the following:

1

In the Repository tree view, right-click the Job you want to export and then select Export Job from the

contextual menu.

The [Export Jobs] dialog box appears.

4 Export Jobs

X R I T alend! ExportmyArchive.zip - Browse... |

lob Version

Select the lob version

Export type
H Select the export type ’Petals ESB -
Options

[¥] Singleton job [ Generate the end-point
[¥] Source files [ validate Petals MMEessages

Job Contexts: [Default v]

Edit the exposed contexts (0]

©)

Finish ] ’ Cancel

L™

Inthe To archivefilefield, browse to set the path to the archive file in which you want to export the Job.

From the Select the job version list, select the Job version you want to export.

From the Select export typelist in the Export type area, select Petals ESB.

The three following options in the Options area are selected by default: Singleton job and Sour cefile. You
can select any of the other options as needed.

The table below explains the export options:

Option

Description

Singleton job

Exports the Job as singleton: A singleton Job can have only one instance running at atime on a
given Talend Service Engine in petals ESB.
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Option

Description

Generate the end-point

Generates the end-point at deployment time. If this option is not selected, the end-point nameis
the Job name with the suffix Endpoi nt .

Validate Petals messages

Validates all the messages/ requests against the WSDL.

Selecting this option reduces system performance (disk access).

&
Sourcefiles Embeds the source files in the generated service-unit.
Jobs contexts A list from which to select the context that will be used by default by the Job.
5. Inthe [Export Jobs] dialog box, click the Edit the exposed contexts link to open the [Context Export]
dialog box.
[ (1 30
Contexts Export
Define the way contexts will be exported in the generated WSDL,
Mame w3 Type Export Mode
outputLocation *siskring Mok exporked
Parameter
In-aktachrment
Out-Atkachment
Parameter and Cut-Akkachrent
@
This dialog box will display alist of all the context variables that are used in the exported Job. Here you can
specify how each context variable should be exported in the generated WSDL file.
6. ClickintheExport Modefield and select from thelist the context export mode for each of the listed context
variables.
The table below explains the export mode options:
Export Mode Description
Not exported The context is not exported (not visible as a parameter). But the context can till be overridden
using the native parameters (options) of the Job.
Parameter The context is exported as a parameter in the WSDL.
In-Attachment The context will pass the path of atemporary file which content is attached in the input message.
Out-Attachment The context will be read after the Job execution.
-This context must point to afile,
-Thefile content will be read by the service engine and attached to the response,
-The context name will be used as the attachment name,
-Thefile will be deleted by the service engine right after its content was loaded.
Parameter and Out-| A mix between the Par ameter and the Out-Attachment modes.
Attachment
-The context is exposed as a parameter,
-It will also be read after the Job execution,
-Thefile will be deleted anyway,
The advantage of this export mode is to define the output file destination dynamically.
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7. Click OK to validate your choice and close the [Context Export] dialog box.
8. Inthe[Export Jobs] dialog box, click Finish.

Thedialog box closes. A progressindicator displaysto show the progress percentage of the export operation.
The Job is exported in the selected archive.

The Talend Job is now exposed as a service into petals ESB and can be executed inside the bus.

4.2.2.6. How to export a Job as an OSGI Bundle For ESB

Inthe [Export Jobs] dialog box, you can change the type of export in order to export the Job selection asan OSGI
Bundle in order to deploy your Job in Talend ESB Container.

% Export Jobs |:|@@

(i I"' o
s
To archive file: | Di\TESE_SE-All-r63038-¥4.2,2NBtjob_0.1 jar v || eromse.. |
Job Wersion
-: Select the job wersion
Expork Eype
Seleck the export bype I:I:I'E-GI Bundle For ESE
Options
-
@J Finish l [ Cancel

1. IntheExport type area, select OSGI Bundle For ESB to export your Job as an OSGI Bundle.

The extension of your export automatically changeto .jar asitiswhat Talend ESB Container is expecting.
2. Click the Browse... button to specify the folder in which exporting your Job.
3. Click Finish to export it.

4.2.3. How to export items

Y ou can export multiple items from the repository onto adirectory or an archivefile.

To do so:
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1. IntheRepository tree view, select the items you want to export.

2. Toselect severd items at atime, pressthe Ctrl key and select the relevant items.

; *Repository 2 = | b.;';.(h v = 0]
LOCAL: ProjectName '
4 4 Job Designs
P Ten
I Conte
s Code
. L] sQLT
& Recys

Open job

Read job

Open another version
Open Job Hierarchy
Setup routine dependencies
Edit properties
Detect dependencies
Delete

Copy

Duplicate

Run job

Export Job

EEPREGEeIe & Ie

Export iterns

Li

3. Right-click while maintaining the Ctrl key down and select Export items on the pop-up menu:

#* Export items |:I®

Expart items to an archive file or directary, I E /15 l

(¥) Select root directory: | Cuivork, Files\Exports | [Bruwse... ]

() Select archive File: | | Browse, .,

Expart Dependencies

Select the items ko export:

| kvpe Filker bexk |

(] 13 Contexts A0 Select Al
=-[m] |5 Code
=-[E]t83 Routines Deselect Al

[15 system
[#]&=3 DemoRoutines 0,1 .
[«]=3 GetRandomPhonerum 0,1 Collapse all
H-T1LT snl Temnlates

Expand All

Cancel

@ Finish |
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Y ou can select additional items on the tree for exportation if required.

4. Click Browseto browse to where you want to store the exported items. Alternatively, define the archivefile
where to compress the filesfor all selected items.

Select the Export Dependencies check box if you want to set and export routine dependencies along with Jobs you

" are exporting. By default, al of the user routines are selected. For further information about routines, see section What
areroutines.

5. Click Finish to close the dialog box and export the items.

4.2.4. How to change context parameters in Jobs

Asexplained in section How to export Jobs, you can edit the context parameters:

If you want to change the context selection, simply edit the .bat/.sh file and change the following setting: - -
cont ext =Pr od to the relevant context.

If you want to change individual parameters in the context selection, edit the .bat/.sh file and add the following
setting according to your need:

Operation Setting

To change valuel for parameter keyl --cont ext _param keyl=val uel

To change valuel and value2 for respective|--context_param keyl=val uel - - cont ext _param key2=val ue2
parameters keyl and key2

To change a value containing space characters|- - cont ext _param keyl="path to file”
such asin afile path

4.3. Managing repository items

Talend Open Studio for Big Data enables you to edit the items centralized in the repository and to update the Jobs
that use these items accordingly.

4.3.1. How to handle updates in repository items

Y ou can update the context parametersthat are centralized in the Repository tree view any timein order to update
the context group details, for example.

When you modify any of the parameters of an entry inthe Repository treeview, al Jobs using thisrepository entry
will be impacted by the modification. This is why the system will prompt you to propagate these modifications
to all the Jobs that use the repository entry.

The following sections explain how to modify the parameters of a repository entry and how to propagate the
modifications to all or some of the Jobs that use the entry in question.

4.3.1.1. How to modify a repository item

To update the parameters of arepository item, a context for example, complete the following:

Talend Open Studio for Big Data User Guide 139



How to handle updatesin repository items

Expand the Contexts node in the Repository tree view and browse to the relevant entry that you need to
update.

Right-click this entry and select the corresponding edit option in the contextual menu.
A respective wizard displays where you can edit each of the definition steps for the entry parameters.

When updating the entry parameters, you need to propagate the changes throughout numerous Jobs or all
your Jobs that use this entry.

A prompt message pops up automatically at the end of your update/modification process when you click the
Finish button in the wizard.

# Modification x|

Lo wou want to propagate the modifications to all jobs? It can take some
\__-J_/ Lirne,

Yes l [ Mo

Click Yesto close the message and implement the changes throughout all Jobs impacted by these changes.
For moreinformation about thefirst way of propagating all your changes, see section How to update impacted
Jobs automatically.

Click Noif you want to close the message without propagating the changes. Thiswill allow you to propagate
your changes on the impacted Jobs manually on one by one basis. For more information on another way of
propagating changes, see section How to update impacted Jobs manually.

4.3.1.2. How to update impacted Jobs automatically

After you update the parameters of any item aready centralized in the Repository tree view and used in different
Jobs, amessage will prompt you to propagate the modifications you did to all Jobs that use these parameters.

To update impacted Jobs, compl ete the following:

1. Inthe[Modification] dialog box, click Yesto let the system scan your Repository tree view for the Jobs
that get impacted by the changes you just made. This aims to automatically propagate the update throughout
all your Jobs (open or not) in one click.

The [Update Detection] dialog box displaysto list all Jobs impacted by the parameters that are modified.
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Update Detection

The properties used in the Following items have been modified.
Choose and update what wou have checked,

(*1 1 This job is not opened.

Items Ciperations
= 1 Job tExkractxMLField_prelim 0.1 (%) -
= [w]<3 tMysqloukput_1 -
ﬂ‘l Properky Ipdate From repository
= [ ety Job tExtractXMLField 0.1 (%) -
= [ ]I8 "customerdetails” (tysgllnput_1% -
F ﬁ‘l Property Idpdate From repository

Remarks

DB (MYSOL): Localhost

DE (MYSQLLocalhost

Expand All l [ Collapse all ] [Deselect all ]

[ Ok H Cancel ]

Y ou can open the [Update Detection] dialog box any time if you right-click the item centralized in the Repository
" tree view and select Manage Dependencies from the contextual menu. For more information, see section How to

update impacted Jobs manually.

If needed, clear the check boxesthat correspond to the Jobs you do not wish to update. Y ou can update them
any time later through the Detect Dependencies menu. For more information, see section How to update

impacted Jobs manually.

Click OK to close the dialog box and update all selected Jobs.

4.3.1.3. How to update impacted Jobs manually

Before propagating changes in the parameters of an item centralized in the tree view throughout the Jobs using
this entry, you might want to view all Jobs that are impacted by the changes. To do that, complete the following:

1

2.

In the Repository tree view, expand the node holding the entry you want to check what Jobs useiit.

Right-click the entry and select Detect Dependencies.

A progress bar indicates the process of checking for all Jobs that use the modified context parameter. Then

adialog box displaysto list al Jobs that use the modified item.
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Update Detection

The properties used in the Following items have been modified.
Choose and update what wou have checked,

(*1 1 This job is not opened.

Items Ciperations Remarks
= ’Eh Job tExkracteMLField_prelim 0.1 (%) - -
= [w]<3 tMysqloukput_1 - -
ﬁ'l Properky Ipdate From repository DB (MYSOL): Localhost
=[] Job tExtractMLField 0.1 (*) - -
= E "customerdetails" (tMysgllnput_1) - -

ﬁ'l Property Idpdate From repository DE (MYSQLLocalhost
Expand All l [ Collapse all ] [ Deselect Al ]
[ CK, ] [ Zancel ]

3. Select the check boxes corresponding to the Jobs you want to update with the context parameter and clear
those corresponding to the Jobs you do not want to update.

4. Click OK to validate and close the dialog box.

The Jobs that you choose not to update will be switched back to Built-in, asthelink to the Repository cannot be maintained.
i It will thus keep their setting as it was before the change.

4.4. Searching a Job in the repository

If you want to open a specific Job in the Repository tree view of the current Talend Open Sudio for Big Data and

you can not find it for one reason or another, you can simply click i . on the quick access toolbar.

Tofind aJob in the Repository tree view, complete the following:

On Talend Open Studio for Big Data toolbar, click EH: to open the [Find a Job] dialog box that lists

automatically al the Jobs you created in the current Studio.
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2.

# Find a Job

Type job name prefix or pattern (%, ¥

D JobswithProblem

00y 311

00 v 311 _MPx

00y 3zt

4 bigFile 0.1

]jaj Call_Mvebservice_In_Job_ 0.1
]jE‘E Copy_of _MPX_Aggreqgate 0.1
UE‘E current 0,1

UEE data_lineage 0.1

UE‘E expark_job 0.1

UE‘E expart_jobZ 0.1

leE expart_job3 0.1

ﬂaj expart_job4 0.1

]jaﬁ expart_jobS 0.1

]jaj Impactanalysis_Datalineage 0.1
i best_Jobont

58 tRunJob_child 0.1

[Link Repu:usitu:urw;.-'] [ Ok ] [ Cancel

Enter the Job name or part of the Job nhame in the upper field.

When you start typing your text in the field, the Job list is updated automatically to display only the Job(s)
which name(s) match(es) the letters you typed in.

# Find a Job

Type job name prefix or pattern {*, ¥

'l |

= v_311_Mp

ﬂ% mpx 0.1

UEE MP¥_fggregate 0.1

o MPR_Sort 0.1
H-0y 3

[Link Rep-:nsit-:ury] [ Ok, ] [ Cancel

Select the desired Job from the list and click Link Repository to automatically browse to the selected Job
in the Repository tree view.

If needed, click Cancel to close the dialog box and then right-click the selected Job in the Repository tree
view to perform any of the available operations in the contextual menu.
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Otherwise, click OK to close the dialog box and open the selected Job on the design workspace.
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Chapter 5. Mapping data flows

The most common way to handle multiple input and output flows including transformations and data re-routing
isto use the dedicated mapping components: tMap and tXM LM ap.

This chapter gives details separately about the usage principles of these two components, for further information
or scenario and use cases, see Talend Open Sudio for Big Data Components Reference Guide.

Before starting any data integration processes, you need to be familiar with Talend Open Sudio for Big Data
Graphical User Interface (GUI). For more information, see appendix GUI.
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tMap and tXMLMap interfaces

5.1. tMap and tXMLMap interfaces

tMap and tXMLMap are advanced components which require more detailed explanation than other Talend
components. The Map Editor is an “all-in-one” tool alowing you to define all parameters needed to map,
transform and route your data flows via a convenient graphical interface.

Y ou can minimize and restore the Map Editor and all tablesin the Map Editor using the window icons.

E 8 var <% g ¥ JL 0 L0 Auko map!
s ~

cars_data & G o] Defined_data & o
Column Expression Column

4 ID_Owiner cars_data. ID_Ow... Qg, D Q...

Reqistration cars_data.Reqistr. ., Reqisk...
Iake cars_data.Make Make
Color cars_data, Color Colar

ID_Reseller cars_data.ID_Re.., ID_Re...
owners_data, Mame Mame

owners_data ID_.., I0_In...

owners_data _0 | &

Property Yalue Rejected_data _0 & e
Lookup Model Load once

Makch Model Unique ratch sl Column
Join Model Inner Join cars_data.ID_Ow... Do
Store temp d...  False cars_data.Registr. ., Regist, ..
Schema Type Bulit-In cars_data ID_Re... I Re...
owners_data. Mame Marne
Expr. key Calurnn
B, cars_datadn... C% ID_0...
Mame 7 Rejected_InnerJloin _0 3 v
Schema editor ~_Expression editor
cars_data Defined_data
Calurnn Key | T.. Wl M. D L., P D..| ™ Calurin Kevw | T.. W] M. D L.. P. D 1
o.. [] L. 2 0 Gl m_.. L. 2 0
re.. [ 5. 7 0 Re.. [ 5. 70
Make [ 5. & 0 Z Make [ 5. & 0 Z
< b ] < b ]
[ apply ] [ Ok ] [ Cancel

This figure presents the interface of tMap. That of tXMLM ap differs slightly in appearance. For example, in addition to
i the Schema editor and the Expr ession editor tabs on the lower part of thisinterface, tXMLMap hasathirdtab called Tree
schema editor. For further information about tXM LM ap, see section tXMLMap operation.

The Map Editor is made of several panels;

» Thelnput panel isthetop left panel on the editor. It offers agraphical representation of all (main and lookup)
incoming data flows. The data are gathered in various columns of input tables. Note that the table name reflects
the main or lookup row from the Job design on the design workspace.

e TheVariablepand isthecentral panel inthe Map Editor. It allowsthe centralization of redundant information
through the mapping to variable and alows you to carry out transformations.

* The Output pand isthe top right panel on the editor. It allows mapping data and fields from Input tables and
Variables to the appropriate Output rows.

 Both bottom panels are the Input and Output schemas description. The Schema editor tab offersaschemaview
of al columns of input and output tables in selection in their respective panel.
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tMap operation

» Expression editor is the edition tool for all expression keys of Input/Output data, variable expressions or
filtering conditions.

The name of input/output tables in the Map Editor reflects the name of the incoming and outgoing flows (row
connections).

The following sections present separately tMap and tXMLM ap.

5.2. tMap operation

tMap alows the following types of operations:
* data multiplexing and demultiplexing,

* datatransformation on any type of fields,

fields concatenation and interchange,

field filtering using constraints,
» dataregjecting.

Asall these operations of transformation and/or routing are carried out by tM ap, this component cannot be a start
or end component in the Job design.

OMAINEFS. ' ' ' ' ' ' '
% . n

l:uwners_daE'a (Lookup)

" Defined iMain order:1)

% cars_daka (Main) =E q Rejecked_data (Main curu:ler:Zf@
Cars tMap_1 MotInsured

Fejected_Innerloifriain order: 3]

ND_'Owner'_ID

tMap uses incoming connections to pre-fill input schemas with data in the Map Editor. Therefore, you cannot
create new input schemas directly in the Map Editor. Instead, you need to implement as many Row connections
incoming to tM ap component as required, in order to create as many input schemas as needed.

The sameway, create as many output row connections asrequired. However, you canfill in the output with content
directly in the Map Editor through a convenient graphical editor.

Notethat there can be only one M ain incoming rows. All other incoming rows are of L ookup type. Related topic:
section Row connection.

L ookup rows are incoming connections from secondary (or reference) flows of data. These reference data might
depend directly or indirectly on the primary flow. This dependency relationship is translated with a graphical
mapping and the creation of an expression key.
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Setting the input flow in the Map Editor

The Map Editor requires the connections to be implemented in your Job in order to be able to define the input
and output flows in the Map Editor. You also need to create the actual mapping in your Job in order to display
the Map Editor in the Preview area of the Basic settings view of thetMap component.

Map Editar: D Mapping links display as:  |&uto w
Store on disk,
Temp data directory path: E]
Prewigw ; == T H AR e
Lurk_luta F | A Vel ats &g =
dam warers muem T e wemalorall i
T _
1"., Ardran ER aha
ra bt X o o
'\-_--' netebba 1, Ardem 1I'ey Ardrmn
L no e thied Hhb Hedo
bt —
LR ¥ PO T e
reaners fata e | 3 AR e A [
. e e Nl ' " T. I=arses
1 -un':'“- [ ']
L. Hed T Kupaabed thila py| =
“orm w = daks o L. kn 1
wemn Tore 1 et X Ta e
. . ot thied I'ay Aadem 1'ey Asdeay
= Ll LR ¥ IYIN S L.
Bobar s o Tk L AT meer b R R
L) amear
oy Erjerbad Tnreriain LU |
- - e e- T z

To openthe Map Editor in anew window, double-click thetMap iconin the design workspace or click the three-
dot button next to the Map Editor in the Basic settings view of thetMap component.

The following sections give the information necessary to use the tMap component in any of your Job designs.

5.2.1. Setting the input flow in the Map Editor

The order of the Input tablesis essential. The top table reflects the Main flow connection, and for thisreason, is
given priority for reading and processing through the tMap component.

For this priority reason, you are not allowed to move up or down the Main flow table. This ensures that no Join
can belost.
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Setting the input flow in the Map Editor

&4 B8
Owners = | Q
Colurmn
A ID_Cwirier
Marne
ID_Insurance
Chlidren_Mr
Cwwners, Chiidren_Mr == 2 &g
Cwners, Chlidren_Mr <=6
Cars _9 T Q
Property =
Lookup Madel Load once
Match Model &l matches
Join Maodel Inmer Join
Store kemp data false
schema Tvpe Bulit-In
Expr. key Column
“"l" Owners, ID_Owner ID_Cwner
Reqistration
L W L] Make
Color
o~ I0_Reseller
Resellers _9 e o]
Property Yalue
Lookup Madel Load once
Match Model All matches
Jain Model Inner Jain
Store kemp data false
achema Tvpe Bulit-In
Expr. key Colurmn
“—P‘ Cars,ID_Reseller I0'_Reseller

Mame_Reseler
Address_Res...
Ciby

ZIP

Although you can use the up and down arrowsto interchange L ook up tables order, be awarethat the Joins between
two lookup tables may then belost.

Related topic: section How to use Explicit Join.
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Setting the input flow in the Map Editor

5.2.1.1. How to fill in Input tables with a schema

To fill in the input tables, you need to define either the schemas of the input components connected to the tM ap
component on your design workspace, or the input schemas within the Map Editor.

For more information about setting a component schema, see section How to define component properties.

For more information about setting an input schema in the Map Editor, see section Setting schemas in the Map
Editor.

Main and Lookup table content

The order of the Input tablesis essential.

The Main Row connection determines the M ain flow table content. This input flow is reflected in the first table
of the Map Editor’s Input panel.

The L ookup connections content fills in all other (secondary or subordinate) tables which displays below the
Main flow table. If you have not define the schema of an input component yet, the input table displays as empty
in the Input area.

Thekey isa so retrieved from the schema defined in the Input component. ThisK ey correspondsto the key defined
in the input schemawhere relevant. It has to be distinguished from the hash key that isinternally used in the Map
Editor, which displaysin adifferent color.

Variables

Y ou can use global or context variables or reuse the variable defined in the Variables area. Press Ctrl+Space bar
to access the list of variables. Thislist gathers together global, context and mapping variables.

Thelist of variables changes according to the context and grows along new variable creation. Only valid mappable
variablesin the context show on thelist.

Expr. key Colurmn
@, cars_data.ID_Owners| .. id_owner

.

cars_data.ID_Cwners A || Metadata column 'ID_Owaners' properties
cars_data,Reqistration - Columr:ID_Owners
cars_data.Make - Key ifalse
cars_data, Colar - Type :id_Integer
owrers_data, Chlidren_Me cars_data, ID_Reseller - Length :5
owners_data, Chlidren_Mr - cars, ERROR_MESSAGE - F‘FEEISIDI‘Il :
cars.ME_LINE J Eﬁiﬁrﬁﬁn} |
DataCperation, CHAR. - Bt

a editor _Expression edi DataCperation. DT
Dataioperation. FLx
rs_data DataCperation. $TD b

Docked at the Variablelist, ametadata tip box display to provide information about the selected column.

Related topic: section Mapping variables

5.2.1.2. How to use Explicit Join

In fact, Joins let you select data from a table depending upon the data from another table. In the Map Editor
context, the data of aMain table and of a L ookup table can be bound together on expression keys. In this case,
the order of table does fully make sense.
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Setting the input flow in the Map Editor

Simply drop column names from one table to a subordinate one, to create a Join relationship between the two
tables. Thisway, you can retrieve and process data from multiple inputs.

The join displays graphically as a purple link and creates automatically a key that will be used as a hash key to
speed up the match search.

Y ou can create direct joins between the main table and lookup tables. But you can also create indirect joins from
the main table to alookup table, via another lookup table. This requires adirect join between one of the L ookup
table to the Main one.

Y ou cannot create a Join from a subordinate table towards a superior table in the I nput area.
r

The Expression key field which is filled in with the dragged and dropped data is editable in the input schema,
whereas the column name can only be changed from the Schema editor panel.

You can either insert the dragged data into a new entry or replace the existing entries or else concatenate all
selected datainto one cell.

Cars _9 e r;'
Property Walue
Lookup Model Load once
Match Model &l makches
Join Model Inmer Join
Stare kemp data falze
Schema Tyvpe Bulit-In
Expr. key Column
‘ Owners, ID_Owner ID_Cwiner
Reqistration
Make
Calar
— ID_Reseler
Cars, Make. equals{"BMW"™) ||
Cars, Make, equals"Mercedes")
Resellers _E r i
Property Walue
Lookup Model Load once
Match Model &l makches
Join Model Inmer Join
Stare kemp data falze
Schema Tvpe Bulit-In
Expr. kew Caolurnn
“‘—I& Cars, ID_Reseller ID_Reseller

Mame_Reseller
Address_Reseller
ity

ZIP

For further information about possible types of drag and drops, see section Mapping the Output setting .

If you have a big number of input tables, you can use the minimize/maximize icon to reduce or restore the table sizein the
2 Input area. The Join binding two tables remains visible even though the table is minimized.
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Setting the input flow in the Map Editor

Creating a Join automatically assigns a hash key onto the joined field name. The key symbol displaysin violet on
the input table itself and is removed when the Join between the two tables is removed.

Related topics:
* section Setting schemasin the Map Editor
* section How to use Inner Join

Along with the explicit Join you can select whether you want to filter down to a unique match or if you alow
several matches to be taken into account. In this last case, you can choose to consider only the first or the last
match or all of them.

To define the match model for an explicit Join:
1. Click thetMap settings button at the top of the table to which the Join links to display the table properties.

2. Click inthe Value field corresponding to Match Model and then click the three-dot button that appears to
open the [Options] dialog box.

3. Inthe[Optiong] dialog box, double-click the wanted match model, or select it and click OK to validate the
setting and close the dialog box.

Cars
% Options

Property Yalue

Lookup Model Load once IJnique match
Makch Model Inique makch Lo First match
Join Model Left Cuker Join &l matches
Store kemp data false

schema Tvpe Bulit-In

Expr. ke Zolumn

—p @, Owners I0_Owner .| ID_Ciwiner
Reqistration

Make

Colar

I0_Reseller
Cars.Make . equals("BIMW" || I Ok l [ Cancel
Cars. Make, equals"Mercedes")

Unique Match

This is the default selection when you implement an explicit Join. This means that only the last match from the
L ookup flow will be taken into account and passed on to the outpuit.

The other matches will be then ignored.

First Match

This selection implies that several matches can be expected in the lookup. The First Match selection means that
in the lookup only the first encountered match will be taken into account and passed onto the main output flow.

The other matches will then be ignored.
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Setting the input flow in the Map Editor

All Matches

This selection implies that several matches can be expected in the lookup flow. In this case, all matches are taken
into account and passed on to the main output flow.

5.2.1.3. How to use Inner Join

The Inner join isaparticular type of Join that distinguishes itself by the way the rejection is performed.

This option avoids that null values are passed on to the main output flow. It allows also to pass on the rejected
datato a specific table called Inner Join Reject table.

If the data searched cannot be retrieved through the explicit Join or the filter Join, in other words, the Inner Join
cannot be established for any reason, then the requested data will be rejected to the Output table defined as I nner
Join Reject tableif any.

Simply drop column names from one table to a subordinate one, to create a Join relationship between the two
tables. The Join is displayed graphically as a purple link and creates automatically a key that will be used as a
hash key to speed up the match search.

To define the type of an explicit Join:
1. Click thetMap settings button at the top of the table to which the Join links to display the table properties.

2. ClickintheValuefield corresponding to Join M odel and then click the three-dot button that appears to open
the [Options] dialog box.

3. Inthe [Optiong] dialog box, double-click the wanted Join type, or select it and click OK to validate the
setting and close the dialog box.

Owners F o | B
Colurnn
o~ ID_Cwaner
Marne:
ID_Insurance
Chlidren_rr
Cars LIS -
atl % Options E|
Property Yalue
Loakup Madel Load once
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Setting the input flow in the Map Editor

AnInner Join table should aways be coupled to an Inner Join Reject table. For how to define an output table as an Inner
i Join Reject table, see section Lookup Inner Join rejection.

You can aso use the filter button to decrease the number of rows to be searched and improve the performance
(in Java).

Related topics:
* section Lookup Inner Join rejection

* section How to filter an input flow

5.2.1.4. How to use the All Rows option

By default, without a Join set up, in each input table of the input area of the Map Editor, the All rows match
model option is selected. This All rows option means that all the rows are loaded from the L ookup flow and
searched against the Main flow.

The output corresponds to the Cartesian product of both table (or more tablesif need be).

If you create an explicit or an inner Join between two tables, the All rows option is no longer available. Y ou then have to
a2 select Unique match, First match or All matches. For more information, see section How to use Explicit Join and section
How to use Inner Join.

5.2.1.5. How to filter an input flow

Click the Filter button next to the tMap settings button to add a Filter field.
{4128

Owners & | &

Colurmn
| ID_Cwnier
Marne
ID_Insurance
Chlidren_Mr

Cwners, Chiidren_Nr == 2 ff
Cwwners, Chiidren_Rr <=6 D

In the Filter field, type in the condition to be applied. This allows to reduce the number of rows parsed against
the main flow, enhancing the performance on long and heterogeneous flows.

You can use the Auto-completion tool via the Ctrl+Space bar keystrokes in order to reuse schema columnsin
the condition statement.

5.2.1.6. How to remove input entries from table

To remove input entries, click the red cross sign on the Schema Editor of the selected table. Press Ctrl or Shift
and click fields for multiple selection to be removed.

If you remove Input entries from the Map Editor schema, this removal also occursin your component schema definition.
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Mapping variables

5.2.2. Mapping variables

The Var table (variable table) regroups all mapping variables which are used numerous times in various places.

You can also use the Expression field of the Var table to carry out any transformation you want to, using Java
Code.

Variables help you save processing time and avoid you to retype many times the same data.

¥Yar 5 |

Expression Type Yariable

StringHandling. UPCASE(cars data.Make) Skring varl

There are various possibilities to create variables:

e Type in freely your variables in Java. Enter the strings between quotes or concatenate functions using the
relevant operator.

» Add new lines using the plus sign and remove lines using the red cross sign. And press Ctrl+Spaceto retrieve
existing global and context variables.

» Drop one or more I nput entries to the Var table.

m— &+ &
Dragging 2 entries.,
= Insert all selected entries Type Wariable

» _StringHandling. UPCASE(cars data.Make) string [ ] varl

L3,

4]

Select an entry on the Input area or press Shift key to select multiple entries of one Input table.

Press Ctrl to select either non-appended entries in the same input table or entries from various tables. When
selecting entriesin the second table, notice that thefirst selection displaysin grey. Hold the Ctrl key down to drag
all entriestogether. A tooltip shows you how many entries are in selection.

Then various types of drag-and-drops are possible depending on the action you want to carry out.

To... You need to...

Insert all selected entries as separated variables. Simply drag & drop to the Var table. Arrows show you where the new Var
entry can beinserted. Each Input isinserted in a separate cell.

Concatenate all selected input entries together with an| Drag & drop onto the Var entry which gets highlighted. All entries gets
existing Var entry. concatenated into one cell. Add the required operators using Java operations
signs. The dot concatenates string variables.

Overwrite a Var entry with selected concatenated | Drag & drop onto the relevant Var entry which gets highlighted then press

Input entries. Ctrl and release. All selected entries are concatenated and overwrite the
highlighted Var.

Concatenate selected input entries with highlighted| Drag & drop onto an existing Var then press Shift when browsing over the

Var entries and create new Var linesif needed chosen Var entries. First entries get concatenated with the highlighted Var

entries. And if necessary new lines get created to hold remaining entries.

5.2.2.1. How to access global or context variables

Press Ctrl+Space to access the global and context variable list.
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Using the expression editor

Appended to the variable list, a metadata list provides information about the selected column.

5.2.2.2. How to remove variables

To remove aselected Var entry, click the red cross sign. This removes the whole line as well as the link.

Press Ctrl or Shift and click fields for multiple selection then click the red cross sign.

5.2.3. Using the expression editor

All expressions (Input, Var or Output) and constraint statements can be viewed and edited from the expression
editor. This editor provides visual comfort to write any function or transformation in a handy dedicated view.

5.2.3.1. How to access the expression editor

Y ou can write the expressions necessary for the datatransformation directly in the Expr ession editor view located
in the lower half of the expression editor, or you can open the [Expression Builder] dialog box where you can
write the data transformation expressions.

To open the Expression editor view, complete the following:
1. Double-click thetMap component in your job design to open the Map Editor.
2. Inthelower half of the editor, click the Expression editor tab to open the corresponding view.

To edit an expression, select it in the I nput panel and then click the Expression editor tab and modify the expression
@ as required.

Q}Q ¥Yar HPE«@@GQ

cars_data 2] s - Expression Type Yariable

' cars_data.Make bolpperCased) .. | String [ ] varl

Colurmn
ID_Cwners
Registration
Make
Colar
ID_Reseller

Schema editor | Expression editor

cars_data.Make.tollpperCase)

3. Enter the Java code according to your needs. The corresponding expression in the output panel is
synchronized.

Refer to the Java documentation for more information regarding functions and operations.
-z

To open the [Expression Builder] dialog box, click the three-dot button next to the expression you want to open
inthe Var or Output panel of the Map Editor.

156 Talend Open Studio for Big Data User Guide



Using the expression editor

5 X L1 Adomap! | [7] Die or

namesAndstates L}b ..' |

Expression Colurmn

Lﬁ Mame
rowz, Skate Skates

The[Expression Builder] dialog box opens on the selected expression.

# Expression Builder [z|
Expression Tesk
Wrap [Undo(CtrI + 7 ] [Clear ]
StringHandling.EREPLACE (rowl.name, " " " ') var Value A Chuck_Marris

rowd id nll

rowl.name  Chuck Morris
rowl.add... null

HUHY B o —

Categories Functions Help

gl ~ | [ALPHA ~

;g::ég:m;dn 1 EIT-ETGE — ||| Substitutes an element of a
Mathermnatical COUNT ||| string with a replacement
Relatiol DOUOTE element

v E—

@ I Ok H Cancel

For a use case showing the usage of the expression editor, see the following section.

5.2.3.2. How to write code using the Expression Builder

Some Jobsrequire pieces of codeto bewritten in order to provide componentswith parameters. In the Component
view of some components, an Expression Builder interface can help you build these pieces of code (in Java).

The following example shows the use of Expression Builder in atMap component.
tFileInputDelimited_1

rowE (Lookup)

¥

. rowl {Main) =Eq namesandstates (Main) =E@|

tMysglInput_ 1 ' tMap_1 tLogRow 1
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Two input flows are connected to the tMap component.

» From the DB input, comes alist of names made of afirst name and alast name separated by a space char.

» Fromthe File input, comes alist of US states, in lower case.

InthetMap, use the expression builder to: First, replace the blank char separating the first and last names with an
underscore char, and second, change the states from lower case to upper case.

1. InthetMap, set the relevant inner join to set the reference mapping. For more information regarding tM ap,
see section tMap operation and section tMap and tXMLMap interfaces.

2. Fromthemain (rowl) input, drop the Names column to the output area, and the Sate column from the lookup
(row2) input towards the same output area.

3. Thenclick inthefirst Expression field (rowl.Name) to display the three-dot button.

¥ L1 Auto map! | [7] Die ar
namesAndstates __;;" ..'. i
Expression Column
oWl name LL\\%S WE =
rowZ, Skate Stakes
The [Expression Builder] dialog box opens up.
% Expression Builder fgl
Expression Test
[+] wirap [Undo(CtrI + Z) ] [Clear l
StringHandling.EREFLACE (rowl.name, " ", " ") War Value ~ Chuck_Mortis
rowd,id ridll
rowl name  Chuck Morris
rowl. add... null
rowl.date  null
HUMEY (EHEEEER ) L2 >
Cateqaries Functions Help
g A | [ALPHA ~
*ser Defined —(||BTRIM F . : ~
DataOperation CHANGE = Sulbsntultes an element of 2
Mathematical COUMT string with a replacement
Murneric — | | DWW MCASE
Relational DOUOTE clement.
StringHanding v MY
@j [ Ok l [ Cancel

4. IntheCategory area, select the rel evant action you want to perform. Inthisexample, select St ri ngHandl i ng
and select the EREPLACE function.

5. In the Expression area, paste rowl.Name in place of the text expression, in order to get:
StringHandl i ng. EREPLACE(rowl. Nane, " ", " _"). Thisexpression will replace the separating space char
with an underscore char in the char string given.

6. Now check that the output is correct, by typing in the relevant Value field of the Test area, adummy value,
e.g: Chuck Norris and clicking Test!. The correct change should be carried out, for example, Chuck Norris.
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7. Click OK to validate the changes, and then proceed with the same operation for the second column (State).

8. InthetMap output, select the row2.Sate Expression and click the[...] button to open the Expression builder
again.

% Expression Builder E]

Expression Test
[Undo(CtrI+Z)] [Clear]
StringHandling.UPCASE (row2.State] Yar Walug A (INDLAMNA
rowz, Skate indiana
rowz, Capikal rdll =
rowZz, MostPopul...  null ¥
g (=== < &

Categary Functions Help

Mathematical A || CHAMGE A

gzlt:t%?jzrlation 1 Converts all lowercase letters
TalendDate DOLUOTE in an expression to

Mumetic __||EREPLACE uppercase.

Talendstrin LEFT
mmh_ ||| RIGHT

(£

I Ok H Cancel ]

This time, the StringHandling function to be used is UPCASE. The complete expression says:
Stri ngHandl i ng. UPCASE(r ow2. St ate) .

9. Once again, check that the expression syntax is correct using adummy Valuein the Test area, for example
indiana. The Test! result should display INDIANA for this example. Then, click OK to validate the changes.

Both expressions are now displayed in thetMap Expression field.

= X L1 auka map!

namesAndStates

Expression

These changes will be carried out along the flow processing. The output of this example is as shown below.
Starermy robh YamssdndsSeates 36 88 T B SRS

tLogRow_1
Hame | BandomStates
William_Grant IOWa
William_Hoower HEW YORE
Grover_Lincoln HORTH DAKOTA
Lyndon_ Jefferson QHIO
Gerald_Haves WASHIHGTOH
Benjamin_Grant HATHE
George_Fierce COHHNECTICUT
Jimny_HFeagan ALASEA
Hartin Haves WASHINGTON
Franklin_ Jefferson |IOWA
Andrew_Hi=on HEW HAMPSHIEE
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5.2.4. Mapping the Output setting

On the design workspace, the creation of a Row connection from the tMap component to the output components
adds Output schematablesin the Map Editor.

Y ou can also add an Output schemain your Map Editor, using the plus sign from the tool bar of the Output area.

You have as well the possibility to create a join between your output tables. The join on the tables enables you
to process several flows separately and unite them in a single output. For more information about the output join
tables feature, see Talend Open Studio for Big Data Components Reference Guide.

Thejoin table retrieves the schema of the source table.
r

When you click the [+] button to add an output schema or to make a join between your output tables, a dialog
box opens. Y ou have then two options.

# Add a output §|

O Mew oukpuk

(¥ Create join table From | Cut % | Mamed | outl

(4 ] [ Cancel
Select... To...
New output Add an independent table.
Createjoin tablefrom Create ajoin between output tables. In order to do so, select in the drop down
list the table from which you want to create the join. In the Named field, type
in the name of the table to be created.

Unlike the Input area, the order of output schema tables does not make such a difference, as there is no
subordination relationship between outputs (of Join type).

Once all connections, hence output schema tables, are created, you can select and organize the output data via
drag & drops.

Y ou can drop one or several entries from the Input area straight to the relevant output table.
Press Ctrl or Shift, and click entries to carry out multiple selection.

Or you can drag expressions from the Var area and drop them to fill in the output schemas with the appropriate
reusable data.

Note that if you make any change to the Input column in the Schema Editor, a dialog prompts you to decide to
propagate the changes throughout all Input/V ariable/Output table entries, where concerned.

Action Result

Drag & Drop onto existing expressions. Concatenates the selected expression with the existing expressions.

Drag & Drop to insertion line. Inserts one or several new entries at start or end of table or between two
existing lines.

Drag & Drop + Ctrl. Replaces highlighted expression with selected expression.

Drag & Drop + Shift. Adds the selected fields to all highlighted expressions. Inserts new lines if
needed.

Drag & Drop + Ctrl + Shift. Replaces all highlighted expressions with selected fields. Inserts new linesif
needed.
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Y ou can add filters and rejections to customize your outputs.

5.2.4.1. Building complex expressions

If you have complex expressions to build, or advanced changes to be carried out on the output flow, then the
Expression Builder interface can help in this task.

Click the Expression field of your input or output table to display the[...] button. Then click thisthree-dot button
to open the Expression Builder.

For more information regarding the Expression Builder, see section How to write code using the Expression
Builder.

5.2.4.2. Filters

Filters allow you to make a sel ection among the input fields, and send only the selected fields to various outputs.

Click the[+] button at the top of the table to add afilter line.

L
“aliiran %

Activatefunactivate expression Filter|

L= LB L= = L =

£

You can enter freely your filter statements using Java operators and functions.

Drop expressions from the I nput area or from the Var areato the Filter row entry of the relevant Output table.

owners_data _n re i Insured # s 0
Expr. kew Calumn owners_data.id_insurance 1= null
* cars_data, ID_Cwners id_owner B
narne Expression Calumn
id_insurance cars_data,ID_Owners ID_whers
hlidren_r cars_data,Regiskration R.egistration

An orange link isthen created. Add the required Java operator to finalize your filter formula.

You can create various filters on different lines. The AND operator is the logical conjunction of al stated filters.

5.2.4.3. Output rejection

Reject options define the nature of an output table.

It groups data which do not satisfy one or more filters defined in the standard output tables. Note that as standard
output tables, are meant all non-reject tables.

This way, data rejected from other output tables, are gathered in one or more dedicated tables, allowing you to
spot any error or unpredicted case.
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The Reject principle concatenates all non Reject tables filters and defines them as an EL SE statement.
To define an output table as the Else part of the regular tables:
1. Click thetMap settings button at the top of the output table to display the table properties.

2. Click inthe Valuefield corresponding to Catch output re ect and then click the [...] button that appearsto
display the [Options] dialog box.

3. Inthe [Options] dialog box, double-click true, or select it and click OK to validate the setting and close
the dialog box.

Ldr>_Udid., Ll BESENET 1R EsEnsT
R Options g] owners_data. Mame Mame

owners_data. ID_Insurance ID_Insurance
false -

Rejected_data & | G i
Property Walue b
Catch output reject False [...]
Catch lookup inner join reject false

Schema Tvoe Bulit-In b/
< >
Expression Zalurmn

cars_daka, ID_Owner ID_Owiners
cars_daka,Reqistration Reqistration
cars_daka.ID_Reseller ID_Reseller
owners_data.Mame Marne

] 4 l [ Cancel =

You can define several Reject tables, to offer multiple refined outputs. To differentiate various Reject outputs,
add filter lines, by clicking on the plus arrow button.

Once atable is defined as Reject, the verification process will be first enforced on regular tables before taking in
consideration possible constraints of the Reject tables.

Note that dataare not exclusively processed to one output. Although a data satisfied one constraint, henceisrouted

to the corresponding output, this data still gets checked against the other constraints and can be routed to other
outputs.

5.2.4.4. Lookup Inner Join rejection

The Inner Join is a Lookup Join. The Inner Join Reject table is a particular type of Rejection output. It gathers
rejected data from the main row table after an Inner Join could not be established.

To define an Output flow as container for rejected Inner Join data, create a new output component on your Job
that you connect to the Map Editor. Then in the Map Editor, follow the steps below:

1. Click thetMap settings button at the top of the output table to display the table properties.

2. ClickintheValuefield corresponding to Catch lookup inner join reject and then click the[...] button that
appears to display the [Options] dialog box.

3. Inthe [Options] dialog box, double-click true, or select it and click OK to validate the setting and close
the dialog box.
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[ % Expression Zolumn
% Options El cars_data,ID_Cwner ID_wners

cars_data.Registration Reqistration
cars_daka,ID_Reseler ID_Reseller
) False owners_daka,Mame MName
3 Rejected_InnerJoin | :|_.' i
Property Yalue *'\
Catch output reject false
Catch lookup inner join reject  False
schema Tvoe Eulit-In b
< »
Expression olurmn
cars_data,ID_Cwner ID_Cwners
oK ] [ Cancel cars_data.Registration Reqistration

5.2.4.5. Removing Output entries

To remove Output entries, click the cross sign on the Schema Editor of the selected table.

5.2.4.6. Handling errors

The Die on error option prevent error to be processed. To do so, it stops the Job execution as soon as an error is
encountered. The tMap component provides this option to prevent processing erroneous data. The Die on error
option is activated by default in tMap.

Deactivating the Die on error option will allow you to skip the rows on error and complete the process for error-
free rows on one hand, and to retrieve the rows on error and manage them if needed.

To desactivate the Die on error option:
1. Double-click thetMap component on the design workspace to open the Map Editor.
2. Click the Property Settings button at the top of the input areato display the [Property Settings] dialog box.

3. In[Property Settings] dialog box, clear the Die on error check box and click OK.
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=y

H Yar

C Store on disk

row?

Prop
Liook)
[akc
Join
Stores
ache

Expr

W % Property Settings

id Temp data directory path: | | [Brawse... ]

R Max buffer size(nb of rows): |2|:|D|:||:|E||:| | *

[ O, H Cancel ]

A new table called ErrorReject appears in the output area of the Map Editor. This output table automatically
comprises two columns: error M essage and error Stack Trace, retrieving the message and stack trace of the error
encountered during the Job execution. Errors can be unparseable dates, null pointer exceptions, conversion issues,

etc.

Y ou can aso drag and drop columns from the input tables to this error reject output table. Those erroneous data
can be retrieved with the corresponding error messages and thus be corrected afterward.

rowl L}b ..'
Colurnn

id
Zusktameriame
Customeraddress
idskate
idz
RegTime
ReqisterTime

.D ErrorReject Q
Expressian Colurmn
efrorMess. ..
erroratack. ..

Once the error reject table is set, its corresponding flow can be sent to an output component.
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tFileInput Defimited_3

rDWE{@DDkup}
=
3 ; rowl (Main) =E ;{i MarmeandCity (Main order:2) =3
tFileInputDelimited_2 ' ' ' tMap_1 : ' ' " EMysgloutput 1

tLogRow 1

To do so, on the design workspace, right-click the tM ap component, select Row > Error Reject in the menu, and
click the corresponding output component, here tL ogRow.

When you execute the Job, errors are retrieved by the Error Reject flow.
Starfing ol fie an arrar g8 15030 S1o8ReS8LE

java.text ParseException: Unparseable date: "08 01
1980" | jawva. lang.FuntineEzception:
java . text ParseEzception: Unparseable date: "08 01 1980°
at routines. TalendDate. parselate({TalendDate. java:503)
at
doc . die_on_error_0_1.Die _on _error.tFilelnputDelimnited_2Pro
ces=(Die_on_error . jawa:1409)
at
doc . die_on_error_0_1.Die_on_error. runJobInTOS{Die _on_error.
java:2262)
at
doc . die_on_error_0_1.Die_on_error main({lDie_on_error.java:l
1600
Cau=ed by: java.text. ParseEzception: Unparseable date: "08
o1 19a0”
at jawva.text DateFormat . parse(nknown Source)
at routines. TalendDate. parselate({TalendDate. java:501)

... 3 more
[1]08 01 1980
Joabh e on s anded g 1505 GLoRReRRIE farr b oods=07

The result contains the error message, its stack trace, and the two columns, id and date, dragged and dropped to
the Error Reject table, separated by apipe “|".

5.2.5. Setting schemas in the Map Editor

Inthe M ap Editor, you can define the type of atable schemaas Built-In so that you can modify the data structure
in the Schema editor panel.

5.2.5.1. Using the Schema Editor

The Schema Editor details al fields of the selected table. With the schema type of the table set to Built-In, you
can modify the schema of the table.
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Schema editor . Expression editor

owners_daka

Colurmn key  Type | Length Precision = Mullable | Comment
Gl ID_Owner int z 0
i O
Marne [] s=tring & 0
ID_Insurance [] s=tring 7 0

Use the tool bar below the schematable, to add, move or remove columns from the schema

Y ou can a'so load a schema from the repository or export it into afile.

Metadata Description

Column Column name as defined on the Map Editor schemas and on the Input or Output component
schemas.

Key The Key shows if the expression key data should be used to retrieve data through the Join link. If
unchecked, the Join relation is disabled.

Type Type of data: String, Integer, Date, etc.

This column should always be defined in a Java version.
&

Length -1 shows that no length value has been defined in the schema.
Precision Defines the number of digits to the right of the decimal point.
Nullable Clear this check box if the field value should not be null.
Default Shows any default value that may be defined for thisfield.
Comment Free text field. Enter any useful comment.

Input metadata and output metadata are independent from each other. Y ou can, for instance, change the label of a column
i on the output side without the column label of the input schema being changed.

However, any change made to the metadata are immediately reflected in the corresponding schema on the tMap
relevant (Input or Output) area, but also on the schema defined for the component itself on the design workspace.

A Red colored background showsthat an invalid character has been entered. Most special charactersare prohibited
in order for the Job to be ableto interpret and use the text entered in the code. Authorized charactersinclude lower-
case, upper-case, figures except as start character.

5.2.6. Solving memory limitation issues in tMap use

When handling large data sources, including for example, numerous columns, large number of lines or of column
types, your system might encounter memory shortage issues that prevent your Job, to complete properly, in
particular when using atMap component for your transformation.

A feature has been added (in Javaonly for the time being) to the tM ap component, in order to reduce the memory
in use for lookup loading. In fact, rather than storing the temporary data in the system memory and thus possibly
reaching the memory limitation, the Store temp data option allows you to choose to store the temporary data
onto adirectory of your disk instead.

This feature comes as an option to be selected in the Lookup table of the input datain the Map Editor.
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To enable the Storetemp data option:
1. Double-click thetMap component in your Job to launch the Map Editor.

2. Ininput area, click the Lookup table describing the temporary data you want to be |oaded onto the disk rather
than in the memory.

3. Click thetMap settings button to display the table properties.

4. Click in the Value field corresponding to Store temp data, and then click the [...] button to display the
[Options] dialog box.

5. Inthe[Options] dialog box, double-click true, or select it and click OK, to enable the option and close the
dialog box.

Owners_data | . ;|_.'. i # Options g'
Property Valle
Loakup Madel Load once
Match Model IJnique match
Join Model Left Cuker Join
Store bermp data False L]
Schema Tyvpe Bulit-In
Expr. kew Calumn
“-}* Cars_data,ID_Cwwner % id
Zuskamerame
Customerad. ..
idSkate
a2 Ok ] [ Cancel
ReqTime

ReqisterTime -
For thisoption to befully activated, you also need to specify the directory on the disk, where the datawill be stored,
and the buffer size, namely the number of rows of dataeach temporary filewill contain. Y ou can set the temporary
storage directory and the buffer size either in the Map Editor or in the tMap component property settings.
To set the temporary storage directory and the buffer sizein the Map Editor:
1. Click the Property Settings button at the top of the input areato display the [Property Settings] dialog box.

2. In[Property Settings] dialog box, fill the Temp data directory path field with the full path to the directory
where the temporary data should be stored.

3. Inthe Max buffer size (nr of rows) field, specify the maximum number of rows each temporary file can
contain. The default value is 2,000,000.

4. Click OK to validate the settings and close the [Property Settings] dialog box.

Talend Open Studio for Big Data User Guide 167



Solving memory limitation issuesin tMap use

Yar

% Property Settings

Die on error
Owing

Expr Store on disk

‘ C Temp data directory path: Dy Temp

Browse, .. |

Max buffer size(nb of rows): | 2000000 5

Rese

Prop
Looky]
Match
Jain
Skore
Sche [

oK. ” Cancel ]

To set the temporary storage directory in the tM ap component property settings without opening the M ap Editor:

1.

Click thetM ap component to select it on the design workspace, and then select the Component tab to show
the Basic settings view.

In the Store on disk area, fill the Temp data directory path field with the full path to the directory where
the temporary data should be stored.

Alternatively, you can use a context variable through the Ctrl+Space bar if you have set the variable in a

Context group in the repository. For more information about contexts, see section How to centralize contexts
and variables.

= properties | Ly Component &2 ) Job Setting | 'L Contexts(] [3_ Problems E-, Modules Eﬂ-‘-‘ scheduler | — B
o =0
BX§ tMap_1 =)=
' o ' e
Basic settings Map Editor: D Mapping links display as: | Auta “
&dvanced setkings Store on disk N
e r=m—r— Temp data directory path: | context.tempFolder E]
Wigw Presvicw § o o
Drocumentation el +
Lol
Hae
Sates
Topbepl U waich =[] T foin g B
Exr. bharp Cakrmn b

At the end of the subjob, the temporary files are cleared.

Thisway, you will limit the use of allocated memory per reference data to be written onto temporary files stored

on the disk.

As writing the main flow onto the disk reguires the data to be sorted, note that the order of the output rows cannot be
guaranteed.

Onthe Advanced settingsview, you can also set abuffer sizeif needed. Simply fill out the field Max buffer size
(nb of rows) in order for the data stored on the disk to be split into as many files as needed.
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5.2.7. Handling Lookups

In order to adapt to the multiple processing types as well as to address performance issues, the tM ap component
supports different lookup loading modes.

e Load once: Default setting. Select this option to load the entire lookup flow before processing the main flow.
Thisisthe preferred option if you have a great number of datafrom your main flow that needs to be requested
in your lookup, or if your reference (or lookup) data comes from afile that can be easily loaded.

» Reload at each row: At each row, the lookup gets loaded again. Thisis mainly interesting in Jobs where the
lookup volume is large, while the main flow is pretty small. Note that this option allows you to use dynamic
variable settings such as where clause, to change/update the lookup flow on the fly as it gets loaded, before
the main flow join is processed. This option could be considered as the counter-part of the Store temp data
option that is available for file lookups.

» Reload at each row (cache): Expressions (in the Lookup table) are assessed and looked up in the cache first.
The results of joins that have already been solved, are stored in the cache, in order to avoid loading the same

resultstwice. Thisoption optimizes the processing time and hel psimprove processing performance of thetM ap
component.

Note that for the time being, you cannot use Reload at each row (cache) and Store temp data at the same time.
2

To set the loading mode of alookup flow:
1. Click thetMap settings button at the top of the lookup table to display the table properties.

2. Click in the Value field corresponding to Lookup Model, and then click the [...] button to display the
[Optiong] dialog box.

3. Inthe[Optiong] dialog box, double-click the wanted loading mode, or select it and then click OK, to validate
the setting and close the dialog box.

Owners_data oL OES Options EI
Property Yalue iLoad once
Lookup Madel Load ance [l Reload at each raw
Match Model IJnique match Reload at each row {cache)
Join Model Inner Join
Store temp data false
Schema Twpe Bulit-In
Expr. ke Column
“"l" Cars_data, ID_Cwner C%. ID_Owiner
Marme
ID_Insurance
Chlidren_Mr
[ ik l [ Cancel
Resellers_data __“ ..' | :

For use cases using these options, seethetM ap section of Talend Open Studio for Big Data Components Reference
Guide.

When your lookup is a database table, the best practise is to open the connection to the database in the beginning of your
2 job design in order to optimize performance. For a use case using this option, seetM ap in Talend Open Sudio for Big Data
Components Reference Guide.
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5.3. tXMLMap operation

Before starting this section, we recommend reading the previoustM ap sectionsfor the basic knowledge of aTalend mapping
2 component.

tXMLMap isfine-tuned to leverage the Document data type for processing XML data, a case of transformation
that often mixes hierarchical data (XML) and flat data together. This Document type carries a complete user-
specific XML flow. In using tXMLMap, you are able to add as many input or output flows as required into a
visual map editor to perform, on these flows, the operations as follows:

* data multiplexing and demultiplexing,

« datatransformation on any type of fields, particularly on the Document type,

» data matching via different models, for example, the Unique match mode (related topic: section How to use
Explicit Join),

» Automated XML tree construction on both of the input and the output sides,
* inner join and left outer join (related topic: section How to use Inner Join)

* lookup between data sources whatever they are flat or XML data using models like L oad once (related topic:
section Handling Lookups),

« fields concatenation and interchange,

« field filtering using constraints,

 dataregjecting.

LiketMap, amap editor is required to configure these operations. To open this map editor, you can double-click
thetXMLMap icon in the design workspace, or aternatively, click the three-dot button next to the Map Editor
in the Basic settings view of the tXM L Map component.

tXMLMap and tMap use the common approaches to accomplish most of these operations. Therefore, the
following sections explain only the particular operations to which tXMLMap is dedicated for processing the
hierarchical XML data.

The operations focusing on hierarchical data are:

« using the Document type to create the XML tree;

* managing the output XML data;

* editing the XML tree schema.

The following sections present more relevant details.

Different fromtMap, tXM L M ap does not provide the Stor etemp data option for storing temporary data onto the directory
2 of your disk. For further information about this option of tMap, see section Solving memory limitation issuesin tMap use.

5.3.1. Using the document type to create the XML tree

The Document data type fits perfectly the conception of defining XML structure as easily as possible. When
you need the XML tree structure to map the input or output flow or both, use this type. Then you can import the
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XML tree structure from various XML sources and edit the tree directly in the mapping editor, thus saving the
manual efforts.

5.3.1.1. How to set up the Document type

The Document data type is one of the data types provided by Talend. This Document type is set up when you
edit the schemafor the corresponding datain the Schema editor . For further information about the schema editor,
see section Using the Schema Editor.

The following figure presents an example in which the input flow, Customer, is set up as the Document type. To
replicate it, in the Map editor, you can simply click the [+] button to add one row on the input side of the Schema
editor, rename it and select Document from the drop-down list of the given data types.

Schema editor _Tree schema editor | Expression editor

Column Kev  Twpe w| M.. DatePattern... Length Precision  Def...  Comm...
Customer [ EENE
short | Short 'y
Skring
Lisk
Crynianmic

In practice for most cases, tXMLMap retrieves the schema of its preceding or succeeding components, for
example, from atFilelnputXML component or in the ESB use case, from atESBProvider Request component.
This avoids many manual efforts to set up the Document type for the XML flow to be processed. However, to
continueto modify the XML structure asthe content of aDocument row, you need still to use the given Map editor.

Be aware that a Document flow carries a user-defined XML tree and is no more than one single field of a schema, which,
2 same as the other schemas, may contain different data types between each field. For further information about how to set
aschema, see section Basic Settings tab.

Once the Document typeis set up for arow of data, in the corresponding data flow table in the map editor, abasic
XML tree structure is created automatically to reflect the details of this structure. This basic structure represents
the minimum element required by avalid XML treein using tXMLM ap:

» Theroot element: it is the minimum element required by an XML tree to be processed and when needs be, the
foundation to develop a sophisticated XML tree.

» Theloop element: it determines the element over which the iteration takes place to read the hierarchical data of
an XML tree. By default, the root element is set as loop element.

main :row3 Q

Calurn

Cuskomer

=I- raoak {loop)

Thisfigure gives an example with the input flow, Customer. Based on this generated XML root tagged asroot by
default, you can develop the XML tree structure of interest.

To do this, you need to:
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1. Import the custom XML tree structure from one of the following types of source:

* XML or XSD files (related topic: section How to import the XML tree structure from XML and XSD files)

When you import an XSD file, you will create the XML structure this XSD file describes.

If needs be, you can develop the XML tree of interest manually using the options provided on the contextual menu.

-z

2. Resettheloop element for the XML tree you are creating, if needs be. Y ou can set as many loops asyou need
to. At this step, you may have to consider the following situation:

« If you haveto create several XML trees, you need to define the loop element for each of them.

If needed, you can continue to modify the imported XML tree using the options provided in the contextual menu.
The following table presents the operations you can perform through the available options.

Options

Operations

Create Sub-element and Create Attribute

Add elements or attributes to develop an XML tree. Related topic: section
How to add a sub-element or an attribute to an XML tree structure

Set a namespace

Add and manage given namespaces on the imported XML tree. Related
topic: section How to manage a namespace

Delete Delete an element or an attribute. Related topic: section How to delete an
element or an attribute from the XML tree structure
Rename Rename an element or an attribute.

Asloop element

Set or reset an element asloop element. Multipleloop elements and optional
loop element are supported.

Asoptional loop

This option is not available unless to the loop element you have defined.

When the corresponding element exists in the source file, an optional loop
element works the same way as a normal loop element; otherwise, it resets
automatically its parent element as loop element or in absence of parent
element in the source file, it takes the element of the higher level until the
root element. But in the real-world practice, with such differences between
the XML tree and the source file structure, we recommend adapting the
XML tree to the source file for better performance.

Asgroup element

Onthe XML treeof theoutput side, set an element asgroup element. Related
topic: section How to group the output data

As aggregate element On the XML tree of the output side, set an element as aggregate element.
Related topic: section How to aggregate the output data
Add Choice Set the Choice element. Then all of its child elements devel oped underneath

will be contained in this declaration. This Choice element originates from
one of the XSD concepts. It enables tXML Map to perform the function of
the XSD Choice element to read or write a Document flow.

When tXMLMap processes a choice el ement, the elements contained in
its declaration will not be outputted unless their mapping expressions are
appropriately defined.

The tXMLMap component declares automatically any Choice
2 element set in the XSD file it imports.

Set as Substitution

Set the Substitution element to specify the element substitutable for agiven
head element defined in the corresponding XSD. The Substitution element
enables tXMLMap to perform the function of the XSD Substitution
element to read or write a Document flow

When tXM LM ap processes a substitution element, the el ements contained
inits declaration will not be outputted unless their mapping expressions are
appropriately defined.

The tXMLMap component declares automaticaly any
2 Substitution element set in the XSD file it imports.
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The following sections present more details about the process of creating the XML tree.

5.3.1.2. How to import the XML tree structure from XML and XSD
files

To import the XML tree structure from an XML file, proceed as follows:
1. Intheinput flow table of interest, right-click the column name to open the contextual menu. In this example,
it is Customer.

main :row3 Q

Column

(Csh=neas
Import From File

=5 Import From Repository

2. From thismenu, select Import From File.

3. In the pop-up diadlog box, browse to the XML file you need to use to provide the XML tree structure of
interest and double-click the file.

To import the XML tree structure from an XSD file, proceed as follows:

1. Intheinput flow table of interest, right-click the column name to open the contextual menu. In this example,
it is Customer.

main :row3 Q

Calumn

Cusharao
Import Fram File

= Impart From Repository

2. From thismenu, select Import From File.

3. Inthepop-up dialog box, browseto the X SD file you need to use to provide the XML tree structure of interest
and double-click thefile.

4. Inthedialog box that appears, select an element from the Root list as the root of your XML tree, and click
OK. Then the XML tree described by the XSD file imported is established.

Ml oustomers b

[ K l [ Cancel ]

Theroot of theimported XML tree is adaptable:

» When importing either an input or an output XML tree structure from an XSD file, you can choose an element as
the root of your XML tree.

¢ Once an XML structure isimported, the root tag is renamed automatically with the name of the XML source. To
change this root name manually, you need use the tree schema editor. For further information about this editor, see
section Editing the XML tree schema.

Talend Open Studio for Big Data User Guide 173



Using the document type to create the XML tree

Then, you need to define the loop element in this XML tree structure. For further information about how to define
aloop element, see section How to set or reset a loop element for an imported XML structure.

5.3.1.3. How to set or reset a loop element for an imported XML
structure

You need to set at least one loop element for each XML treeiif it does not have any. If it does, you may have to
reset the existing loop element when needs be.

Whatever you need to set or reset aloop element, proceed as follows:

1. Inthecreated XML tree structure, right-click the element you need to define as loop. For example, you need
to define the Customer element as loop in the following figure.

main :row3 Q

Calurnn

Custamer

—- custarnes I
Create Sub-Element

=@ Create Akkribute
"""""" l‘ 21 Delete ittty

2. From the pop-up contextual menu, select Asloop element to define the selected element as loop.

Once done, this selected element is marked with the text: loop:true.

=I-Customer (loop :brue)
|

If you close the Map Editor without having set the required loop element for a given XML tree, its root element will be
i set automatically as loop element.

5.3.1.4. How to add a sub-element or an attribute to an XML tree
structure

In the XML tree structure view, you are able to manually add a sub-element or an attribute to the root or to any
of the existing elements when needs be.

To do either of these operations, proceed as follows:

1. Inthe XML tree you need to edit, right-click the element to which you need to add a sub-element or an
attribute underneath and select Create Sub-Element or Create Attribute according to your purpose.
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main :rowl Q

Colurnn

Customer

L|:,\- @RegisterTime

|_l—_|— Mams I

E Create attribute
Delete 0 oo

Az loop element
[=- Address

2. Inthe pop-up [Create New Element] wizard, type in the name you need to use for the added sub-element
or attribute.

¥ Create Hew Element

Input the new element's valid label

| Reg |

Ik l [ Cancel

3. Click OK to validate this creation. The new sub-element or attribute displaysin the XML tree structure you
are editing.

5.3.1.5. How to delete an element or an attribute from the XML
tree structure

From an established XML tree, you may need to delete an element or an attribute. To do this, proceed asfollows:

1. Inthe XML tree you need to edit, right-click the element or the attribute you need to delete.
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main :rowl Q

Colurmn

Cuskormer

- "?:@p:é-ii;{ér'ﬁrﬁé """"""""""""""""""
--------- LL—J—Narnn |-----------------------------
__________ ____l_ Create Sub-Element L

%\' Create Sttribute

Delete

Az loop element

---------- [=I- Address S

2. Inthe pop-up contextual menu, select Delete.

Then the selected element or attribute is deleted, including all of the sub-elements or the attributes attached
to it underneath.

5.3.1.6. How to manage a hamespace

When necessary, you are able to set and edit namespace for each of the element in the a created XML tree of the
input or the output data flow.

Defining a namespace

To do this, proceed as follows:

1. Inthe XML tree of the input or the output data flow you need to edit, right click the element for which you
need to declare a namespace. For example, in a Customer XML tree of the output flow, you need to set a
namespace for the root.
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Cuskomer
|

N T _| B Creake Sub-Element
-7 Create Attribute
[ Set & Mamespace

Az group element

- ZuskomerMarme

[=-idState

2. Inthe pop-up contextual menu, select Set a namespace. Then the [Namespace dialog] wizard displays.

3. Inthiswizard, typein the URI you need to use.

¥ Mamespace dialog

Input new namespace

Input the prefix and value of the namespace

Mamespace | hikkp:| |

] Prefix
@ [ Ok ] [ Cancel

4. If you need to set a prefix for this namespace you are editing, select the Prefix check box in thiswizard and
typein the prefix you need. In this example, we select it and typein xhtml.

* Mamespace dialog E|

Input new namespace

Input the prefix and value of the namespace

Mamespace | http: /e w3, orgf 1999 bkl |
Prefix | xhtml |

@ [ 0.4 ] [ Zancel

5. Click OK to validate this declaration.
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Modifying the default value of a namespace

To do this, proceed as follows:

1. Inthe XML tree that the namespace you need to edit belongs to, right-click this namespace to open the
contextual menu.

= -xminsixhtml  (Defaulk dalie chebne fanae s orgy 1999 =0kl
Set A Fixed Prefix

Delete 4IL|

2. Inthismenu, select Set A Fixed Prefix to open the corresponding wizard.
3. Typeinthe new default value you need in this wizard.

4. Click OK to validate this modification.

Deleting a namespace

To do this, proceed as follows:

1. Inthe XML tree that the namespace you need to edit belongs to, right-click this namespace to open the
contextual menu.

= -xminsixhtml  (Defaulk el chebne tanas s orgy 1999 =0kl
Set & Fixed Prefix

Delete 4|L|

2. Inthismenu, click Delete to validate this deletion

5.3.1.7. How to group the output data

ThetXM LM ap component uses agroup €l ement to group the output data according to agiven grouping condition.
This allows you to wrap elements matching the same condition with this group element.

To set agroup element, two restrictions must be respected:
1. the root node cannot be set as group element;

2. the group element must be the parent of the loop element.

The option of setting group element is not visible until you have set the loop element; this option is also invisible if an
2 element is not allowed to be set as group element.

Once the group element is set, al of its sub-elements except the loop one are used as conditions to group the
output data.

You have to carefully design the XML tree view for the optimized usage of a given group element. For further
information about how to use a group element, see tXMLMap in Talend Open Sudio for Big Data Components
Reference Guide.

tXMLM ap provides group element and aggregate element to classify datain the XML tree structure. When handling arow
i ] of XML data flow, the behavioral difference between them is:

* The group element processes the data always within one single flow.

« The aggregate element splits this flow into separate and complete XML flows.
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Setting a group element

To set agroup element, proceed as follows:

1. Inthe XML tree view on the output side of the Map editor, right-click the element you need to set as group
element.

2. From the opened contextual menu, select As group element.

Then this element of selection becomes the group element. The following figure presents an example of an
XML tree with the group element.

Customer " Q

Expression Colurmn

Customer_States

=I- customers
[ = Customer (group itrug)
row? . LabelState =I- Label5tate
=I- Mame (loop krued
[rowl.Cuskomer: [Customers)Custo.. I_ id
[rowel . Customer: /CustomersiCusta, . == Customerhlarne
l |+

Revoking a defined group element

To revoke a defined group element, proceed as follows:

1. Inthe XML tree view on the output side of the Map editor, right-click the element you have defined as
group element.

2. From the opened contextual menu, select Remove group element.

Then the defined group element is revoked.

5.3.1.8. How to aggregate the output data

With tXMLMap, you can define as many aggregate elements as required in the output XML tree to class the
XML data accordingly. Then this component outputs these classes, each as one complete XML flow.

1. Todefine an element as aggregate el ement, ssimply right-click this element of interest in the XML tree view
on the output side of the Map editor and from the contextual menu, select As aggr egate element.

Then this element becomes the aggregate element. Textsin red are added to it, reading aggregate : true. The
following figure presents an example.
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Customer L Q
Expression Caluran

Cuskomer_States
|

== rook

= Cuskamers

¢ [rowed, U3states: .. %- States (aggregate :brue)
=~ clients (loop tkrue)
b [row3. Customer, .. %— id
b [rows. Customer . ., T_ nare
t [row3. Customer, .. T_ address
[rows. Customer. ., == revenues

dl | 2+

2. Torevokethe definition of the aggregate element, simply right-click the defined aggregate element and from
the contextual menu, select Remove aggr egate element.

To define an element as aggregate element, ensure that this element has no child element and the All in one feature isbeing
2 disabled. The Asaggr egate element optionisnot availablein the contextual menu until both of the conditions are respected.
For further information about the All in one feature, see section How to output elements into one document.

For an example about how to use the aggregate element with tXMLMap, see Talend Open Sudio for Big Data
Components Reference Guide.

tXMLM ap provides group element and aggr egate element to classify datain the XML tree structure. When handling one
¥ row of data ( one complete XML flow), the behavioral difference between themiis:

» Thegroup element processes the data always within one single flow.

» The aggregate element splits this flow into separate and complete XML flows.

5.3.2. Defining the output mode

To definethe output mode of the document-type data, you are defining whether to put al of the XML elementsinto
one single XML flow and when empty element exist, whether to output them. By doing this, you do not change
the structure of the XML tree you have created.

5.3.2.1. How to output elements into one document

Unlessyou are using the aggregate element which always classifies the output el ements and splits an output XML
flow, you are able to determine whether an XML flow is output as one single flow or as separate flows, using the
All in onefeaturein thetXMLMap editor.

To do this, on the output side of the Map editor, proceed as follows:

1. Click the pincer icon to open the map setting panel. The following figure presents an example.
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Customer " Q
Property Yalue

Cakch Qukput Reject False

atch Lookup Inner Join Reject false

Create emphy element

Expression T
Cuskomer_States
I
== customers
1

- customer (loop e
1

[Fowal Cuskomer: fCustomers)iC, ., T_ imid

[row ], Cuskomer; fCustomers)iC, .. T - Cuskomertame
[Fowal Cuskomer: fCustomers)iC, ., T - CustomerAddre
[row ], Cuskomer; fCustomers)iC, .. T_ id3tate

[romz U5states: fUSSEates)Sta. . =I- | abelState

‘] |

2. ClicktheAll in onefield and from the drop-down list, select tr ue or false to decide whether the output XML
flow should be one single flow.

 If you select true, the XML datais output al in one single flow. In this example, the single flow reads
asfollows:

Searesng job (XA ¥ap s 10038 G52 -01 T

[stati=tics] connecting to zocket on port 3643

[stati=tic=] connected

¢tEml wersion="1.0" encoding="UTF-83"7:

soustomersr<customer id="1"r<CustomerHamne:Griffith Paving
and

Sealcoatind s CusztonerNamner < Cusztoneriddress:talend@®apresf1<-C
ustomeriddress:<idState:7<-1d5tater><Label5State:Connect 1cut €
sLabelStater<-customer < customner
1d="56"»<CustomerHamne:Glenn Daks Qffice

Supplies< sCustomerHane:<Customneriddres=:1859 Gresn Bav

Fd. <« Customeriddres=s:<idState:? (- 1id5tater<Label5tateConne
cticut<-LabelStater< custoner:<customnser
id="2"»<CustomerHame:Bill's Dive
Shop<-CuztomerHamns < Custoneriddres=s:511 Maple Awve. Apt.
1B< - Customneriddres=sr<1dStater35<-1d5tater><Label5State:0hiod s
LabelStater<-customer:<customer id="61":<CustomerHamne:DEN
Banl<-CustomerHamner<Custoneriddres=:456 Grossmnan

Ln. </ Custoneriddres=s:<idStater3h<-1d5tate><LabelState:0hiog
<LabelStater<-customer:<{customser
1d="63"»<CustomerHamne:Pivot Point
Colleges-CustomerHame:<Customneriddres=:1547 Knolwood

Rd. < Customneriddress:<idStater9<{ 1id5tate:<Lab=el5tate:Flori
da<-LabelState:< customner < -customners:

[=tati=tic=s] dis=connected

Joab f AT NEn anded g6 000 E GF-F1oRREE fesr b oodesay

The structure of this flow reads:
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Zrxml wersion="1.0" encoding="TUTF-&" 2
< CUSCOLETS>
<CUStOmer 17
ZCustonerNamne=Griffith Paving and 3Sealcoatin<g /CustomerNames-
LCustonerdddressrtalend@apresdl< /Custonerdddresss
<iditatex7</iditates
<LabelftatexConnecticut /Labelitatel
</oustomner:
LoUStoner THETE
ZCustonerName>Glenn Oaks 0ffice Jupplies</CustonerName>-
ZCustonerdddress>15858 Green Bay Rd.</Customeriddress>
<iditatexT7</iditates
<LabelftatexConhecticut /Lahelitate
<foustomners-
<oustomner AT
<CustomerName>BEill's Diwve Shop</CustonerNames-
ZCustonerdddress»-51ll Maple Ave., Apt. l1EB</Customerdddress:-
<iditater35/iditate-
<Labelftatex0hio</Labelitates
<Lfoustoners
<CUSTOmer el"=
<Custonerane>DEN Bank< /Custonerlamne>
<Custonerhddress>456 Grogsman Ln.</Custonerhddress-
Lid3tatex>3bsfid5tate
<Labelftate>0hio</Labelitates
L/ oustoners-
<£CUStoner Te3"E
ZCustonerName=Pivot Point College</CustonerNames
<Customerkdddress>1547 Enolwood Rd.</Customerdddresss-
<id¥tatex9</iditate>
<LahelitatexFlorida<s/LabelStates-
</customer’
</ocustonerss

« If you select false, the XML datais output in separate flows, each loop being one flow, neither grouped
nor aggregated. In this example, these flows read as follows:
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Starting jobh c LW ENsn g6 IO FE GRS IS e

[ztatisztic=s] connecting to socket on port 4036

[ztati=stics] connected

<?Emnl wersion="1.0" encoding="UTEF-8"7:

{customersr<cusztomer id="1":r<CustomerHame:Griffith Paving
and
Sealcoatin<-CustomerHamne:<Custoneriddress:talend@apres91<.-C
usztomeriddres=sr<idStater7<-1d5tate:<LabelState:Connecticut ¢
<LabelState: < customer < custonsrs:

<?Eml wersion="1.0" encoding="UTEF-8"7:

{customers:<customer id="56"r<{CustomerHame:Glenn Oaks
Dffice Supplies<-CustomnerHamner<Custoneriddres=:1859 Green
Bavy

Fd . <~ Customeriddres=s:<idStater7<-1dStater<LabelState:Conne
cticut<-LabelStater< customerr<-custonsers:

<7Em]l wersion="1.0" encoding="UTF-8"7:

{customers:<customser id="2":<¢CustomerHame:Bill's Dive
Shop<-CustomerName:<Custonerdddre=s=:>511 Haple Awve. Apt.
1B: - Custonerdddres=sr<idStater35<-1d5tater<LabelState:Chiogs
LabelStater<-custoner r<-custonsers:

<7Eml wersion="1.0" encoding="UTEF-8"7:

{customers:<cusztomer id="61"r»<{CustomerHame:DBEH

Banl < -CusztomerHane:<Customneriddre=s=:>456 Grossman

In. < Customeriddress:<idStater35<-1d5tater<LabelState:0hiog
sLabelStater<-custonerr<-custonsers:

<7Eml wersion="1.0" encoding="UTEF-8"7:

{customersr<cusztomer id="63"r<{CustomerName:Fivot Foint
College<-CustomerName:<Custonerdddres=:>1547 Knolwood

Fd . <-Customerdddres=sr<idStater9<-1id5Stater<LabelState:Flori
da<-Lab=lStater< customner < -customsrs: ¥

Each flow contains one complete XML structure. To take the first flow as example, its structure reads:
<rxml wersion="1.0" encoding="UTF-&" 2>
{CUSTOMerss
<CUSTOme Y 17
LCustomerName=Griffith Paving and Sealcoatin<g /CustomerName:
<Custonerdddressrtalendfapresd1< /Customeriddresss
<id3tate=7</iditates-
<LabelitaterConnecticuts Labelitates-
< /CUstomer=
£foustomersx

TheAll in onefeatureisdisabled if you are using the aggregate element. For further informati on about the aggregate element,
? see section How to aggregate the output data

5.3.2.2. How to manage empty element in Map editor

It may be necessary to create and output empty elements during the process of transforming datainto XML flow,
such as, when tXML M ap works along with tWriteXML Field that creates empty elements or when there is no
input column associated with certain XML node in the output XML data flow.

By contrast, in some scenarios, you do not need to output the empty element while you have to keep them in the
output XML tree for some reasons.

tXMLMap alows you to set the boolean for the creation of empty element. To do this, on the output side of the
Map editor, perform the following operations:

1. Click the pincer icon to open the map setting panel.
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Customer ) _}1’ ..' i
Property Yalue

atch Qukput Reject false

Zatch Lookup Inner Join Reject False

all in one krue

et et e - v
Expression

false

_Ostomer_orares
|
=~ customers
1

=- customer {loop ke
1

[Fowl  Customer: fCustomers/ic, ., I_Tl— imid
[rowwl, Customer ; fustomers/ic, .. %l— CustormerManme
[Fowl  Customer: fCustomers/ic, ., I_Tl— Custameraddre
[rowwl, Customer ; fustomers/ic, .. %l— id3kate

I=)- Labelstate
J |

2. Inthepandl, click the Create empty element field and from the drop-down list, select true or falseto decide
whether to output the empty element.

« If you select true, the empty element is created in the output XML flow and output, for example,
<cust ormer ><Label St at e/ ></ cust oner >.

« If you select false, the empty element is not output.

5.3.2.3. How to define the sequence of multiple input loops

If aloop element, or the flat data flow, receives mappings from more than one loop element of the input flow, you
need to define the sequence of the input loops. The first loop element of this sequence will be the primary loop,
so the transformation process related to this sequence will first loop over this element such that the data outputted
will be sorted with regard to its element values.

Sequence input Loop Modes
1 row 1, doc: fproducts/types
z row 1, doc: fproducks/manufacture

(] 4 ] [ Cancel

For example, in this figure, the types element is the primary loop and the outputted data will be sorted by the
values of this element.
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CLYpESE
<typerDELLLZ3< ftypes
Litypess
<typess
<typexDELL123< ftypes
< itypes-
CLYpESE
<typerDELLALA S types
Litypess
<typess
<typexDELLASG ftype
< itypes-
CLYpESE
<typerHP 123/ types
Litypess
<typess
Ltype>HP 123« / typex
Litypess
CLYpESE
<typerHP456<  types
Litypess
<typess
Ltyper>HPALEL / typex
Litypess
<i/mamifactures>

In this case in which one output loop element receives several input loop elements, a[...] button appears next to
this receiving loop element or for the flat data, appears on the head of the table representing the flat data flow.
To define the loop sequence, do the following:

1. Click this[...] button to open the sequence arrangement window as presented by the figure used earlier in
this section.

2. Usethe up or down flash button to arrange this sequence.

5.3.3. Editing the XML tree schema

In addition to the Schema editor and the Expression editor viewsthat tM ap isalso equipped with, aTreeschema
editor view isprovided in the map editor of tXMLMap for you to edit the XML tree schema of an input or output
data flow.

To access this schema editor, click the Tree schema editor tab on the lower part of the map editor.
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Schema editor | Tree schema editor ™._Expression editor

#Path Key Tvpe w| Mullable Pattern #%||| ®Path b
row . iCuskomer: Custk. .. [l string il Cuskomer . newZolumn: fcustomers

row . iCustomer: JCust. .. [ string Fi Cuskomer . newZolumn: foustomer s fcuskomer

row . iCustomer: JCust. .. [ string Fi Cuskomer . newZolumn: foustomer sfcustomer i @id

row . iCustomer: JCust. .. [ string Fi Cuskomer . newZolumn: foustomer sfcustomer fCusko
row . iCustomer: JCust. .. [ string Fi Cuskomer . newZolumn: foustomer sfcustomer fCusko
rratl Tosknrmer sk |l Shrinm i o nskarmer newi”nlomne fonskamers fonskamer CDskn
£ > £ >

Theleft half of thisview is used to edit the tree schema of the input flow and the right half to edit the tree schema
of the output flow.

The following table presents further information about this schema editor.

M etadata Description

XPath Useit to display the absolute paths pointing to each element or attribute in a XML tree and edit the
name of the corresponding element or attribute.

Key Select the corresponding check box if the expression key data should be used to retrieve data
through the Join link. If unchecked, the Join relation is disabled.

Type Type of data: String, Integer, Document, etc.

This column should always be defined in a Java version.
r

Nullable Select this check box if the field value could be null.
Pattern Define the pattern for the Date data type.

Input metadata and output metadata are independent from each other. Y ou can, for instance, change the label of a column
i on the output side without the column label of the input schema being changed.

However, any change made to the metadata are immediately reflected in the corresponding schema on the
tXMLMap relevant (Input or Output) area, but also on the schema defined for the component itself on the design
workspace.

For detailed use cases about the multiple operations that you can perform using tXMLMap, see Talend Open
Sudio for Big Data Components Reference Guide.
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Chapter 6. Managing routines

This chapter defines the routines, along with user scenarios, and explains how to create your own routines or how
to customize the system routines. The chapter also gives an overview of the main routines and use cases of them.
To have an overview of the most commonly used routines and other use cases, see appendix System routines.

Before starting any data integration processes, you need to be familiar with Talend Open Sudio for Big Data
Graphical User Interface (GUI). For more information, see appendix GUI.
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6.1. What are routines

Routines are fairly complex Java functions, generally used to factorize code. They therefore optimize data
processing and improve Job capacities.

You can also use the Repository tree view to store frequently used parts of code or extract parts of existing
company functions, by calling them via the routines. This factorization makes it easier to resolve any problems
which may arise and allows you to update the code used in multiple Jobs quickly and easily.

Ontop of this, certain system routines adopt the most common Javamethods, using the Talend syntax. Thisallows
you to escalate Java errors in the studio directly, thereby facilitating the identification and resolution of problems
which may arise as your integration processes evolve with Talend.

There are two types of routines:

» System routines: anumber of system routines are provided. They are classed according to the type of datawhich
they process: numerical, string, date...

» User routines: these are routines which you have created or adapted from existing routines.

Y ou do not need any knowledge of the Java language to create and use Talend routines.

All of the routines are stored under Code > Routines in the Repository tree view.
For further information concerning the system routines, see section Accessing the System Routines.

For further information about how to create user routines, see section How to create user routines.

Y ou can also set up routine dependencies on Jobs. To do so, simply right click a Job on the Repository tree view and select
a2 Set up routine dependencies. In the dialog box which opens, all routines are set by default. Y ou can use the tool bar to
remove routinesif required.

6.2. Accessing the System Routines

To access the system routines, click Code > Routines > system. The routines or functions are classed according
to their usage.

The system folder and its content are read only.
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=1ty Job Designs

{8 Test 0.1
H best13065 0.1
Contexts
= Code
=-=3| Routines
= system
=23 DakaCperation 0.1
=4 Mathematical 0.1
=25 MNurmneric 0.1
=24 Relational 0.1
=3 StringHandling 0.1
3 TalendDataGenerator 0.1
=3 TalendDate 0.1
=3 Talendstring 0.1

=3 GeneratorUUID 0.1
+ _r S0L Templates

Each class or category in the system folder contains several routines or functions. Double-click the class that you
want to open.

All of theroutines or functionswithin aclassare composed of some descriptivetext, followed by the corresponding
Java code. In the Routines view, you can use the scrollbar to browse the different routines. Or alternatively:

1. PressCtrl+O intheroutines view.
A dialog box displays alist of the different routinesin the category.
2. Click theroutine of interest.

The view jumps to the section comprising the routine' s descriptive text and corresponding code.

The syntax of routine call statementsis case sensitive.
-z

For more information about the most common Java routines, see appendix System routines.

6.3. Customizing the system routines

If the system routines are not adapted to your specific needs, you can customize them by copying and pasting the
content in a user routine, then modify the content accordingly.

To customize a system routine:

1. First of al, create a user routine by following the steps outlined in the section How to create user routines.
The routine opens in the workspace, where you shall find a basic example of aroutine.

2. Then, under Code > Routines > system, select the class of routines which contains the routine(s) you want
to customize.

3. Double-click the class which contains the relevant routine to open it in the workspace.

4. Usethe Outline panel on the bottom left of the studio to locate the routine from which you want to copy
al or part of the content.
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Repositary &2 = O || = MyhewRoutine 0.1 (&3 TalendDate 0.1 &3 =0
H = —=>> isDate -11- 5ilEg ; Mwyyy-HMM- I 25 re
LOCAL: rB2575 Blem~ 144 * isD "2008-11-32 12:15:25", * MM-dd HH " A
145 wf

]jEE Job Designs
146= public static boolean is3Ds

147
148 if (stringDate == null)

Code
) Routines

18 MylewRouting 0,1 14 _ return false;
E| [ system 150 : .
8 Datadperation 0.1 151 (p 1 ull) |
8N Mathematical 0.1 152 1 "yyyy-MM-dd HH:
84 Numeric 0.1 153
=3 Relational 0.1 154
=4 StringHandling 0.1 155
8} TalendDataGenerakar 156
=3 TalendDate 0.1 1y
=3 TalendString 0.1 158
EJ"-J_-LT SQL Templates 158
EJ"-@ Recycle bin 1s0
161 return false:;
< | [* 162 )
163
EE S IEL?" ke 1 = 164 if (!sdf.format(testDate) .equalsIgnor [stringDate] ] |
Ba e w™ 185 return false:
cof routines ~ 1686 }

1a7
168 return true;

169 i

170 ™
< | 2]

%e Component 53 [ Run job] ﬁ" Qozie Schedulerw = Modules} = Problems} =0

Pl

t = import declarations

E----Gb TalendDate

------ @ 9 getPartofDate(String,

------ Oé formatDateiString, Dal—
------ et isDate(String, String) :

5 compareDatelDate, D:
------ ef compareDate(Date, De
------ © ° addDate(Date, int, Str
...... @ addDate(String, String Properties not available.
------ @ 9 giffDate(Date, Date, 5
------ ™ f diffDate(Date, Date, 5
< | >

5. Intheworkspace, select al or part of the code and copy it using Ctrl+C.
6. Click the tab to access your user routine and paste the code by pressing Ctrl+V.
7. Modify the code as required and press Ctrl+Sto saveit.

We advise you to use the descriptive text (in blue) to detail the input and output parameters. This will make your
routines easier to maintain and reuse.

6.4. Managing user routines

Talend Open Studio for Big Data allows you to create user routines, to modify them or to modify system routines,
in order to fill your specific needs.

6.4.1. How to create user routines

Y ou can create your own routines according to your particular factorization needs. Like the system routines, the
user routines are stored in the Repository tree view under Code > Routines. Y ou can add foldersto help organize
your routines and call them easily in any of your Jobs.
To create a new user routine, complete the following:

1. Inthe Repository tree view, expand Code to display the Routines folder.
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= 9 Create folder
=3 Expand/Collapse
= QEI Import items

& Lyl Export items
=

(RIRIS RIS TS RIS RS P s

=) TalendDataGenerator 0.1
=) TalendDate 0.1
=3 Talendstring 0.1

=3 GenerakarUJID 0,1

Right-click Routines and select Createroutine.

The [New routine] dialog box opens. Enter the information required to create the routine, ie., its name,
description...

Click Finish to proceed to the next step.

Repository 52 = O ||#y MyNewRroutine 0.1 52 — 0
LOCAL: r32575 =

’EE Job Designs

1 Contexts 38 /=
= Code 4 * user specification: the function's comment should contain keys as
=& 5 * it must be hefore the "{talendTypes:" key.
%Routine 0.1 . " ) ) ) )
Dsystem 7 % Z. {talendTypes: '=s wvalue must be talend Type, it is reguired . 1
JSQLTemplates =} * longy | Long, int | Integer, hoolean | Boolean, byte | Byte, Date,
E] Recycle bin s @ e
io w
i1 * 3. {Category} define a category for the Function. it is reguired.
iz w
i3 * 4, {param! 's format is: {param! <type>[(<default wvalue or closed
14 w
15 * <typer 's wvalue should ke one of: string, int, list, doukle, ohje
1a * Function's paraweter name. the {param? is optional. so if you the
17 * added. you can have many parameters for the Function. _
13 &
19 * 5. {example} gives a example for the Function. it is optional.
za w
Z1 public class MylNewRoutine {
ZZ
238 FAL
24 * helloExample: not return value, only print "hello™ + message.
z5 &
26 w
27 * {talendTvypes} String s
< | >
o= Outlin &% |5 Code = £ Job [ R Contexts [ 53 Component £2 [ Run job ﬁOUZie Scheduler | 2, Modules [21 Problems =0
W sl e wt ¥
tlj routines

Properties not available.
=2-® MyMewRoukine

et helloE:xamplelString) : woic
< |

Thenewly created routine appearsinthe Repository treeview, directly below the Routinesnode. Theroutine
editor opens to reveal amodel routine which contains a simple example, by default, comprising descriptive
text in blue, followed by the corresponding code.

We adviseyou to add avery detailed description of the routine. The description should generally include the input and
¥ output parameters you would expect to use in the routine, as well as the results returned along with an example. This
information tends to be useful for collaborative work and the maintenance of the routines.

The following example of codeis provided by default:

public static void hell oExanpl e(String nessage) {
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if (nmessage == null) {
message = "World"; //$SNON-NLS-1$
}
Systemout.println("Hello " + nmessage + " !");

5. Modify or replace the model with your own code and press Ctr+Sto save the routine. Otherwise, the routine
is saved automatically when you closeiit.

You can copy al or part of a system routine or class and use it in a user routine by using the Ctrl+C and Ctrl+V
2 commands, then adapt the code according to your needs. For further information about how to customize routines, see
section Customizing the system routines.

6.4.2. How to edit user routines

Y ou can modify the user routines whenever you like.

The system folder and al of the routines held within are read only.
-z

To edit your user routines:

1. Right click the routine you want to edit and select Edit Routine.

2. Theroutine opens in the workspace, where you can modify it.

3. Onceyou have adapted the routine to suit your needs, press Ctrl+Sto saveit.

If you want to reuse a system routine for your own specific needs, see section Customizing the system routines.

6.4.3. How to edit user routine libraries

You can edit the library of any of the user routines by importing external .jar files for the selected routine. These
external library fileswill belisted, like modules, inthe M odulesview in your current Studio. For moreinformation
on the M odules view, see section How to install external modules.

The .jar file of the imported library will be also listed in the library file of your current Studio.

To edit auser routine library, complete the following:

1. IntheRepository tree view, expand Code > Routines.

2. Right-click the user routine you want to edit its library and then select Edit RoutineLibrary.

The[Import External Library] dialog box displays.
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% Import External Library

Configuration of external libraries For routine, [

Library File: Module Regured | Description

testroutine. jar |

reload the library

@ Finish ] [ Cancel

3. Click New to open anew dialog box where you can import the external library.

You can delete any of the already imported routine files if you select the file in the Library File list and click the
] Remove button.

* New Module u EJEJ
) Input a library's name

{(¥) Browse a library file

Library File: | CADocuments and SettingsihmassyiBureau ke | [ Browse, .. ]

If the Library file is required

Description:

0K H Cancel ]

4. Enter the name of thelibrary fileinthe Input alibrary’s name field followed by the file format (.jar), or

5. Select the Browsealibrary file option and click browse to set the file path in the corresponding field.

6. If required, enter adescription in the Description field and then click OK to confirm your changes.
Theimported library fileislisted inthe Library Filelist in the [Import External Library] dialog box.

7. Click Finish to close the dialog box.

Thelibrary fileisimported into the library folder of your current Studio and also listed in the Module view
of the same Studio.

For more information about the M odules view, see section How to install external modules.
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6.5. Calling a routine from a Job

Pre-requisite: Y ou must have at least one Job created, in order to run aroutine. For further information regarding
how to create a Job, see section How to create a Job .

You can call any of your user and system routines from your Job components in order to run them at the same
time as your Job.

To access all the routines saved in the Routines folder in the Repository tree view, press Ctrl+Space in any of
the fields in the Basic settings view of any of the Talend components used in your Job and select the one you
want to run.

E@ thlysqlConnection_1

Basic settings Praperty Type

Advanced settings DE Wersian Mysgl 5w

[wnamic setkings Hask n ot ["=m06"

Yig w context.local_database ”
Database toeet local haet

Documentakion context.local_nos
IJsername " contexk,local_password

] context.local_username
[luse or register a st g0 erakion, CHAR

DataOperation.DTX

DataOperation,. FIX

DataCperation, »TD

global. jobMame

global, projecthame

Mathematical . ABS w

Alternatively, you can call any of these routines by indicating the relevant class name and the name of the routine,
followed by the expected settings, in any of the Basic settings fields in the following way:

<d assNane>. <Rout i neNanme>

6.6. Use case: Creating a file for the current
date

This scenario describes how to use aroutine. The Job uses just one component, which calls a system routine.

[}

4
|I * [

i
tFileTouch_1

1. Inthe Palette, click File > Management, then drop a tFileTouch component onto the workspace. This
component allows you to create an empty file.

2. Double-click the component to open its Basic settings view in the Component tab.

3. IntheFileNamefield, enter the path to accessyour file, or click [...] and browsethe directory tolocatethefile.
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Lj " tFileTouch_1

Basic settings File Mame 0 Inpuk)cuskamer, bxk

Advanced settings [ licreate directory if not exists:

[vnamic settings
Wiew

Dacument ation

Close the double inverted commas around your file extension as follows: "D:/Input/customer” .txt.
Add the plus symbol (+) between the closing inverted commas and the file extension.

Press Ctrl+Space to open alist of al of the routines, and in the auto-completion list which appears, select
TalendDate.getDate to use the Talend routine which allows you to obtain the current date.

Modify the format of the date provided by default, if required.

Enter the plus symbol (+) next to the getDate variable to complete the routine call, and place double inverted
commas around the file extension.

Lj " tFileTouch_1

Basic settings File Mame [ /Inputfcustomer"+TalendDate, getDatel"CCYY-MM-DD hhmmss")+", csy

Advanced settings [(]create directary if nok exists
Dwnamic settings
Wiew

Docurmentatian

If you are working on windows, the ":" between the hours and minutes and between the minutes and seconds must
£5 be removed.

Press F6 to run the Job.

ThetFileT ouch component creates an empty file with the days date, retrieved upon execution of the GetDate
routine called.

customer2010-02-09
134105, c5v
Fichier CSW Microsoft Office E. ..

x5 2
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Chapter 7. Using SQL templates

SQL templates are groups of pre-defined query arguments that run in the ELT mode. This chapter explains the
ELT mode, defines the SQL templates and provides user scenarios to explain how to use the SQL templates or
how to create your own ones.

Before starting any data integration processes, you need to be familiar with Talend Open Sudio for Big Data
Graphical User Interface (GUI). For more information, see appendix GUI.
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7.1. What is ELT

Extract, Load and Transform (ELT) is a data manipulation process in database usage, especidly in data
warehousing. Different from the traditional ETL (Extract, Transform, Load) mode, in ELT, data is extracted,
loaded into the database and then is transformed where it sitsin the database, prior to use. Thisdatais migrated in
bulk according to the data set and the transformation process occurs after the data has been |oaded into the targeted
DBMSinitsraw format. Thisway, less stress is placed on the network and larger throughput is gained.

However, the ELT mode is certainly not optimal for al situations, for example,
e AsSQL isless powerful than Java, the scope of available data transformationsis limited.
e ELT requires users that have high proficiency in SQL tuning and DBM S tuning.

e Using ELT with Talend Open Sudio for Big Data, you cannot pass or reject one single row of data as you can
doin ETL. For more information about row rejection, see section Row connection.

Based on the advantages and disadvantages of ELT, the SQL templates are designed as the ELT facilitation
requires.

7.2. Introducing Talend SQL templates

SQL is a standardized query language used to access and manage information in databases. Its scope includes
data query and update, schema creation and modification, and data access control. Talend Open Sudio for Big
Data provides arange of SQL templatesto simplify the most common tasks. It al'so comprisesa SQL editor which
allows you to customize or design your own SQL templates to meet |ess common requirements.

These SQL templates are used with the components from the Talend ELT component family including
tSQL Template, tSQLTemplateFilter Columns, tSQLTemplateCommit, tSQL TemplateFilter Rows,
tSQL TemplateRollback, tSQL TemplateAggr egate and tSQL TemplateM er ge. These components execute the
selected SQL statements. Using the UNION, EXCEPT and INTERSECT operators, you can modify data directly
on the DBM S without using the system memory.

Moreover, with the help of these SQL templates, you can optimize the efficiency of your database management
system by storing and retrieving your data according to the structural requirements.

Talend Open Sudio for Big Data provides the following types of SQL templates under the SQL templates node
in the Repository tree view:

» System SQL templates: They are classified according to the type of database for which they are tailored.
» User-defined SQL templates: these are templates which you have created or adapted from existing templ ates.
More detailed information about the SQL templatesis presented in the below sections.

For further information concerning the components from the ELT component family, see Talend Open Sudio for
Big Data Components Reference Guide.

Asmost of the SQL templates are tailored for specific databases, if you change database in your system, it is inevitable to
¥ switch to or develop new templates for the new database.

7.3. Managing Talend SQL templates

Talend Open Studio for Big Data enables you viathe SQL Templates folder in the Repository tree view to use
system or user-defined SQL templates in the Jobs you create in the Studio using the ELT components.

The below sections show you how to manage these two types of SQL templates.
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7.3.1. Types of system SQL templates

This section gives detail information related to the different types of the pre-defined SQL templates.

Even though the statements of each group of templates vary from database to database, according to the operations
they are intended to accomplish, they are also grouped on the basis of their types in each folder.

The below table provides these types and their related information.

Name Function Associated components Required component
parameters
Aggregate Realizes aggregation (sum,|tSQL TemplateAggregate Database name
average, count, etc.) over a
set of data. Source table name
Target table name
Commit Sends a Commit instruction|tSQL Template tSQL TemplateAggregate| Null
to RDBMS tSQL TemplateCommit
tSQL TemplateFilter Columns
tSQL TemplateFilter Rows
tSQL TemplateMerge
tSQL TemplateRollback
Rollback Sends a Rollback instruction|tSQL Template tSQL TemplateAggregate| Null
to RDBMS. tSQL TemplateCommit
tSQL TemplateFilter Columns
tSQL TemplateFilter Rows
tSQL TemplateM erge
tSQL TemplateRollback
DropSourceTable Removes a source table. tSQL Template tSQL TemplateAggregate| Table name  (when use
tSQL TemplateFilter Columns tSQL Template)
tSQL TemplateFilter Rows
Source table name
DropTargetTable Removes atarget table tSQL TemplateAggr egate Target table name

tSQL TemplateFilter Columns
tSQL TemplateFilter Rows

Filter Columns

Selects and extracts a set of
data from given columns in

tSQL TemplateAggr egate
tSQL TemplateFilter Columns

Target table name (and schema)

RDBMS. tSQL TemplateFilter Rows Source table name (and
schema)
FilterRow Selects and extracts a set|tSQL TemplateAggregate Target table name (and schema)
of data from given rows in|tSQL TemplateFilter Columns
RDBMS. tSQL TemplateFilter Rows Source table name (and
schema)
Conditions
Mergelnsert Inserts records from the|tSQLTemplateMerge Target table name (and schema)
source table to the target|tSQL TemplateCommit
table. Source table name (and
schema)
Conditions
MergeUpdate Updates the target table with|tSQL TemplateM erge Target table name (and schema)
recordsfrom the sourcetable. | tSQL TemplateCommit
Source table name (and
schema)
Conditions
7.3.2. How to access a system SQL template
To access asystem SQL template, expand the SQL Templates node in the Repository tree view.
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i1 Job Designs
Y, Contexts
Code
EEI _r SQL Templates
=== Hive
=~ system
_r Hivedggregate 0,1
_r HiveCreateSourceTable 0.1
_r HiveCreateTargetTable 0.1
_r HivelropSourceTable 0,1
_r HiveDropTargetTable 0.1
_r HiveFilterCalumns 0.1
L[ HiveFilterRow 0.1
[ UserDefined
(2} Recycle bin

Each folder contains system sub-folders containing pre-defined SQL statements, as well as a User Defined folder
in which you can store SQL statements that you have created or customized.

Each system folder contains severa types of SQL templates, each designed to accomplish a dedicated task.

Apart from the Generic folder, the SQL templates are grouped into different folders according to the type of
database for which they are to be used. The templates in the Generic folder are standard, for use in any database.
You can use these as a basis from which you can develop more specific SQL templates than those defined in
Talend Open Sudio for Big Data.

The system folders and their content are read only.
r

From the Repository tree view, proceed as follows to open an SQL template:
1. Inthe Repository tree view, expand SQL Templates and browse to the template you want to open.
2. Double click the class that you want to open, for example, aggregate in the Generic folder.

The aggregate template view displays in the workspace.

_r.ﬁ.ggregate 0.1 3 =8
1 <%
2 EXTRACT(__ GROUFEY _}:
3 EXTRACT(__ OPERATION_ ):
4 String operation = "'";
5 boolean flag=false:
& for(int i=0; i < _ OPERATICN_ INFUT COLUMN__ .length; i++){

if (flag) |
operation = ", ";
8 lelse(
10 flag=true:
11 }
12 operation += (_ OFPERATICN FUNCTION [i] + "i(" + _ CPERATICN_ INFU

13 }

14

15 %>

16

17 INSERT INTO <%= TABLE NAME TARGET %> (<%=StringUtils.listc|_ OPERATI
15 BJELECT <%= operation %>, <%= StringUtils.listc( GROUPEY INPUT COLUMN
15 GROUP EBY <%=3tringUcils.lisc(_ GROUPEY INPUT COLUMN , ™,™, ™", "") %

£ >
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You can read the predefined aggregate statements in the template view. The parameters, such as
TABLE_NANME_TARGET, oper at i on, are to be defined when you design related Jobs. Then the parameters can be
easily set in the associated components, as mentioned in the previous section.

Everytimeyou click or open an SQL template, its corresponding property view displays at the bottom of the studio.
Click the aggregate template, for example, to view its properties as presented below:
TR SOLTe &1 Context | 52 Compon | 0B Run (Jo | [21 Problem = Modules | d& Talend | B2 Schedul Tg JobHier| = O

_f Aggregate 0.1

Main Marme
Versi
Ersien Author Version
Purpose Status
Description
Creation Modification

For further information regarding the different types of SQL templates, see section Types of system SQL templates

For further information about how to use the SQL templates with the associated components, see section How
to use the SQL Templates.

7.3.3. How to create user-defined SQL templates

As the transformation you need to accomplish in ELT may exceed the scope of what the given SQL templates
can achieve, Talend Open Sudio for Big Data allows you to develop your own SQL templates according to some
writing rules. These SQL templates are stored in the User -defined folders grouped according to the database type
in which they will be used.

For more information on the SQL template writing rules, see appendix SQL template writing rules.
To create a user-defined SQL template:

1. Inthe Repository tree view, expand SQL Templates and then the category you want to create the SQL
templatein.

+

py Job Designs
+ Contexts
+ Code
= _r SQL Templates
=== Hive

#-[J system

. '!JP Create SOLTemplate

(3} Pecy
= [ Create Folder

L5zl Import items

2. Right-click User Defined and select Create SQL Template to open the [SQL Templates] wizard.
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¥* New 50LTemplate |:l E

Mew SOL Template
Add a new 30L Template to repository

Marmne |SQLTempIate |

Purpose | |

Descripkion

Authar

Locker

|

| |
ersian | ||E]

|

|

Stakus A |

Path || Select ]

@ Finish l [ Cancel

3. Enter theinformation required to create the template and click Finish to close the wizard.

The name of the newly created template appears under User Defined in the Repository tree view. Also, an
SQL template editor opens on the design workspace, where you can enter the code for the newly created
template.
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Appendix A. GUI

This appendix describes the Graphical User Interfaces (GUI) of Talend Open Sudio for Big Data.
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Main window

A.1. Main window

Talend Open Studio for Big Data main window istheinterface from which you manage all types of dataintegration
processes.

The Talend Open Sudio for Big Data multi-panel window is divided into:
* menu bar,

* toolbar,

» Repository tree view,

* design workspace,

» Palette,

* various configuration views in a tab system, for any of the elements in the data integration Job designed in
the workspace,

» QOutlineview and Code Viewer.

The figure below illustrates Talend Open Sudio for Big Data main window and its panels and views.

File Edit Wiew Window Help

=1 e P~ IR SR - TR N P ol e T /| 100% v Y | 1y Integration
C.! Learn “Cy Ask =’ Upgrade! e Exchange
far Re 23 = O <4 *mobtest o1 52 = O 5F Palette 52 =g
LOCAL: 182575 = ([ ’ ! ' ' ) ' ) ) ' ) ) ' ' ' =
=Rt NEC] Find componer| 7 25
=I1iy Job Designs - Biq Dt
! . . . . . . . . . . . . . . iq Data
£h DEMO 0.1 = [|h=28d
“p DEMCZ 0.1 [~ Business Inkeligence
i test 0.1 ;=b [ Business
Contexts 5 o - (= Cloud
= Code tRowGer?erator_2
#4851 Routines [= Cuskom Code
=-L] sQL Templat —
_r 0 emp_a es rowz (Lookup) L=-Data Qualiby
2} Recycle bin " = Databases <
. . S (= AS400
XA h% " U!".L"Jrl D
= —— —— ]
_ ] rou_vl (Ma_|n) _ _ DLIt!JLIt (Mﬁm) ey, (- DothET
tRowGenerator_1 tMap_1 tLogRow _1
[=-ELT L
Designer | Code [~ Combined S0L
if Jo Co | hFCo B2 B Ru ? ooz | 2 o | D Err | [21 Pro =g [=ESB
< > Iy I
EPS 4 ogrow_1 [ = File @
2c ™ =8| o Had
= . [= Hadaop
s Basic settings Schema Edit schems (] [Sync oo —
Advanced settings Mode o
4 tLogRow_1 b — 9 @Basic == Inkernet
ynamic setkings =
- tMap_1 , (") Table {print walues in cells of a kable) (5 laes B EiEE i
+ tRowGenerator_1 View ) ) ' 4 bAssert
1 HowGenerator 2 Documentation () wertical (sach row is a keyivalue list)

Field Separataor

W P N Sy

[—== Misc

[CIPrint header (= Orchestr ation
[T Prirt component unique name in fronk of each aukput Fow [ Pracessing 0
[ Print schema column name in front of each value (= Fields
[Juse fixed length For values Rp—
[:— Syskem

= Talend rrir
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Menu bar and Toolbar

The various panels and their respective features are detailed hereafter.
All the panels, tabs, and views described in this documentation are specific to Talend Open Sudio for Big Data. Some views

2 listed in the [Show View] diaog box are Eclipse specific and are not subjects of this documentation. For information on
such views, check Eclipse online documentation at http://www.eclipse.org/documentation/.

A.2. Menu bar and Toolbar

At the top of the Talend Open Sudio for Big Data main window, various menus and a quick access toolbar gather
Talend commonly features along with some Eclipse functions.

A.2.1. Menu bar of Talend Open Studio for Big Data

Talend Open Sudio for Big Data’ s menus include:
» some standard functions, such as Save, Print, Exit, which are to be used at the application level.

» some Eclipse native features to be used mainly at the design workspace level as well as specific Talend Open
Sudio for Big Data functions.

The table below describes menus and menu items available to you on the menu bar of Talend Open Sudio for
Big Data.

Menu Menu item Description
File Close Closes the current open view on the Studio design workspace.
Close All Closes al open views on the Studio design workspace.
Save Saves any changes done in the current open view.
Save as Saves any changes done without changing the current open view.
Save All Saves any changes donein all open views.
Print Unavailable option.
Switch project Closes the current session and launches another one to enable you to open a different
project in the Studio.
Edit proj ect | Opens a dialog box where you can customize the settings of the current project.
properties
For more information, see section Customizing project settings
Import Opens a wizard that helps you to import different types of resources (files, items,
preferences, XML catalogs, etc.) from different sources.
Export Opens a wizard that helps you to export different types of resources (files, items,
preferences, breakpoints, XML catalogs, etc.) to different destinations.
Exit Closes The Studio main window.
Open File Opens afile from within the Studio.
Edit Undo Undoes the last action done in the Studio design workspace.
Redo Redoes the last action done in the Studio design workspace.
Cut Cuts selected object in the Studio design workspace.
Copy Copies the selected object in the Studio design workspace.
Paste Pastes the previously copied object in the Studio design workspace.
Delete Deletes the selected object in the Studio design workspace.
Select All Selects all components present in the Studio design workspace.
View Zoom In Obtains alarger image of the open Job.
Zoom Out Obtains a smaller image of the open Job.
Grid Displays grid in the design workspace. All items in the open Job are snapped to it.
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Menu Menu item Description

Shap to Geometry | Enablesthe Snap to Geometry feature.

Window Per spective Opens different perspectives corresponding to the different itemsin the list.
Show View... Opens the [Show View] dialog box which enables you to display different views on
the Studio.

Maximize  Active| Maximizes the current perspective.
View or Editor...

Preferences Opens the [Prefer ences] dialog box which enables you to set your preferences.

For more information about preferences, see section Setting Talend Open Sudio for
Big Data preferences

Help Welcome Opens a welcoming page which has links to Talend Open Sudio for Big Data
documentation and Talend practical sites.

Help Contents Opens the Eclipse help system documentation.

About Talend Open|Displays:
Sudio for Big Data
-the software version you are using,

-detailed information on your software configuration that may be useful if thereis a
problem,

-detailed information about plug-in(s),

-detailed information about Talend Open Studio for Big Data features.

Export logs Opens a wizard that helps you to export al logs generated in the Studio and system
configuration information to an archived file.

SoftwareUpdates |Find and Install.... Opens the [Install/Update] wizard that helps searching for
updates for the currently installed features, or searching for new features to install.

Manage Configuration...: Opensthe[Product Configuration] dialog box whereyou
can manage Talend Open Sudio for Big Data configuration.

A.2.2. Toolbar of Talend Open Studio for Big Data

Thetoolbar containsicons that provide you with quick access to the commonly used operations you can perform
from Talend Open Studio for Big Data main window.

The table below describes the toolbar icons and their functions.

Name Icon Description

Save = Saves current job design.
1=

Saveas = Saves as another new Job.

Export items = Exports repository itemsto an archive file, for deploying outside Talend Open Sudio for
gl Big Data. Instead if you intend to import the exported element into a newer version of

Talend Open Sudio for Big Data or of another workstation, make sure the source files
areincluded in the archive.

Import items = Imports repository items from an archive file into your current Talend Open Sudio for
. Big Data. For more information regarding the import/export items feature, see section
How to import items.
Find a specificjob G= Displaystherelevant dialog box that enables you to open any Job listed in the Repository
] tree view.
Run job ﬂ . Executes the Job currently shown on the design space. For more information about job
execution, see section How to run a Job.

206 Talend Open Studio for Big Data User Guide



Repository tree view

Name Icon Description

Create A . Launches the relevant creation wizard. Through this menu, you can create any repository
o item including Job Designs, contexts, and routines.

Project settings Launches the [Project Settings] dialog box. From this dialog box, you can add a

= description to the current Project and customi ze the Pal ette display. For moreinformation,
see section Customizing project settings.

Detect and update all . Searches for all updates available for your Jobs.

jobs 4

Export Talend a Launches the [Export Talend projects] wizard. For more information about project
projects = export, see section How to export a project.

A.3. Repository tree view

The Repository tree view gathers al the technical items that can be used to design Jobs. It gives access to any
item including , JobDesigns, as well as reusable routines.

The Repository centralizes and stores all necessary elements for any Job design contained in a project.

The figure below illustrates the elements stored in the Repository.

fﬁj Repository i = 0O
LOCAL: ProjectMame

Contexts
Code

_r SOL Templates
&} Recycle bin

- - -

Ll
The Refresh button g4 allows you to update the tree view with the last changes made.

The Activate filter button He %s allows you to open the filter settings view so as to configure the display of
the Repository view.

The Repository tree view stores all your data (Jobs).

The table below describes the nodes in the Repository tree view.

Node Description

Job Designs The Job Designs folder shows the tree view of the designed Jobs for the current project. Double-
click the name of the Job to open it on the design workspace. For more information, see chapter
Designing a data integration Job.

Contexts The Context folder groups files holding the contextual variables that you want to reuse in various
Jobs, such asfilepaths or DB connection details. For moreinformation, see section How to centralize
contexts and variables.

Code The Codefolder isalibrary that groupsthe routines availablefor thisproject and other pieces of code
that could be reused in the project. Click the relevant tree entry to expand the appropriate code piece.

For more information, see chapter Designing a data integration Job.

SQL Templates The SQL Templatesfolder groupsall system SQL templates and givesthe possibility to create user-
defined SQL templates. For more information, see section How to use the SQL Templates.

Recyclebin The Recycle bin groups all elements deleted from any folder in the Repository tree view.

Talend Open Studio for Big Data User Guide 207



Design workspace

Node Description

The deleted elements are still present on your file system, in the recycle bin, until you
" right-click the recycle bin icon and select Empty Recycle bin.

Expand the recycle bin to view any folders, subfolders or elements held within. You can
i action an element directly from the recycle bin, restore it or delete it forever by clicking
right and selecting the desired action from the list.

A.4. Design workspace

In the Talend Open Studio for Big Data’ s design workspace, Job Designs can be laid out.

For more information, see section How to create a Job .

For Job Designs: active designs display in aeasily accessible tab system above this workspace.
Under this workspace, you can access several other tabs:

 the Designer tab: opens by default when creating a Job. It displays the Job in a graphical mode.
« the Code tab: enables you to visualize the code and highlights the possible language errors.

Warnings are indicated in yellow whereas errors are indicated in red.

'Q Ask g pgrade! B |y Integration
‘b *lobbest 0.1 57 = B || 5% palette 2 =8
= \].:.
e 0 0 0 o o [ Business Inteligence
= '-." [= Business
tRu:uwGer?eratu:ur_2 (= Cuskom Cods
FOWE I:I_gocnkup]l ' ' ’ ’ ’ = Data Quality
) ) ) . ) ) ) ) [ Databases
= =
Y -.@%E »I C=ELT
e ol (MaEinT outpuk (Main] iy, L2
‘tRowGenerator_1 ) ) tMap_1 ' © HogRow 1 [=~E5E
= File
=% Inkernek

Designer | Code | Jobscripk _
=~ Logs & Errors

APaletteisdocked at thetop of the design workspace to help you draw the model corresponding to your workflow
needs.

A.5. Palette

From the Palette, you can drop technical components and notes to the design workspace. You can define and
format them using the various tools offered in the Component view for the Job.

Related topics:

« chapter Designing a data integration Job.
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Configuration tabs

« section How to change the Palette layout and settings.

A.6. Configuration tabs

The configuration tabs are located in the lower half of the design workspace. Each tab opens a view that displays
the properties of the selected element in the design workspace. These properties can be edited to change or set the
parameters related to a particular component or to the Job as awhole.

tFileInputPositional_1 ' ) ) ' ) ) ' " tFileCutputdML_1
Designer | Code
if Job{tFileOutputiML_s1 &3 Contexts{Job tFileQutp | % Component | 0B Run {Job tFileOutputxm [‘_ Froblems =0

iy tFileOutputXML_s1 0.1

Main Mame

Extra ; o
Author Wersion

Stats & Logs

Version Purpose Status
Description
Creation Maodification

The Component, Run Jobs, Problems and Error Log views gather all information relative to the graphical
elements selected in the design workspace or the actual execution of the open Job.

The M odules and Scheduler tabs are located in the same tab system as the Component, L ogs and Run Job tabs.
Both views are independent from the active or inactive Jobs open on the design workspace.

Y ou can show more tabs in this tab system and directly open the corresponding view if you select Window > Show view
2 and then, in the open dialog box, expand any node and select the element you want to display.

The sections bel ow describe the view of each of the configuration tabs.

View Description

Component This view details the parameters specific to each component of the Palette. To build a Job that will function,
you arerequired to fill out the necessary fields of this Component view for each component forming your Job.

For more information about the Component view, see section How to define component properties.

Run Job This view obviously shows the current job execution. It becomes alog console at the end of an execution.

For details about job execution, see section How to run a Job.

Oozie scheduler This enables you to run the current Job, or schedule it so that it will launch periodicaly, on a remote HDFS
Server.

For more information, see section How to run a Job on a remote HDFS server.

Error Log This view is mainly used for Job execution errors. It shows the history of warnings or errors occurring during
job executions.
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Outline and code summary panel

View Description
The log tab has also an informative function for a Java component operating progress, for example.

x

Error Log tabishidden by default. Asfor any other view, go to Window > Show views, then expand Gener al
node and select Error Log to display it on the tab system.

Modules This view shows if amodule is necessary and required for the use of a referenced component. Checking the
Modules view helpsto verify what modules you have or should have to run smoothly your Jobs.

For more information, see section How to install external modules.

Job view The Job view displays various information related to the open Job on the design workspace. This view has
the following tabs:

Main tab

Thistab displays basic information about the Job opened on the design workspace, i.e. its name, author, version
number, etc. The information is read-only. To edit it you have to close your Job, right-click its label on the
Repository tree view and click Edit properties on the drop-down list.

Extratab

This tab displays extra parameters including multi thread and implicit context loading features. For more
information, see section How to use the features in the Extra tab

Stats/L og tab

Thistab allows you to enable/disable the statistics and logs for the whole Job.

Y ou can already enable these features for every single component of your Job by simply using and setting the
relevant components: tFlowM eter Catcher, tStatCatcher, tLogCatcher.

For more information about these components, see Talend Open Sudio for Big Data Components Reference
Guide.

In addition, you can now set these features for the whole active Job (i.e. all components of your Job) in one go,
without using the Catcher components mentioned above. This way, al components get tracked and logged in
the File or Database table according to your setting.

Save ko project setkings button

Y ou can also save the current setting to Project Settings by clicking the

For more details about the Stats & L ogs automation, see section How to automate the use of statistics & logs.
Version tab

This tab displays the different versions of the Job opened on the design workspace and their creation and
modification dates.

Problems This view displays the messages linked to the icons docked at a components in case of problem, for example
when part of its setting is missing. Three types of icons/messages exist: Error, Warning and Infos.

For more information, see section Warnings and error icons on components.

Job Hierarchy This view displays atree folder showing the child Job(s) of the parent Job selected. To show this view, right-
click the parent Job in the Repository tree view and select Open Job Hierarchy on the drop-down list.

Y ou can also show this view in the Window > Show view... combination where you can select Talend > Job
Hierarchy.

You can see Job Hierarchy only if you create a parent Job and one or more child Job(s) via the tRunJob
component. For moreinformation about tRunJob, see Talend Open Sudio for Big Data Components Reference
Guide.

A.7. Outline and code summary panel

This panel islocated below the Repository tree view. It displays detailed information about the open Job in the
design workspace.
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Shortcuts and aliases

The Information panel is composed of two tabs, Outline and Code Viewer, which provide information regarding
the displayed diagram and also the generated code.

For more information, see section How to display the code or the outline of your Job.

A.8. Shortcuts and aliases

Below is atable gathering all keyboard shortcuts currently in use:

Shortcut Operation Context

F2 Shows Component settings view. Global application

F4 Shows Run Job view. Global application

F6 Runs current Job or shows Run Job view if no Job is open. Global application

Ctrl + F2 Shows Module view. Global application

Ctrl + F3 Shows Problems view. Global application

Ctrl +H Shows the Designer view of the current Job. Global application

Ctrl + G Shows the Code view of the current Job. Global application

Ctrl +R Restores the initial Repository view. From Repository view

Ctrl + Shift + F3 Synchronizes components javajet components. Global application

Ctrl + Shift+J Opens a Job. Global application (In Windows)

F7 Switches to Debug mode. From Run Job view

F5 Refreshes the Repository view. From Repository view

F8 Kills current Job. From Run Job view

F5 Refreshes Modulesinstall status. From Modules view

Ctrl+L Execute SQL queries. Talend commands (in Windows)

Ctrl+Space bar Access global and user-defined variables. It can be error|From any component field in Job or
messages or line number for example, depending on the| Component views
component selected.
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Appendix B. Theory into practice: Job
examples

This chapter aims at users of Talend Open Studio for Big Data who seek areal-life use case to hel p them take full

control over the product. This chapter comes as a complement of Talend Open Studio for Big Data Components
Reference Guide.
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tMap Job example

B.1. tMap Job example

B.1.1. Introducing the scenario

To illustrate the way Talend Open Studio for Big Data operates, find below a rea-life example scenario. In this
scenario, we will load aMySQL table with afile, that gets transformed on the fly. Then in afurther step, we will
select the data to be loaded using a dynamic filter.

Before actually starting the Job, let’ s inspect the input data and the expected output data.

B.1.1.1. Input data

Our input file, the data of which will be loaded into the database table, lists clients from all over the State of
Cdlifornia

The file structure usually called Schema in Talend Open Studio for Big Data includes the following columns:
* First name

* Last name

* Address

» City

B.1.1.2. Output data

We want to load into the database, Californiaclientsliving in a couple of Counties only: Orange and Los Angeles
counties.

The table structure is dightly different, therefore the data expected to be loaded into the DB table should have
the following structure:

» Key (key, Type: Integer)

» Nane (Type: String, max. length: 40)

e Address (Type: String, max.length: 40)

» County (Type: String, max. length:40)

In order to load this table, we will need to use the following mapping process:
The Key column is fed with an auto-incremented integer.

The Nane column isfilled out with a concatenation of first and last names.

The Addr ess column data comes from the equivalent Address column of the input file, but supports a upper-case
transformation before the loading.
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Tranglating the scenario into a Job

The count y column is fed with the name of the County where the city islocated using areference file which will
help filtering Orange and L os Angeles counties’ cities.

B.1.1.3. Reference data

As only Orange and Los Angeles counties data should be loaded into the database, we need to map cities of
Californiawith their respective county, in order to filter only Orange and Los Angeles ones.

To do so, we will use areferencefile, listing cities that are located in Orange and L os Angeles counties such as:

City County
Agoura Hills Los Angeles
Alhambra Los Angeles
Aliso Vigjo Orange
Anaheim Orange
Arcadia Los Angeles

The referencefile in this Job is named LosAngel esandOrangeCounties.txt.

B.1.2. Translating the scenario into a Job

In order to implement this scenario, let’s break down the Job into four steps:
1. Creation of the Job, configuration of the input file parameters, and reading of the input file,
2. Mapping of data and transformations,

3. Definition of the reference file parameters, relevant mapping using thetM ap component, and selection of inner
join mode,

4. Redirection of the output into aMySQL table.

B.1.2.1. Step 1: Job creation, input definition, file reading

Launch Talend Open Studio for Big Data, and createalocal project or import the demo project if you arelaunching
Talend Open Studio for Big Data for the first time. For more information, see section Launching Talend Open
Sudio for Big Data and section Working with projects.

The main window of Talend Open Studio for Big Data is divided into several aress:

» Totheleft: the Repository tree view that holds Jobs, shared Code, and so on.

* Inthe center: the Editor (main Design area)

At the bottom: Component and Job tabs

» Totheright: the Palette of technical components.
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Trandlating the scenario into a Job

To the left of the Studio, the Repository tree view that gives an access to:

e The Job Designer: For details about this part, see section Getting started with a basic Job design.

 Contexts and routines; For details, see section Using the Metadata Manager

To create the Job, right-click Job Designs in the Repository tree view and select Create Job.

In the dialog box displaying then, only the first field (Name) isrequired. Typein Californial and click Finish.
An empty Job then opens on the main window and the Palette of technical components (by default, to the right of
the Studio) comes up showing a dozen of component families such as: Databases, Files, Internet, Data Quality
and so on, hundreds of components are already available.

To read the file California_Clients, let’s use the tFilel nputDelimited component. This component can be found
inthe File/lnput group of the Palette. Click this component then click to the left of the design workspace to place
it on the design area.

Let’'s define now the reading properties for this component: File path, column delimiter, encoding...

To do so:

1. Drop thetFilelnputDelimited component from the File group of the Palette to the design workspace.

2. Double-click the tFilelnputDelimited component to open its Basic settings view in the Component tab.

3. IntheFile name/Stream field, define the path to the input file.

4. IntheHeader field, define the number of rows to be skipped when reading the input file.

5. Click the[...] button next to the Edit schema to open the [Schema] dialog box, and define the data structure
of theinput file. When done, click OK to close the] Schema] dialog box.

¥ Schema of tFilelnputDelimited_1 |

tFilelnputDelimited_1

Column Key Type | M. DatePat.. Len.. Pre.. D.. (€
FirstMame [C] String
LastMame [l String
Address [C] String :
City [C]  String 1
4 ] P

| ok || cancel

L &

Now the basic property settings of the input component are compl ete.
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Tranglating the scenario into a Job

e

tFilelnputDelimited 1

Designer| Code

1y Job(Calif | ) Contexts( | 52 Compon &3 [F Run (Job ﬁ' Qozie(Cal % Modules [S_ Problems = B8

o

=0
5= tFilelnputDelimited_1 HE

Basic settings Property Type Built-In -
Advanced settings "When the input source is a stream or a zip file footer and random shouldn't be bigger than 0.
Dynamic settings File name/Stream "D/ Talend/Input/California_Clients.csv" " ()
-~ Row Separator "n" Field Separator  "}" *
Documentation [F] CSV options

Header 1 Footer O Lirnit

Schema Built-In = | Edit schema [I]

[V] Skip empty rows  [C] Uncompress as zip file [ Die on error

At this stage, we will terminate our flow by ssimply sending the data read from this input file onto the standard
output (StdOut).

To do so, add atL ogRow component (from the Logs & Errors group).

Tolink both components, right-click theinput component and select Row/M ain. Then click the output component:
tL ogRow.

This Job is now ready to be executed. To run it, select the Run tab on the bottom panel.

Enable the statistics by selecting the Statistics check box inthe Advanced Settings vertical tab of the Run view,
then run the Job by clicking Run in the Basic Run tab.
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100 rows in 0.82s

[ . 1221 rows/s . ... e |
) hﬁl _ rowl (Main) _ "'_ —y
tRilelnputDelimited_1 tLogRow_1

Designer | Code
i Job(Calif Contexts( | 22 Compon | Run (Job &3 E‘:" Oozie(Cal | =, Modules| (21 Problems =8

Job Californial

Execution
Basic Run

Debug Run = Run K s Clear

Advanced Settings
Target Exec

Futherford|Jefferson|5148 W. Russell St. |Annapolis -
Martin|FRoosevelt |6284 San Lui= Obispo North |Pierre
Woodrow | Arthur | 8250 Richmond Hill |Dowver —
Lyndon | Arthur| 232 Carpinteria Avenue |Austin Iii
Lyndon | Eisenhower |1213 Lake Tahos Blwd. |Pierre

Dwight |Cleveland|5285 Harry S Truman Blwd |Saint Paul

Thomas |Haves| 2621 Horth Ventu Park Road |Salt Lake

City

[statistics] disconnected

Jabh fafifornrald andes 3¢ 1P FLEOTSSES fasre

oFE =87

The content of the input file display thus onto the console.

B.1.2.2. Step 2: Mapping and transformations

We will now enrich our Job to include on-the-fly transformations. To implement these transformation, we need
to add atMap component to our Job. This component is multiple and can handle:

» multiple inputs and outputs

« search for reference (simple, cartesian product, first, last match...)

* join (inner, outer)

* transformations

* regections

» and more...

Remove the link that binds together the job’ s two components via aright-click the link, then Delete option. Then
place the tMap of the Processing component group in between before linking the input component to the tMap
aswe did it previoudly.

Eventually to link the tM ap to the standard output, right-click the tM ap component, select Row/* New Output*
(Main) and click the tL ogRow component. Type in outl in the dialog box to implement the link. Logicaly, a

message box shows up (for the back-propagation of schemas), ignore it by clicking on No.

Now, double-click the tMap to accessits interface.
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Tranglating the scenario into a Job

To the l€eft, you can see the schema (description) of your input file (rowl). To the right, your output is for the
time being still empty (outl).

Drop the Firstname and Lastname columns to the right, onto the Name column as shown on the screen below.
Then drop the other columns Address and City to their respective line.

rowl ey out1 & g L
Colurmn Excpression Colurmn
Firstnarme rowl Firstname+" "+rowl Lastname Marne
Lastname rowl, Address, talpperCasel) Address
Address rowl, Ciky ik
ity

Then carry out the following transformations on each column:

» Change the Expression of the Name columntorowl. Firstname + " " + rowl. Last Name. Concatenate the
Firstname column with the Lastname column following strictly this syntax (in Java), in order for the columns
to display together in one column.

» Change the Expression of the Address column to r owl. Addr ess. t oUpper Case() which will thus change the
address case to upper case.

Then remove the Lastname column from the out1 table and increase the length of the remaining columns. To do
S0, go to the Schema Editor located at the bottom of the tMap editor and proceed as follows:

Zolumn key  Tvpe w| M., DatePattern... | Length  Precision = Def...  Comm.,
Firstname |:| akring 10 0
Lastname |:| Skring 10 0
Address [1 string 26 1]
City [1 string 2z 0

£

1. Select the column to be removed from the schema, and click the crossicon.
2. Select the column of which you need increase the length size.

3. Typeinthelength sizeyou intend in thelength column. In thisexample, change the length of every remaining
column to 40.

As the first name and the last name of a client is concatenated, it is necessary to increase the length of the name column
i in order to match the full name size.

No transformation is made onto the City column. Click OK to validate the changes and close the Map editor
interface.

If you run your Job at this stage (viathe Run view aswe did it before), you' Il notice the changes that you defined
are implemented.
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100 rows in 0.81s 100 rows in 0.81s ]
. .5 ; - rowl (Main =£g 1 - outl (Main =. ;-Q;.
tRilelnputDelimited 1 tMap_ 1 tLogRow_ 1

Designer | Code
<y Job(Calif Contexts( | ¢ Compon | B Run (Job &3 E':" Oozie(Cal | = Modules| [2( Problems

Job Californial

Execution
Basic Run

Debug Run | b . e

Advanced Settings
Target Exec

Rutherford Jefferson|5148 W. RUSSELL ST. |Annapolis -
Martin Roosewvelt|6284 SAN LUIS OBISPD HORTH |Pierre
Woodrow Arthur|2250 RICHMOWD HILL |Dowver

Lyndon Arthur|232 CARPINTERIA AVENUE |Austin

ILvndon Eisenhower|12132 LAKE TAHOE BLVD. |Fierre
Dwight Cleveland|5285 HARRY S5 TRUMAN BLVD |Saint Paul
Thoma= Haye=s|2621 HORTH VEHTU PARE ROAD |Salt Lake
City

[=tati=stic=s] disconnected

Jah SR rfornrsd amded 6 JE 88 FAeiid oSS fesa e
codeE =7

For example, the addresses are displayed in upper case and the first names and last names are gathered together
in the same column.

B.1.2.3. Step 3: Reference file definition, re-mapping, inner join
mode selection

Define the M etadata corresponding to the LosAngel esandOrangeCounties.txt file just theway wedid it previously
for California_clientsfile.

First drop another tFilel nputDelimited component onto the design workspace, and define its basic properties. the
path to the reference input file, the number of rows to be skipped, and the schema.

Then link this component to the tM ap component.
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Subjoh:
LA_Orange_cities
FolE {I.Eu:u:ukup]l
58 s
@ rawl (Main] . outl (Main T ey
" Calfornia_clients ' ' tMap_1 ' ' " tLogRow 1

Double-click again on the tMap component to open its interface. Note that the reference input table (row2)
corresponding to the LA and Orange county file, shows to the left of the window, right under your main input

(rowl).

Now let’s define the join between the main flow and the reference flow. In this use case, the join is pretty basic
to define as the City column is present in both files and the data match perfectly. But even though this was not
the case, we could have carried out operations directly at this level to establish alink among the data (padding,

case change...)

To implement the join, drop the City column from your first input table onto the City column of your reference

table. A violet link then displays, to materialize thisjoin.

rowl ..' Q
Zolurmn
Firstname
Lastname
Address
Ciky
row? g ..' |
Expr, key Colurmn
@, rowl City ity
Counky

Now, we are able to use the County column from the reference table in the output table (outl).
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rowl rep iy outl F | L

Colurmn Expression Colurmn
Firstname rowl Firstnarme+" "+rowl. Lastname Marne
Lastname row ], Address, ballpperCasel) Address
Address o], Ciky Ciky
iy o, Counky Counky

rowz? & | B
Expr, ke Colurmn
@, rowl City ity
Counky

Eventually, click the OK button to validate your changes, and run the new Job.

The following output should display on the console.

Execution
Ulysse=s Taft|1794 GRANDVIEW DRIVE|GARDEN GROVE|ORANGE -

Theodore Grant|1895 PACIFIC HUY S|ORANGE | ORANGE

John John=on|1554 SAN ¥SIDRO BLVD|HORCO|

Warren Jackson|2897 MONROE STREET|VILLA PAREK|ORANGE

Warren Van Buren|1633 WESTSIDE FREEWAY |PLACENTIA|QORANGE

Rutherford Eisenhower|448 BURNETT ROAD|COROHA |

Zachary Taft|385 W. RUSSELL ST. |VORBA LINDA|ORANGE

Fachary Pierce|1292 FONTAINE ROAD|VENTURA|

George Garfield|685 VIA REAL|CAMARILIO|

Warren Tawlorl|A3IN HORTH ATHERTOW STREETICARPTHTERTA I b

Asyou can notice, thelast columnisonly filled out for Los Angelesand Orange counties’ cities. For all other lines,
this column is empty. The reason for thisis that by default, the tM ap implements a left outer join mode. If you
want to filter your data to only display lines for which a match is found by the tMap, then open again the tM ap,
click the tMap settings button and select the Inner Join in the Join Model list on the reference table (row?2).

B.1.2.4. Step 4: Output to a MySQL table

Our Job works perfectly! To finalizeit, let’ s direct the output flow to aMySQL table.

Todo so, let’ sfirst create the M etadata describing the connection to the MySQL database. Double-click Metadata/
MySQL/DemoMySQL in the referential (on the condition that you imported the Demo project properly). This
opens the Metadata wizard.

On Step2 of the wizard, type in the relevant connection parameters. Check the validity of this connection by
clicking on the Check button. Eventually, validate your changes, by clicking on Finish.

Drop this metadata to the right of the design workspace, while maintaining the Ctrl key down, in order to create
automatically atMysglOutput component.

Remove the tL ogRow component from your Job.

Reconnect the outl output flow from the tM ap to the new component tMysglOutput (Right-click/Row/outl):
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Using the output stream feature

Subjob: =/

' L.ﬁ._O'ranbe_'cities '

rowz {Lg::u:ukup]l

|ﬁ ro 1 I;Main]l _ =§<ﬁ _u:uutl I:_Main]l ='—s

" California_clients EMap_1 " My5OL_Local DB

On the Basic Settings tab of this component:

1. Typein LA Orange Clientsin the Table field, in order to name your target table which will get created
on thefly.

2. Select the Drop tableif existsand create option or on the Action on tablefield.

3. Click Edit Schema and click the Reset DB type button (DB button on the tool bar) in order to fill out
automatically the DB type if need be.

Run again the Job. The target table should be automatically created and filled with datain less a second!

In this scenario, we did use only four different components out of hundreds of components availablein the Palette
and grouped according to different categories (databases, Web service, FTP and so on)!

And more components, this time created by the community, are also available on the community site
(talendforge.org).

For more information regarding the components, see Talend Open Sudio for Big Data Components Reference
Guide.

B.2. Using the output stream feature

B.2.1. Introducing the scenario

The following use case aims to show how to use the output stream feature in a number of components in order
to greatly improve the output performance.

In this scenario, a pre-defined csv file containing customer information is loaded in a database table. Then the
loaded datais selected using atM ap, and output to alocal file and to the console using the output stream feature.

B.2.1.1. Input data

Theinput file, the data of which will be loaded into the database table, contains customer information of various
aspects.
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Trandlating the scenario into a Job

Thefile structure usually called Schema in Talend Open Studio for Big Data includes the following columns:
 id (Type: Integer)

» CustomerName (Type: String)

CustomerAge (Type: Integer)

Customer Address (Type: String)
» CustomerCity (Type: String)

* RegisterTime (Type: Date)

B.2.1.2. Output data

The tMap component is used to select id, CustomerName and Customer Age columns from the input data. Then
the selected data is output using the output stream feature.

Thus the expected output data should have the following structure:
* id (Type: Integer)

e CustomerName (Type: String)

e CustomerAge (Type: Integer)

All the three columns above come from the respective columnsin the input data.

B.2.2. Translating the scenario into a Job

In order to implement this scenario, break down the Job into four steps:

1. Create the Job, define the schema for the input data, and read the input file according to the defined schema.
2. Set the command to enable the output stream feature.

3. Map the data using the tM ap component.

4. Output the selected data stream.

A complete Job looks as what it displays in the following image. For the detailed instruction for designing the
Job, read the following sections.

@ rowl {Main! E q : okl {Main) =@ rowz (Main) " u..;‘

custdners tMap_1 tFileOutputDelimited_1 tLogRow_1

CnSubjobok,

pro

I:'Ja\-'a_i
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Tranglating the scenario into a Job

B.2.2.1. Step 1: Reading input data from a local file

Wewill usethetFilel nputDelimited component to read the file customers.csv for the input data. This component
can be found in the File/I nput group of the Palette.

1.

5.

Drop atFilelnputDelimited component onto the design workspace, and double-click the to open the Basic
settings view to set its properties.

@ customers(tFileInputDelimited_1) EE u
Basic settings Froperty Type Bulin bt H

Advanced settings File name/Stream | "C:fmyFolderfcustomers, ooy * E]
Drynamic settings Row Separator "in" Field Separakor  |";" *
Wigw [[]csv options

e Header n Footer |0 Lirnik

Validation Rules -
Schema Built-In v | Edit schema []

Skip empby rows || Uncompress as zip file [ Die on errar

Click the three-dot button next to the File name/Stream field to browse to the path of the input data file.
Y ou can also typein the path of the input data file manually.

Click Edit schema to open adialog box to configure the file structure of the input file.

Click the plus button to add six columns and set the Type and columns names to what we listed in the
following:

olurmn Key | Twpe ~| M., DatePatt...  Length  Pre...  D... Co..
id []  Integer
Customeriame |:| Skring
Customerhge |:| Inkeger
Customeraddress [ String
CuskomerCity |:| Skring
RegiskerTime [ Date "dd-rra-w,

Click OK to close the dialog box.

B.2.2.2. Step2: Setting the command to enable the output stream

feature

Now we will make use of tJava to set the command for creating an output file and a directory that contains the
output file.

To do so:

1. Drop atJava component onto the design workspace, and double-click it to open the Basic settings view to

Set its properties.

tlava_1 = [

Basic settings Code new java.io.File("C:/myFolder™) .wkdirs():
globalMap.put ("out_file”, new
java.io.FileOutputStream("C: /myFolder,/customerselection. txt” , false) ) ;

Advanced settings
Dynamic settings
Wign

Docurmentation
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2.  Fill inthe Code areawith the following command:

new java.io.File("C /nyFolder").nkdirs();
gl obal Map. put ("out _file", new java.io. Fil eQutput Strean("C:/nyFol der/
custonmersel ection.txt",fal se));

The command we typed in this step will create a new directory C:/myFolder for saving the output file
@ customer selection.txt which is defined followingly. You can customize the command in accordance with actual
practice.

3. ConnecttJavatotFilel nputDeimited usingaTrigger > On Subjob Ok connection. Thiswill trigger tJava

o OrEbjobok T3 ?
I:'Ja\-'a_i ' ' ' customers

B.2.2.3. Step3: Mapping the data using the tMap component

1. DropatMap component onto the design workspace, and double-click it to open the Basic settings view to
set its properties.

: HE
% tMap_1 =[]

Basic settings Map Editor: E] Mapping links display as:  &uto L

Advanced settings Store on disk

Dynamic settings Temp data direckory path; [I]
Wiew

Documentation

2. Click the three-dot button next to Map Editor to open adialog box to set the mapping.

3. Click the plusbutton on the left to add six columnsfor the schema of theincoming data, these columns should
be the same as the following:
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=l

rowl rep iy

Colurnn
id
ZuskomerMame
Cuskomerfge
CustomerAddress
CuskomerCity
RegisterTime

Schema editor . Expression editor

rowl

Colurmn Key = Twpe w| M., DatePatte...
id [] 1Integer
CustomerMame [] string
Customerage [] Integer
Customeraddress [] string
CustamerCity [] string
RegisterTime [l Date " MR-y

Click the plus button on the right to add a schema of the outgoing data flow.
'@' Mewy outpuk oukl

(O create join kable From Mamed

Ik l [ Cancel

Select New output and Click OK to save the output schema. For the time being, the output schemais still
empty.

Click the plus button beneath the outl table to add three columns for the output data.

ouktl e Q
Expression Column
niewColurmn
newolurmnl
newZolumnz

Drop theid, Customer Name and Customer Age columns onto their respective line on the right.
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8.

=y var o= o g X L1 Auko map!
rowl re Q outl ™ Q
Column Expression Column
id row] id id
Custamerilanme row 1 CustomerMame Custamerhlame
Cuskomerfge rawl.Customer Age Cuskormerfge
Customerfddress
CuskarmerCity
ReqisterTime

Schema editor ™ Expression editor

rowl outl

Column Key Type Column Key Type 7 I T
id O Integer id O Integer
Customettame |:| Skring CustomerMame |:| Skring
Cushomerage O Irkeger Customerage O Inkeger
Customeraddress O Skring
CustomerCity |:| String
RegisterTime O Dake

> < >

<

Click OK to save the settings.

B.2.2.4. Step4: Outputing the selected data stream

1

3.

4,

Drop atFileOutputDelimited component onto the design workspace, and double-click it to open the Basic
settings view to set its component properties.

Select the Use Output Stream check box to enable the Output Stream field and fill the Output Stream
field with the following command:

(java.io. Qut put Strean gl obal Map. get ("out _file")
Y ou can customize the command in the Output Stream field by pressing CTRL +SPACE to select built-in command
] from the list or type in the command into the field manually in accordance with actual practice. In this scenario, the

command we use in the Output Stream field will call thej ava. i 0. Qut put St r eamclassto output the filtered data
stream to alocal file which is defined in the Code area of tJava in this scenario.

=0
% tFileOutputDelimited_1 E

Basic settings Property Type puls b H

advanced settings Use Output Skreamn

Dvnamic setkings Cukput Skream ¥iava.in OukpukStreamiglobalMap . geki"out_File"™
Wig Riow Sepatator "n" Field Separakar "
Documentstian Include Header [ ] Compress as zip file

Yalidation Rules .
Schema Bult-In  +| Edischema  []

Connect tFilelnputDelimited to tMap using a Row > Main connection and connect tMap to
tFileOutputDelimited using a Row > out1 connection which is defined in the Map Editor of tMap.

Click Sync columnsto retrieve the schema defined in the preceding component.

To output the selected data to the console:
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1.

2.

Drop atL ogRow component onto the design workspace, and double-click it to open its Basic settings view.

Select the Table radio button in the M ode area.

e, EE
7 tLogRow_1 ==
-\
Basic settings Schemsa Built-In * || Edit schema E]
Advanced settings Mode

) Basic

Dyvnarnic setkings

Tahbl int walues in cells of a tabl
View (%) Table {print walues in cells of a table)

Bocurentation (" vertical Ceach row is a kevivalue lisk)

Yalidation Rules

Connect tFileOutputDelimited to tL ogRow using a Row > Main connection.
Click Sync columns o retrieve the schema defined in the preceding component.

This Job is now ready to be executed.

. ; E&E N 1
@ rowd (Main okl (Main) '% rowZ (Main) Sy

cuskdners EMap_1 tFileOutputDelimited_1 HLogRow_1

CnSubjobOk

e

EJava_i

Press CTRL +Sto save your Job and press F6 to execute it.

The content of the selected datais displayed on the console.
SEErérng qof SJutpuiSirean & 15030 R8T ESFERT

[statisztics] connecting to socket on port 4059
[2tati=tic=s] conhected

tLogRow_1
id | CustomerNans | Custonerige
10001 | Warren 67
10002 | Woodrow B
10003 | Grover 7
10004 | Abraham 74
10005 | Chester 78
10006 | Calwin 623
10007 | Zachary 53
10008 | Chester 36
10009| Che=ster 1)
10010 Woodrow 57

[=ztati=tic=] dis=connected
Job nEpnESErean aaded ¢ 150 FD I8-TRCRRIE fesr b oode=a)

The selected datais aso output to the specified local file customerselection.txt.
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[= customerselection. bt

g

id: CustomerMNane: Customer Age
10001; Warren: a7
10002 : Woodrow: 65
100035 ; Grover: 77
10004 ; dbraham: 74
10005; Chester ;75
10006 Calvin: 63
10007 Zachary: 53
10005; Chester;36
10009 ;: Chester; a0
10010; Woodrow: 57

L S T 3 B ~ R S )

=
= O

For an example of Job using this feature, see Scenario: Utilizing Output Sream in saving filtered data to a local
file of tFileOutputDelimited in Talend Open Studio for Big Data Components Reference Guide.

For the principle of the Use Output Stream feature, see section How to use the Use Output Stream feature.

B.3. Finding out who visit your website most
often

To drive afocused marketing campaign based on habits or profiles of your customers or users, you heed to be able
to fetch data based on their habits or behavior on your website to be able to create user profiles and send them
the right advertisements, for example.

This section provides an example of finding out users having visited a website most often by sorting out their

| P addresses from a huge number of records in the access-log file for an Apache HTTP server to enable further
analysis on user behavior on the website.

B.3.1. Discovering the scenario

In this example, certain Talend Big Data components are used to leverage the advantage of the Hadoop open
source platform for handling big data. In this scenario we use four Jobs:

» Thefirst Job sets up an HCatal og database, table and partition in HDFS
» The second Job uploads the access-log file to be analyzed to the HDFS file system.

» Thethird Job parses the uploaded access-log file, including filtering any records with an "404" error, counting
the number of successful servicecallsto thewebsite, sorting theresult dataand savingitinthe HDFSfile system.

» Thelast Job reads the result data from HDFS and displays the |P addresses with successful service calls and
their number of visits to the website on the standard system console.
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B.3.2. Translating the scenario into Jobs

B.3.2.1. Setting up an HCatalog database
In the first step, we will set up an HCatal og environment to manage the access-log file to be analyzed.

Choose theright components and build thefirst Job
1. Droptwo tHCatalogOperation components from the Palette onto the design workspace.

2. Connect thetwo tHCatalogOper ation componentsusing aTrigger > On Subjob Ok connection. Thesetwo
subjobs will create an HCatal og database and set up an HCatal og table and partition in the created HCatalog
table, respectively.

3. Label these componentsto better identify their functionality.

1. Create an HCatalog database
2. Set up an HCatalog table and partition

(8 E ~ OnSubjobOk | "’;’}E‘

' Create HCatalog Database Create Heatalog Table

Create an HCatalog database

1. Double-click the first tHCatalogOper ation component to open its Basic settings view on the Component
tab.
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=n|[=]
@-g Create HCatalog Database(tHCatalogOperation_1) ==
4
Basic settings Property Type Built-In -
Advanced settings Version ) *
Distribution HortonWorks = |* HCatalog version |Hortonworks Data Platform V1 =

Dynamic settings
Templeton Configuration
Templeten hostname "talend-hdp” * Templeton pert "50111"

View
Documentation
[7] Use kerberos authentication

Operation on: Database ~ * Operation |Create -

HCatalog Configuration
Database "talenddb_hadoop”

Username "hcat”

Create Configuration
Database location "fuser/hcat/talenddb_hadoop.db”

Database description ™"

[7] Die on error

2. Fromtherelevant lists, select the Hadoop distribution and version. In this example we use the default settings:
HortonWorks distribution with the version of HortonWorks Data Platform V1.

3. Provideeither the host name or the | P address of your Templeton server and the Templeton port in the rel evant
fields, both in double quotation marks.

4. From the Operation on list, select Database; from the Operation list, select Create.
5. Inthe Databasefield, enter anamefor the database you're going to create, talenddb_hadoop in this example.
6. Inthe Usernamefield, enter the user name for database authentication.

7. Inthe Database location field, enter the location for the database file is to be created in HDFS.

Set up an HCatalog table and partition

1. Double-click the second tH Catal ogOper ation component to openits Basic settingsview onthe Component
tab.
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=n|=
.,;-g Create Hcatalog Table(tHCatalogOperation_2) EE l_l
g r
Basic settings Property Type | Built-In i
Advanced settings Schema Built-In -~ | Editschema []
Dynamic settings Version
View Distribution HortonWorks ™ HCatalog version |Hortonworks Data Platform V1 - *
Documentation Templeton Configuration

Templeton hostname "talend-hdp” * Templeton port "50111"

Uze kerberos authentication

Operation on: Table = [* Operation |Create -
Create the table only if doesn't exist already
HCataleg Configuration

Database "talenddb_hadoop”
Table "weblog” *
Username "heat" *

Create Table Configuration
Create an external table

Format TEXTFILE - *
7 Set partitions [Built-ln~ ~ | Edit schema [

Die on error

2. Specify the same HCatalog distribution and version, Templeton host name/IP address, and Templeton port
asinthefirst tHCatalogOper ation component.
3. From the Operation on list, select Table; from the Operation list, select Create.

When you work on atable, HCatal og requires you to define a schemafor it. This schema, however, will not
take part in our subsequent operations, so simply click the[...] button and add a column to the schema, and
give it any name that's different from the column name of the partition schemayou're going to set later on.

4. Specify the same database and user name as in the first tH CatalogOper ation component.
5. Inthe Tablefield, enter aname for the table to be created, weblog in this example.

6. Selectthe Set partitionscheck box and click the[...] button next to Edit schemato set apartition and partition
schema. Note that the partition schema must not contain any column name defined in the table schema. In
this example, the partition schema column is named ipaddresses.

B.3.2.2. Uploading the access-log file to the Hadoop system

In the second step, we will build and configure the second Job to upload the access-log file to the Hadoop system,
and then check the uploaded file.

Choose theright components and build the second Job

1. From the Palette, drop a tApachel oglnput, a tHCatalogOutput, a tHCatalogl nput, and a tL ogRow
component onto the design workspace.

2. Connect the tApachel oglnput component to the tHCatalogOutput component using a Row > Main
connection. This subjob will read the access-log file to be analyzed and upload it to the established HCatal og
database.
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3. Connect thetHCatalogl nput component to the tL ogRow component using aRow > M ain connection. This

subjob will verify the file upload by reading the access-log file from the HCatalog system and displaying
the content on the console.

4. Connect thetApachel ogl nput component to thetH Catalogl nput component using aTrigger > On Subjob
Ok connection.

5. Label these components to better identify their functionality.

1. Upload an AccessLog file
2. Check the uploaded AccessLog file

@ _ rowl (Main) _ " %;ﬁ-—'

Read AccassLog File Uplead to HCatalog

OnSubjebOk

'
row? (Main)

Check HCatalog ' " Print Values

Upload the access-log fileto HDFS

1. Double-click the tApachel oglnput component to open its Basic settings view, and specify the path to the
access-log file to be uploaded in the File Name field.

=@
@ Read AccessLog File(tApacheLoglnput_1) == E
Basic settings Property Type Built-In = | Schema |Built-In = | Editschema E]
Advanced settings File Mame "rfdemo/apache-hadoop/access_log” * E]
Dynamic settings [] Die on error
Wiew
=

2. Double-click the tHCatalogOutput component to open its Basic settings view.
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=rh[I=1
% Upload to HCatalog(tHCatalogOutput_1) == L]
Basic settings Property Type il i
Advanced settings Schema Built-In 7 | Edit scherna D Synec columns
Dynamic settings Version
View Distribution HortonWorks = [* Hatalog version |Hortonworks Data Platform V1 - u
Documentation [] Use kerberos authentication
HDFS Configuration
MameMode URT  "hdfs://talend-hdp:8020," *
File name "fuser/hcat/access_log/out.log” *
Action Overwrite -

Templeton Configuration

Templeton hostname "talend-hdp” * Templeton port "50111" *
HCatalog Cenfiguration

Database "talenddb_hadocop” *
Table "weblog" *
Partiticn "ipaddresses="192168.1.5" *
Username "hcat” *
File location "fuser/hcat/access_log” *

[] Die en error

3. Click the[...] button to verify that the schema has been properly propagated from the preceding component.
If needed, click Sync columnsto retrieve the schema.

4. For the following items, use the same settings as defined in the first Job:
» Hadoop distribution and version
e Templeton host name/I P address and Templeton port number
» HCatalog database, table, and user name
5. Inthe NameNode URI field, enter the URI of the HDFS NameNode.
6. IntheFile namefield, specify the path and name of the output file in the HDFS file system.
7. FromtheAction list, select Create to create the file or Overwriteif the file already exists.
8. Inthe Partition field, enter the partition name-value pair, ipaddresses='192.168.1.15' in this example.

9. IntheFilelocation field, enter the path where the data will be save, /user/hcat/access log in this example.

Check the uploaded access-log file

1. Double-click thetHCatalogl nput component to open its Basic settings view.
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% Check HCatalog(tHCataloglnput_1)

Property Type Built-In -

Basic settings

Advanced settings | Schema Built-ln = | Editschema [~

Dynamic settings Yersion

View Distribution HortonWorks = ™ HCatalog version Hertonworks Data Platform V1l = |
Documentation Templeton Configuration

Templeton hostname "talend-hdp” * Templeton port "50111"

Use kerberos authentication

HCataleg Configuration

Database "talenddb_hadoop”

Table "weblog” *

Partition "ipaddresses="192.168.1.5" *

Username "hecat” *
Die on error

2. Click the[...] button to open the [Schema] dialog box and define the input schema. In this example, we can
simply copy the schema from that of the tApachel ogl nput or tHCatalogOutput component.

3. For adl the other items, use the same settings as defined in the tHCatalogOutput component.

4. IntheBasic settings view of the tLogRow component, select the Vertical mode to display the each row in
akey-value manner when the Job is executed.

B.3.2.3. Analyzing the access-log file on the Hadoop platform

In this step, we will build and configure the third Job, which uses several Pig components to analyze the uploaded
access-log file in a Pig chain to get the IP addresses with successful service calls and their number of visits to
the website.

Choose theright components and build the third Job

1. Drop the following components from the Palette to the design workspace:
 atPiglL oad, to load the data to be analyzed,
 atPigFilterRow, to remove records with the '404' error from the input flow,
 atPigFilter Columns, to select the columns you want to include in the result data,
» atPigAggregate, to count the number of visits to the website from each host,
» atPigSort, to sort the result data, and
» atPigStoreResult, to save the result to HDFS.

2. Connect these components using Row > Pig Combine connections to form a Pig chain, and label them to
better identify their functionality.
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. Read the access-log from HCatalog
. Filter any 404 messages

. Select data columns

. Count the web hits

. Sort the results

. Upload the results to HOFS

L= & o T SR S Y LS TP

Read lLog ' ' Select Data Columns ' ' " Sort Result

Configurethe Pig chain

1.

Double-click the tPigL oad component to open its Basic settings view, and configure the following items to
load the file to be analyzed in the Pig chain:

Schema: copy from the previous Job, and permit the schemato be propagated to the next component.
Pig mode: select Map/Reduce.

Hadoop distribution and version: the same as in the previous Job, HortonWorks and HortonWorks Data
Platform V1 in this example.

NameNode URI: the same as in the previous Job, hdfs://talend-hdp: 8020 in this example.
JobTracker host: talend-hdp: 50300 in this example.
Load function: select PigStor age.

Input file URI: the output file name defined in the previous Job, /user/hcat/access log/out.log in this
example.
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. =0
@D Read Log(tPigLoad_1) Sl D

Basic settings Schema Built-In ~ | Editschema [
Advanced settings Mode
) Local

namic settings
D_y _ @ Map/Reduce
View
Configuration

Documentation
Distribution HortonWorks = * Version | Hortonworks Data Platform VL =

+
[7] Use kerberos authentication

MameMode URT  "hdfs://talend-hdp:8020" "
JobTracker host  "talend-hdp:50300" *

+

Load function PigStorage -

Input file URI |"_e'u ser/hcat/access_log/out.log”

:

[] Die on subjob error

Field separator

2. Inthe Basic settings view of the tPigFilter Row component, click the [+] button to add a line in the Filter
configuration table, and set filter parameters to remove records that contain the code of 404 and pass the
rest records on to the output flow:

* IntheLogical field, select AND.
¢ Inthe Column field, select the code column of the schema.
» Select the NOT check box.
* Inthe Operator field, select equal.
 Inthe Valuefield, enter 404.
EE
Ei@ Filter 404(tPigFilterRow_1) S
Basic settings Schema Built-In = | Editschema [
Advanc.ed set.tlngs Filter configuration Logical Column | NOT Operator Value
Dynamic settings AND code equal 404
View
Documentation
4 L 3
[] Use advanced filter

3. IntheBasic settings view of the tPigFilter Columns component, click the[...] button to open the [Schema]
dialog box. In the Output panel, set two columns, host and count, which will store the information of IP
addresses and their number of visits to the website, respectively.
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6.

& Schema of Select Data Columns ﬁ
Filter 404 (Input - Pig) Select Data Columns (Output)
Column Key Type Mu... Dat.. Lle.. Pr.. D. * Celumn Key Type M. Date.. Le.. Pr. D. C|

host [l String 50 1] host [} String 50 1]

identity [l String 10 1] count [} String

user [l String 20 1]

date [ string 13 0

time [l String 10 1]

diffgmt  [T] String 10 0 3

rtype [[]  String w o0

file [l String 50 1]

proto [ String 8 0

code = Integ... 5 0

bytes [ Integ.. 1 0 | 4

refer [l String 255 0

anent [T1_ Strinn 7] %0 i
4 T | + < T | »

’ OK ] ’ Cancel ]

Lo

S

Inthe Basic settingsview of thetPigAggr egate component, click Sync columnsto retrieve the schemafrom
the preceding component, and permit the schema to be propagated to the next component.

Configure the following parameters to count the number of occurrences of each IP address:

* Inthe Group by area, click the [+] button to add aline in the table, and select the column count in the

Column field.

* Inthe Operations area, click the [+] button to add aline in the table, and select the column count in the
Additional Output Column field, select count in the Function field, and select the column host in the
Input Column field.

Basic settings

Advanced settings

Dynamic settings

Wiew

Documentation

Count Hits(tPigAggregate_1)

=
==

»

m

Schema Built-In = | Editschema [
Group by Column
count
Operations - .
Additional Output Column Function Input Column
{ count count host

I

1

In the Basic settings view of the tPigSort component, configure the sorting parameters to sort the data to

be passed on:

* Click the [+] button to add alinein the Sort key table.
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 Inthe Column field, select count to set the column count as the key.

* Inthe Order field, select DESC to sort datain the descendent order.

=0
% Sort Result(tPigSort_1) =i E

Advanced settings Sort key Column Cirder

Dynamic settings count DESC b

View

Documentation " m k
BB EENEED

7. IntheBasic settingsview of the tPigStoreResult component, configure the component propertiesto upload
the result data to the specified location on the Hadoop system:

* Check the schema; retrieve the schema from the preceding component if needed.
« Inthe Result filefield, enter the path to the result file.
« Fromthe Storefunction list, select PigStor age.

* If needed, select the Removeresult directory if exists check box.

; =0
QQ Upload Results to DHFS(tPigStoreResult_1) = |E
Advanced settings Result file "fuser/heat/apache_out" *
Dynamic settings Femove result directory if exists

View Store function | PigStorage = *

Documentation wn #

]

Field separator

B.3.2.4. Checking the analysis result

In this step, we will build the last Job, which is a two-component Job that will read the result data from Hadoop

and display it on the standard system console. Then, we will execute all the Jobs one by one and check the result
on the console.

Choosetheright componentsto build the last Job
1. Fromthe Palette, drop atHDFSInput and atL ogRow component onto the design workspace.

2. Connect the components using aRow > M ain connection, and label them to better identify their functionality.
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Read the results from Hadoop

. @ . . . rowl (Main) _ _ Y _
Read from DHFS Print Hit Counts
Configurethelast Job
1. Double-click thetHDFSInput component to open its Basic settings view.
) 5o
% Read from DHFS{tHDF5Input_1)
Basic settings Property Type B i
Advanced settings Schema Built-In - Editschema [
Dynaric settings [7]Use an existing connection
View Version
Documentation Distribution HertenWorks = [* Hadoop version Hertenworks Data Platform V1 ~ ™
Connecticn
[] Use kerberos authentication
MNameMode URD  "hdfs://talend-hdp:E020/" *
User name "izhang" *
File Name "fuser/hcat/apache_out/part-r-00000" " (-
Row Separator "n" * Field Separator ™ *

[7] Custom encoding

2. For thefollowing items, use the same settings as in the previous Job:

 Schema, which should contain two columns, host and count, according to the structure of the file uploaded
to HDFS through the Pig chain in the previous Job.

» Hadoop distribution and version, HortonWorks and HortonWorks Data Platform V1 in this example.
« NameNode URI, hdfs://talend-hdp: 8020/ in this example.

3. Inthe User namefield, enter a user name permitted to access the filein HDFS.

4. IntheFile Namefield, enter the path and file namein HDFS.

5. Inthe Basic settings view of the tL ogRow component, select the Table option.

After the four Jobs are properly set up and configured, run them one by one.

Upon successful execution of the last Job, the system console displays | P addresses with successful service calls
and their number of visitsto the website.
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Execution

Kill

5 Clear

mapRedﬁﬁeiéﬁéf.HapReduceLauncher:
Success|

Frint Hit Counts

host | count

192 .168.1.5 |
127.0.0.1 |
192.168.1.1 |
10.35.4.82 |
172 .16 .68, I

[] Line limit  1g0

[¥] Wrap
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Appendix C. System routines

Thisappendix givesyou an overview of the most commonly used routines, along with use cases. In this Appendix,
routinesfollow the order in which they display inthe Repository. They are grouped according to their types. Each
typeisdetailed in adifferent section.

For more information on how to define routines, to accessto system routines or to manage system or user routines,
see chapter Managing routines.

Before starting any data integration processes, you need to be familiar with Talend Open Sudio for Big Data
Graphical User Interface (GUI). For more information, see appendix GUI.
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Numeric Routines

C.1. Numeric Routines

Numeric routines allow you to return whole or decimal numbers in order to use them as settings in one or more
Job components. To add numeric IDs, for instance.

To access these routines, double click on the Numeric category, in the system folder. The Numeric category
contains several routines, notably sequence, random and decimal (convertlmpliedDecimal Format):

Routine Description Syntax
sequence Returns an incremental numeric ID. Numeri c. sequence(" Paraneter nane", start
val ue, increnent value)

resetSequence Creates a sequence if it doesn’t exist and|Nuneri c. r eset Sequence (Sequence |dentifier,
atributes a new start value. start val ue)

removeSeguence Removes a segquence. Nuneri c. RenoveSequence (Sequence Identifier)

random Returns a random whole number between|Nuneri c. randon( m ni mrum start val ue, maxi num
the maximum and minimum values. end val ue)

convertlmpliedDecimal Form&eturns a decima with the help of an|Numeri c. convert | npl i edDeci mal For mat
implicit decimal model. ("Target Format", value to be converted)

C.1.1. How to create a Sequence

The sequence routine allows you to create automatically incremented IDs, using atJava component:

System.out.println(Mumeric.sequence ("1™, 1,1)1;
Jystem.out.println(Mumeric.sequence ("=1",1,1)1:;

The routine generates and increments the | D automatically:

[ztati=stic=s] connecting to socket on port 3360
[ztatistics] connected

2

C.1.2. How to convert an Implied Decimal

It is easy to use the convertlmpliedDecimal For mat routine, along with atJava component, for example:

Fystem.out.princln (Mumeric.convertIinpliedbecimalFormar ("9Ve9™, "1237)) ;2

Theroutine automatically converts the value entered as a parameter according to the format of theimplied decimal
provided:

1.23
[z2tatistics] disconnected
Jah FEsE rowiine andad 38 14015 G4eRSeSgi8 farr s cadesag

C.2. Relational Routines

Relational routines allow you to check affirmations based on booleans.

To access these routines, double click on the Relational class under the system folder. The Relational class
contains several routines, notably:
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StringHandling Routines

Routine

Description

Syntax

ISNULL

Checksif the variable provided isanull value. Rel ational .| SNULL(variable to be checked)

To check a Relational Routine, you can use the ISNULL routine, along with atJava component, for example:

System.out.println(Belational. ISGNULL (null) ) ;

In this example, the test result is displayed in the Run view:

Starfing job fosf rontinse af 14004 G805 00 8.

[ztatisticse] connecting to szocket on port 3375
[statistic=] connected

tru=

[ztatistics] disconnected

Joaf fEsE rowfine endey af 14004 G485 CFRIE. fasr it oods=g

C.3. StringHandling Routines

The StringHandling routines allow you to carry out various kinds of operations and tests on aphanumeric
expressions, based on Java methods.

To access these routines, doubleclick on StringHandling under the system folder. The StringHandling class
includes the following routines:

Routine Description Syntax

ALPHA checks whether the expression is arranged in|StringHandl i ng. ALPHA("string to be checked")
alphabetical order. Returns the true or false
boolean accordingly.

IS ALPHA checks whether the expression contains|StringHandling. 1S _ALPHA("string to be
alphabetical charactersonly, or otherwise. Returns|checked")
the true or false boolean accordingly.

CHANGE replaces an element of a string with a defined| St ri ngHandl i ng. CHANGE("string t o be checked",
replacement element and returnsthe new string.  |"string to be repl aced”, "repl acenent string")

COUNT Returns the number of times a substring occurs| St ri ngHandl i ng. COUNT("string to be checked",
within astring. "substring to be counted")

DOWNCASE converts all uppercase lettersin an expression into | St ri ngHandl i ng. DOANCASE( " stri ng to be
lowercase and returns the new string. converted")

UPCASE converts all lowercase lettersin an expression into | St ri ngHandl i ng. UPCASE("stri ng to be
uppercase and returns the new string. converted")

DQUOTE encloses an expression in double quotation marks. | St ri ngHandl i ng. DQUOTE("string to be encl osed

in doubl e quotation narks")

INDEX returns the position of the first character in a|StringHandl i ng. | NDEX("string to be checked",
specified substring, within a whole string. If the|"substring specified")
substring specified does not exist in the whole
string, the value - 1 isreturned.

LEFT specifies a substring which correspondsto thefirst| St ri ngHandl i ng. LEFT("string to be checked",
n charactersin astring. nunber of characters)

RIGHT specifies a substring which correspondsto thelast | St ri ngHandl i ng. RI GHT("chaine a vérifier",
n charactersin astring. nunber of characters)

LEN calculates the length of a string. StringHandl i ng. LEN("string to check")

SPACE generates a string consisting of aspecified number | St ri ngHandl i ng. SPACE( nunber of bl ank spaces

of blank spaces.

to be generated)
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How to store a string in aphabetical order

Routine Description Syntax
SQUOTE encloses an expression in single quotation marks. |Stri ngHandl i ng. SQUOTE("string to be encl osed
in single quotation nmarks")
STR generates a particular character a the number of | St ri ngHandl i ng. STR(' char act er to be
times specified. generated’ , nunber of tinmes)
TRIM deletes the spaces and tabs before the first non- St ri ngHandl i ng. TREM "string to be checked")

blank character in a string and after the last non-
blank character, then returns the new string.

BTRIM deletes all the spaces and tabs after the last non- | St ri ngHandl i ng. BTRIM "string to be checked")
blank character in a string and returns the new
string.

FTRIM deletes al the spaces and tabs preceding the first| St ri ngHandl i ng. FTRIM "string to be checked")

non-blank character in astring.

C.3.1. How to store a string in alphabetical order

It is easy to use the ALPHA routine along with atJava component, to check whether a string is in alphabetical
order:
Svstewm.out.println(S3tringHandling. ALPHL ("abodefo™) ) :

The check returns a boolean value.
Searsing Job ftesd routins af 14055 G405 0FEEE

[statistics] connecting to =ocket on port 3469
[statistics] connected
tLrue

C.3.2. How to check whether a string is alphabetical

Itiseasy tousethelS_AL PHA routine along with atJava component, to check whether the string is alphabetical :

System.out.println(StringHandling.I5 ALPHA ("ab33cd")):

The check returns a boolean value.
Srarfrmy jobh rouiinsd a6 I8 45 SRS FETE

[statistic=s] connecting to socket on port 3892
[ztatistics] connected

fal=e

[ztatistics] dizconnected

Joh rontined apded g¢ 33045 SIeogSeS010. fasrE o oode=07

C.3.3. How to replace an element in a string

It iseasy usethe CHANGE routine along with atJava component, to replace one element in astring with another:

Gystem.out.println(3tringHandling. CHANGE ("hello
world!'", "gor 14", "guy™1) ;

The routine replaces the old el ement with the new element specified.
hello guy!
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How to check the position of a specific character or substring, within astring

C.3.4. How to check the position of a specific
character or substring, within a string

The INDEX routine is easy to use along with atJava component, to check whether a string contains a specified
character or substring:

System.out.println (StringHandling. INDEX ("hello world!"™, "hella™)):
Syvstem.out.println(StringHandling.INDEX ("hello world!"™, "world"™}):
System.out.println(StringHandling.INDEX ("hellc world!™, "!")):
Svstem.out.println(StringHandling.INDEX ("hello world!™, "2"));

The routine returns awhole number which indicates the position of thefirst character specified, or indeed the first
character of the substring specified. Otherwise, - 1 isreturned if no occurrences are found.
Stsrérmy qabh rowiinsl & 1547 SLo0seS018
[=2tatistics] connecting to socket on port 4027
[ztati=stic=] connected
1]
A
11
-1
[ztatistics] dizconnected
ol o finel anded ¢ 150487 SRR fasr b o oodesig

C.3.5. How to calculate the length of a string

The LEN routineis easy to use, along with atJava component, to check the length of a string:
System.out.println(StringHandling.LEN ("hello world!™)):

The check returns awhole number which indicates the length of the chain, including spaces and blank characters.
12

C.3.6. How to delete blank characters

The FTRIM routine is easy to use, along with a tJava component, to delete blank characters from the start of
achain:

System.out.println (StringHandling.FTRIM(" Hello world !"™));

The routine returns the string with the blank characters removed from the beginning.
SEArEIny Fabh rogrinsl 36 J& 014 SHeGS R8T

[ztatisticse] connecting to szocket on port 3790
[=tatistic=] connected

Hello world |

[ztatistic=s] disconnected

JOf rautined anded s J&0Fd SAelSesgle ferr s oode =iy

C.4. TalendDataGenerator Routines

The TalendDataGenerator routines are functions which allow you to generate sets of test data. They are based
on fictitious lists of first names, second names, addresses, towns and States provided by Talend. These routines
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How to generate fictitious data

are generally used when developing Jobs, using a tRowGenerator, for example, to avoid using production or
company data.

To access the routines, double click on TalendDataGenerator under the system folder:

Routine Description Syntax

getFirstName returns afirst name taken randomly from a| Tal endDat aGener at or . get Fi r st Name()
fictitiouslist.

getLastName returns a random surname from afictitious| Tal endDat aGener at or . get Last Name()
list.

getUsStreet returns an address taken randomly from a| Tal endDat aGener at or . get UsSt r eet ()

list of common American street names.

getUsCity returns the name of atown taken randomly | Tal endDat aGener at or . get UsGi t y()
from alist of American towns.

getUsSate returns the name of a State taken randomly | Tal endDat aGener at or . get UsSt at e()
from alist of American States.

getUsSateld returns an 1D randomly taken from alist of | Tal endDat aGener at or . get UsSt at el d()
IDs attributed to American States.

No entry parameter isrequired as Talend providesthe list of fictitious data.
2

Y ou can customize the fictitious data by modifying the TalendGenerator Routines. For further information on
how to customize routines, see section Customizing the system routines.

C.4.1. How to generate fictitious data

It iseasy to use the different functionsto generate datarandomly. Using atJava component, you can, for example,
create alist of fictitious client data using functions such as getFir stName, getL astName, getUSCity:

System.out.println(TalendbataGenerator.getFirstName () ) !
System.out.println(TalendbataGenerator.getlastName (1) ;
Jvstem.out.println(Talendbatatenerator.getUscity ()
System.out.println(TalendbataGenerator.getUs3tate (]
System.out.println(TalendbataGenerator.getUs3tateId(] )
Syvstem.out.println(TalendbataGenerator.getUsStreet (1]

The set of data taken randomly from the list of fictitious datais displayed in the Run view:
SEArEIng Fob ftasd rouline a6 14044 BT S FEE

[=tatistic=] connecting to socket on port 3907
[=tati=stic=] connected

Jimmy

Arthur

Dez Moines

Wyoming

T

Hilpas Street

[ztati=stics] disconnected

Jaf taest rordine andad b 14044 F4oRS P08 fasa b codesd)

C.5. TalendDate Routines

The TalendDate routines allow you to carry out different kinds of operations and checks concerning the format
of Date expressions.
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How to format a Date

To access these routines, double click on TalendDate under the system folder:

Routine Description Syntax
addDate adds n days, n months, n hours, n minutes or n|Tal endDat e. addDate("String date initiale",
secondsto aJavadate and returnsthenew date.  |"format Date - eg.: yyyy/ M dd", whole
] n,"format of the part of the date to which n
The Date format IS "yyyy", "MM”, ”dd", l'HH", is to be added - eg. :yyyy") .
"mm", "ss' or "SSS".
compareDate compares al or part of two dates according to|Tal endDat e. conpar eDat e( Dat e datel, Dat e
the format specified. Returns O if the dates are|date2, "format to be conpared - eg.: yyyy-
identical, 1if thefirst date is older than the second | Mt dd" )
and -1 if it is more recent than the second.
diffDate returns the difference between two dates in|Tal endDate. di f f Dat e( Dat e1(), Dat e2(),
terms of days, months or years according to the|"format of the part of the date to be conpared
comparison parameter specified. - eg.:yyyy")
diffDateFloor returns the difference between two dates by|Tal endDate. di f f Dat eFl oor ( Dat el(), Date2(),
floor in terms of years, months, days, hours,|"format of the part of the date to be conpared
minutes, seconds or milliseconds according to the|- eg.: M\I')
comparison parameter specified.
formatDate returns a date string which corresponds to the|Tal endDat e. for mat Dat e("date format - eg.:
format specified. yyyy-MAdd HH: mm ss", Date() to be formatted
formatDatelL.ocale | changes a date into adate/hour string according to | Tal endDat e. f or nmat Dat eLocal e ("format
the format used in the target country. target", java.util.Date date, "language or
country code")
getCurrentDate returns the current date. No entry parameter is|Tal endDat e. get Cur r ent Dat e()
required.
getDate returns the current date and hour in the format | Tal endDat e. get Dat e(" Format of the string -
specified (optional). This string can contain fixed|ex: CCYY- M DD')
character strings or variableslinked to the date. By
default, the string is returned in the format, DD/
MM/CCYY.
getFirstDayOfMonth changes the date of an event to the first day of the| Tal endDat e. get Fi r st DayMont h( Dat e)
current month and returns the new date.
getLastDayOfMonth| changes the date of an event to the last day of the| Tal endDat e. get Last DayMont h( Dat e)
current month and returns the new date.
getPartOfDate returns part of a date according to the format|Tal endDat e. get Part Of Date("String indicating
specified. This string can contain fixed character |t he part of the date to be retrieved, "String
strings or variables linked to the date. inthe format of the date to be parsed")
getRandomDate returns arandom date, in the SO format. Tal endDat e. get RandonDat e("f ormat date of the
character string", String mnDate, String
maxDat e)
isDate checks whether the date string corresponds to the| Tal endDat e. i sDate(Date() to be checked,
format specified. Returnsthe boolean valuetrueor |"f or mat of the date to be checked - eg.: yyyy-
false according to the outcome. MWt dd HH: nm ss")
parseDate changes a string into a Date. Returns a date in the| Tal endDat e. par seDate("format date of the
standard format. string to be parsed", "string in the format
of the date to be parsed")
parseDatelLocale |parsesa.string according to aspecified format and| Tal endDat e. par seDat eLocal e("date fornmat of
extractsthe date. Returnsthe date accordingtothe({the string to be parsed', "String in the
local format specified. format of the date to be parsed", "code
corresponding to the country or |anguage")
setDate modifies part of a date according to the part and|Tal endDat e. set Dat e(Date, whole n, "format of
valueof thedate specified and theformat specified. [t he part of the date to be nodified -
eg. 1yyyy")
C.5.1. How to format a Date
The formatDate routine is easy to use, along with atJava component:
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How to check aDate

Syetem.out.println(TalendDate.formatDate ("dd-MM-vvvv", new Date |:|:| |

The current date isinitialized according to the pattern specified by the new dat e() Javafunction and isdisplayed
inthe Run view:
Srarfrng jobh roufinsel & FF 0S8 SRS FGTE.

2010-02-25 17:28:07
Job roufinsl anded ¢ 17058 FEAGSeSGIE Fasrf codesady

C.5.2. How to check a Date

It is easy to use the isDate routine, along with atJava component to check if a date expression is in the format
specified:
System.out.println(Talendbate.izhate ("2010-02-092 00:00:00%, Puyyy—-MM-dAd
HH:rm:ss") ) ;2

A boolean isreturned in the Run view:
Starérny b rowirnsl a8 170 FE FEogSeS0TE.

trus
Jod roufinsl anded ¢ 17058 SRS Fasr s codesig

C.5.3. How to compare Dates

Itiseasy to use the formatDate routine, along with atJava component to check if the current date is more recent
than a specific date, according to the format specified.

System.out.println(TalendDate.compareDate (new Datel(),
TalendDate.parseDate ("vyyy-MM-dd", "2010/11/24"), "yyyy-MHM-dd")):

The current date isinitialized by the Java function new dat e() and the value -1 is displayed in the Run view to
indicate that the current date precedes the reference date.
SEarermy Fabh rogfinsd 38 I8 G5 SEoGSeSETE

-1
Jof o finel anded 3¢ JE T SRS SRTE . fasr b oode =i

C.5.4. How to configure a Date

It is easy to use the setDate routine, along with a tJava component to change the year of the current date, for
example:

Svstem.out.println (TalendDate.formatDate ("vyvy/ MM/ dd HH:HE:SS",hew

Date())):

System.out.println(TalendDate.sectDate (new Date () 2011, "yvyyvy") )’

The current date, followed by the new date are displayed in the Run view:
SEaresng job roucinsd ¢ 18 0F SRS SETE,
2010-02-26 18:03:14

Sat Feb 26 18:03:14 CET 2011
Jab rogfinal andad at I8 GF FESTRSIGIG faxif oodesi7
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How to parse a Date

C.5.5. How to parse a Date

It is easy to use the parseDate routine, along with a tJava component to change a date string from one format
into another Date format, for example:

System.ocut.println(TalendDate.parseDate ("yyyy-MHM-dd HH:mm:==s",

"1979-10-20 19:00:53m));

The string is changed and returned in the Date format:
Searérmy qob rogiinsl a¢ 110585 G1o03-5008.

Sat Oct 20 19:00:59 CET 1979
Jab rogfrnal andad st P15 FlefReSGiE fesr o oode=87

C.5.6. How to retrieve part of a Date

Itiseasy to use the getPartOfDate routine, along with atJava component to retrieve part of adate, for example:
Date D=TalendDate.parselate "dd-MM-yvvy HH:meo:ss™, "13-10-2010 12:23:45");

System.out.println(D.to3tring()):
System.out.println(Talendbate.getParctOfbate ("DAT OF MONTH", Dj):
Jystem.out.println(Talendbate.getParcOfhate ("HONTH™, D)) !
Jystem.out.println(Talendbate.getPart0fhate ("YEAR™, L))
System.out.println(Talendbate.getPart0fbate ("DAT OF VEARM™, D):
System.out.println(Talendlbate.getParcOofbate ("DAT OF WEEK", D)) ;

In thisexample, the day of month (DAY_OF_MONTH), the month (MONTH), theyear (Y EAR), the day number
of theyear (DAY _OF_YEAR) and the day number of theweek (DAY _OF WEEK) arereturned inthe Run view.
All the returned data are numeric data types.

SEIreImy Jjob rogfins & F80 55 JRSes01 T,

[=tati=tic=s] connecting to =ocket on port 3565
[=tatistics] connected

Wed Oct 13 12:23:45 CEST 2010

13

9

2010

286

4

[=tatistics] disconnected

Jaf powfine anded ¢ FECEF PSSR, fesd ¢ code=07

In the Run view, the date string referring to the months (MONTH) starts with 0 and ends with 11: O corresponds to January,
] 11 corresponds to December.

C.5.7. How to format the Current Date

It is easy to use the getDate routine, along with a tJava component, to retrieve and format the current date
according to a specified format, for example:

System.out.println(TalendDate.getDate ("CCYY-MM-DD™) )
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TalendString Routines

The current date is returned in the specified format (optional):
SEarEsmy Jjob roucinsd & 10058 G5oGEeS01 0,

2010-03-02
Joh rorrdrned anded a6 I 58 GEAGRSEIE. o b oode =T

C.6. TalendString Routines

The TalendString routines allow you to carry out various operations on a phanumerical expressions.

To accessthese routines, double click on TalendString under the system folder. The TalendString class contains
the following routines:

Routine Description Syntax

replaceSpecialCharForXML  [returns a string from which the|Tal endStri ng. repl aceSpeci al Char For XML ("string
special characters (eg.:: <, >, &...)|contai ning the special characters - eg.: Thelma
have been replaced by equivalent|& Loui se")

XML characters.

checkCDATAFor XML identifies characters starting with| Tal endSt ri ng. checkCDATAFor XML("string to  be
<I[CDATA] and ending with|parsed")

11> as pertaining to XML and
returnsthem without modification.
Transforms the strings not
identified as XML in a form
which is compatible with XML
and returns them.

talendTrim parsestheentry stringand removes| Tal endString. tal endTrin("string to be parsed",
the filler characters from the start|"filler character to be renoved', character
and end of the string according to|posi ti on)

the aignment value specified: -1
for the filler characters at the end
of the string, 1 for those at the
start of the string and O for both.
Returns the trimmed string.

removeAccents removes accents from a string|Tal endString. renoveAccents("String")
and returns the string without the
accents.

getAsciiRandomString generates a random string with a| Tal endSt ri ng. get Asci i RandonBtring (whol e nunmber
specific number of characters. indicating the length of the string)

C.6.1. How to format an XML string

It is easy to run the replaceSpecial Char For XML routine along with a tJava component, to format a string for
XML:
System.out.println(TalendString. replaceSpecialCharForXML ("Thelma &
Louise™)):

In thisexample, the"&" character is replaced in order to make the string XML compatible:

Srarfrng Fabh rogtinsd & J&5 48 GEoGFeSGTET,

Thelmns &amnp; Louise
Jof ronfinel anded s J5 88 FEoEReSRNE. fasr b o oodesit
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How to trim astring

C.6.2. How to trim a string

It is easy to use the talendTrim routine, along with atJava component to remove the string padding characters
from the start and end of the string:

System.out.println(TalendString. talendTrim("**talend open studig*®*=",

T B

System.out.println(Talend5tring. talendTIrim("**calend open studig®®®="
Ery 1))

Bystem.out.println(TalendString. talendIrim("**talend open studig®***"
ety 0) )

The star characters are removed from the start, then the end of the string and then finally from both ends:
SEIrermy qabh roueinsd e i85 GEGRSGER,
*#%talend open studio
talend open studio*eex

talend open =tudio
Jobh rogfansl andad a& F4015F GE-GEeSNT farr b oode =87

C.6.3. How to remove accents from a string

It is easy to use the removeAccents routine, along with a tJava component, to replace the accented characters,
for example:

System.out.println(TalendString. removedccents ("sdcrebleii! ™)) ;

The accented characters are replaced with non-accented characters:
Srarfrmy jobh rovtinsd 36 F& 8T GReRReFETE

sacrebleul
Joab rogfinsd andad af 16005 SR-RF-FRI8. fasrf oode=a7
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Appendix D. SQL template writing rules

This chapter describes the rules applied for the creation of SQL templates. It aimsto help users of SQL templates
in Talend Open Sudio for Big Data to understand and develop the SQL templates for more customized usage.

These rules provide details that you have to respect when writing the template statement, a comment line or the
different relevant syntaxes.

These rules helps to use the SQL code in specific use cases, such as to access the various parameters defined in
components.
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SQL statements

D.1. SQL statements

An SQL statement can be any valid SQL statement that the related JDBC is able to execute. The SQL template
codeisagroup of SQL statements. The basic rules to write an SQL statement in the SQL template editor are:

e An SQL statement must end with ; .

» An SQL statement can span lines. In this case, no line should be ended with ; except the last one.

D.2. Comment lines

A comment line startswith # or - - . Any linethat startswith # or - - will be ignored in code generating.

Thereis no exception to the lines in the middle part of a SQL statement or withinthe<% .. % syntax.

D.3. The «..» syntax

This syntax can span lines. The following list points out what you can do with this syntax and what you should
pay attention to.

 You can define new variables, use Javalogical codelikei f, f or and whi | e, and also get parameter values.

For example, if you want to get the FILE_Name parameter, use the code as follows:

<%
String filename = _ FILE NAME__;
%>

» This syntax cannot be used within an SQL statement. In other words, it should be used between two separated
SQL statements.

For example, the syntax in the following code is valid.

#sql sentence

DROP TABLE t enp_0;

<%

#| oop

for(int i=1; i<10; i++){
%

#sql sentence

DROP TABLE tenp_<%i %;
<%

}
%

#sql sentence

DROP TABLE tenp_10;

In thisexampl e, the syntax is used between two separated SQL templates: DROP TABLE t enp_0; and DROP TABLE
tenp_<%i %; .

The SQL statements are intended to remove severa tables beginning from temp_0. The code between <% and
% generate a sequence of number in loop to identify tables to be removed and close the loop after the number
generation.

» Within this syntax, the <%=. . . % or </ . . . / > syntax should not be used.
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The<%. . . % syntax

<%...% and </.../> are also syntax intended for the SQL templates. The below sections describe related
information.

Parameters that the SQL templates can access with this syntax are ssmple. They are often used for connection purpose and
a2 can be easily defined in components, such as TABLE_NAME, DB_VERS ON, SCHEMA TYPE, etc.

D.4. The <.« Syntax

This syntax cannot span lines and is used for SQL statement. The following list points out what you can do with
this syntax and what you should pay attention to.

» Thissyntax can be used to generate any variable value, and also the value of any existing parameter.
» No space char is alowed after <%-.
* Inside this syntax, the <%.% or </ ... > syntax should not be used.

The statement written in the below exampleisavalid one.

#sqgl sentence
DROP TABLE tenp_<% _TABLE NAMVE _ %;

The code is used to remove the table defined through an associated component.

For more information about what components are associated with the SQL templates, see chapter Designing a
data integration Job.

For more information on the <% . . % syntax, see section The <% . . % Syntax.

For more information on the </ . . . / > syntax, see the following section.

Parameters that the SQL templates can access with this syntax are simple. They are often used for connection purpose and
2 can be easily defined in components, such as TABLE_NAME, DB_VERS ON, SCHEMA TYPE, etc.

D.5. The <. .,- syntax

This syntax cannot span lines. The following list points out what you can do with this syntax and what you should
pay attention to.

* It can be used to generate the value of any existing parameter. The generated value should not be enclosed by
quotation marks.

» No space char is allowed after </ or before/ >.
* Inside this syntax, the <%.% or <% ..% syntax should not be used.

The statement written in the below exampleisavalid one.

#sgl sentence
DROP TABLE tenp_</ TABLE_NAME/ >;

The statement identifies the TABLE_NAME parameter and then removes the corresponding table.
For more information on the <%.% syntax, see section The <% . . % syntax.

For more information on the <% ..9% syntax, see section The <%. . . % Syntax.
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Code to access the component schema elements

The following sections present more specific code used to access more complicated parameters.

Parameters that the SQL templates can access with this syntax are simple. They are often used for connection purpose and
2 can be easily defined in components, such as TABLE_NAME, DB_VERS ON, SCHEMA_TYPE, etc.

D.6. Code to access the component schema
elements

Component schema elements are presented on a schema column namelist (delimited by adot “.”). These elements
are created and defined in components by users.

The below code composes an example to access some elementsincluded in acomponent schema. In the following
example, the ELT_METADATA SHEMA variable name is used to get the component schema.

<%

String query = "select ";

SCHEMA( __ELT_METADATA_SHENVA ) ;

for (int i=0; i < __ ELT_METADATA SHEMA _.length ; i++) {

query += (__ELT METADATA SHEMA [i].name + ",");
}

query += " from" + _ TABLE NAME ;

%

<%query %,

In this example, and according to what you want to do, the _ ELT METADATA SHEMA [i].name
code can be replaced by _ ELT _METADATA SHEMA_[i].dbType, _ ELT METADATA SHEMA _ [i].isKey,
_ ELT_METADATA SHEMA [i].lengthor_ELT METADATA SHEMA [i].nul | abl e to accessthe other fields

of the schema column.

The extract statement is SCHEMA( __ELT_METADATA _SHEMA ) ;. In this statement, ELT_METADATA SHEMA is the
variable name representing the schema parameter to be extracted. The variable name used in the code is just an
example. Y ou can change it to another variable name to represent the schema parameter you already defined.

_ Make sure that the name you give to the schema parameter does not conflict with any name of other parameters.
&%

For more information on component schema, see section Basic Settings tab.

D.7. Code to access the component matrix
properties

The component matrix properties are created and changed by users according to various data transformation
purposes. These properties are defined by tabular parameters, for example, the operation parameters or groupby
parameters that users can define through the tSQL TemplateAggr egate component.

To accessthese tabular parametersthat are naturally more flexible and complicated, two approaches are available:
* The</.../> approach:

</.../>is one of the syntax used by the SQL templates. This approach often needs hard coding for every
parameter to be extracted.

For example, a new parameter is created by user and is given the name NEW_PROPERTY. If you want to access
it by using </ NEW PROPERTY/ >, the below code is needed.
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Code to access the component matrix properties

eseif (paramName.equals("NEW_PROPERTY")) {

List<Map<String, String>> newPropertyTableValue = (List<Map<String, String>>)
ElementParameterParser.getObjectVaue(node, " NEW_PROPERTY__");

for (intii = 0; ii <newPropertyTableVauesize(); ii++) {

Map<String, String> newPropertyMap =newProperty TableValue.get(ii);

realVaue += ...;//append generated codes

» The EXTRACT(__GROUPBY__); approach:

The below code shows the second way to access the tabular parameter (GROUPBY).

<%

String query = "insertinto" + _ TABLE_NAME__ + "(id, name, date_birth) select sum(id), name, date_birth from cust_teradata
group by";

EXTRACT(__GROUPBY _);
for (inti=0;i <__GROUPBY_LENGTH__; i++){

query += (__GROUPBY _INPUT_COLUMN__[i] +");
}
%>

<%=query %>,

When coding the statements, respect the rules as follows:

» Theextract statement must use EXTRACT(__GROUPBY__) ;. Upcase should be used and no space char is allowed.
This statement should be used between <%and %.

e Use_ GROUPBY_LENGTH__, inwhich the parameter nameisfollowed by _LENGTH, to get the line number of the
tabular GROUPBY parameters you define in the Groupby area on a Component view. It can be used between
<%and % or <% and %.

* Usecodelike __ GROUPBY_I NPUT_COLUMN__[i] to extract the parameter values. This can be used between
<%and % or between <% and %.

* In order to access the parameter correctly, do not use the identical name prefix for several parameters.
For example in the component, avoid to define two parameters with the names PARAMETER NAME and
PARAMETER_NAME_2, as the same prefix in the names causes erroneous code generation.
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